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Overview

The new MA9322-EHTVL is the most versatile product offering to date from VIVOTEK.
The MA9322-EHTVL expands on the already versatile MA9321-EHTVL by adding IR
illumination up to 30 meters, providing high resolution images through four independent
sensors, and remote focus lenses. By having each sensor independent of each other, the
MA9322-EHTVL can view four different regions simultaneouslyand therefore reduce the
total number of cameras needed for surveillance, helping to lower total installation time and
costs.

Featuring four independent 5SMP CMOS Sensors with IR illuminators, the MA9322-EHTVL
network camera can provide the most flexibility in surveillance monitoring. Each sensor
utilizes a 3.7 to 7.7 mm remote focus lens and 3-axis design along a circular track to
enable full 360° coverage. This enables the MA9322-EHTVL to capture every angle for
comprehensive video coverage from a single IP address, making this camera ideally suited
for surveillance in areas such as hallway intersections, building corners, parking garages/
lots, and shopping malls. Now with added IR illuminators, areas of low light visibility are no
longer an issue either.

The MA9322-EHTVL is equipped with a removable IR-cut filter and WDR Pro technology,
enabling the camera to maintain optimal image quality and unparalleled visibility in high
contrast lighting environments. Furthermore, the MA9322-EHTVL employs VIVOTEK’s
Smart Stream |l technology and H.265 compression codec, reducing bandwidth more than
90%* while still maintaining excellent image quality compared to traditional H.264 without
smart streaming.

In addition to its versatile coverage, the MA9322-EHTVL is armed with a robust IP66 and

IK10-rated housing to enable the multidirectional camera to withstand rain and dust as well
as to protect against vandalism or tampering.

Revision History

m Rev. 1.0: Initial release.



Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera
is not only a high-performance web-ready camera but can also be part of a flexible surveillance
system. It is the user’s responsibility to ensure that the operation of such devices is legal before
installing this unit for its intended use.

It is important to first verify that all contents received are complete according to the Package
Contents listed below. Take note of the warnings in the Quick Installation Guide before the Network
Camera is installed; then carefully read and follow the instructions in the Installation chapter to
avoid damage due to faulty assembly and installation. This also ensures the product is used
properly as intended.

The Network Camera is a network device and its use should be straightforward for those who
have basic networking knowledge. It is designed for various applications including video sharing,
general security/surveillance, etc. The Configuration chapter suggests ways to best utilize the
Network Camera and ensure proper operations. For creative and professional developers, the URL
Commands of the Network Camera section serves as a helpful reference to customizing existing
homepages or integrating with the current web server.

Package Contents

m MA9322-EHTVL m Quick Installation Guide
m Screws / desiccant bag m T10 torx wrench
m IR light cover m Waterproof cable gland

m Alignment sticker

& IMPORTANT:

1. Wiring methods used for the connection of the equipment to earth shall be in
accordance with the National Electrical Code, ANSI/NFPA 70, and the Canadian
Electrical Code, Part |, CSA C22.1.

2. Use the camera only with a DC power supply that is UL listed, and limited power
source (LPS) certified. The power supply should bear the UL listed and LPS marks.
The power supply should also meet any safety and compliance requirements for the
country of use.
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NOTE:

Camera Hardware Preventative Maintenance:
1. Visual inspection of all major components including accessories, cabling and

connections where accessible for signs of deterioration or damage.

2. Check and clean cameras, lenses and housings inside and out as needed.

Please do not scratch, damage, or leave fingerprints on the dome/front cover and/or
lens because this may decrease image quality.

For general cleaning of dirty areas, it is suggested to use compressed air to remove
dust and/or other debris in order not to damage the on-board components.

In order to clean oil stains, it is recommended to use a spray-type decomposing cleaner
(absolutely avoid reciprocating wipes on the surface). After the oil has decomposed,
spray it with water, dry with air, and/or absorb water with a cotton cloth or a soft cloth
(dab, please avoid wiping).

Do not use harsh detergents, gasoline, benzene or acetone, etc. to clean as they may
deform or cause damage to the product. Also, excessive cleaning could damage the
surface.

. Check images for correct field of view (pan, tilt and zoom focus) and adjust as

necessary.
Check and replace the Micro SD memory card as needed.

Stop edge recording before removing the Micro SD memory card.

Make sure that the Micro SD memory card is right side up and do not insert it with
force, otherwise it may be damaged.

When it is raining or the humidity is high, insertion or ejection of the Micro SD memory
card is not recommended.

Disassembly of the dome/front cover carries the risk of internal dew condensation, so
please remember to replace the desiccant bags on the inside of the cameras before
reassembly.

Check that the camera view has not been blocked by obstacles and that you can see
the property perimeter clearly.

Make sure the interiors of cameras and accessories, like mounting kits and/or
enclosures, are clean and dry.

Make sure cameras are securely attached to the wall/ceiling/mounting kits.

/\ IMPORTANT:

1. Please contact VIVOTEK's certified dealers for power adapters.

2. Installation and maintenance service should only be performed by qualified technicians.
3. If powered by a power adapter, the adapter should be properly grounded.

4. The power cord must be connected to a socket or outlet with a ground connection.



/\ IMPORTANT:

The product shall be grounded properly with a screw type of 3.5mm min. for protective
earthing terminal, and connected using a green-yellow protective earthing conductor
with 20 AWG min.

/\ IMPORTANT:

1. The product must be installed and protected in a location that is not easily accessible,
and is away from impacts or heavy vibration. For example, at the location where the
surveillance cameras are looking down or installed at high positions such as on a wall,
or at least 3 meters above the ground.

2. The camera should be installed at least 10 centimeters away from the eave of a

building.

. If powered by a power adapter, the adapter should be properly grounded.

. Maintenance and repair work must always be carried out by qualified technical

personnel.

. Disconnect power from the unit when performing a maintenance task.

. Please contact VIVOTEK's certified dealers for power adapters.

AW
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/\ IMPORTANT:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed I.T.E. with PoE output.

1. La caméra ne doit étre raccordée qu’a des réseaux PoE, sans routage vers des
installations extérieures.

2. Pour les raccordements PoE, utilisez uniquement un équipement de Tl homologué UL,
avec une sortie PoE.

Use the camera only with a DC power supply that is UL listed, and limited power source
(LPS) certified. The power supply should bear the UL listed and LPS marks. The power
supply should also meet any safety and compliance requirements for the country of use.

n’utilisez la caméra qu’avec un bloc d’alimentation CC homologué UL, ainsi qu'avec
une alimentation limitée (LPS) certifiée. Le bloc d’alimentation doit porter les indications
d'homologation UL et LPS. Il doit également répondre aux exigences en matiére de
securité et de conformité relatives au pays d’utilisation.



/\ IMPORTANT:

For some customers who already have their own web site or web control application, the
Network Camera/Video Server can be easily integrated through URL syntax. This section
specifies the external HTTP-based application programming interface. The HTTP-based
camera interface provides the functionality to request a single image, control camera
functions (PTZ, output relay etc.), and get and set internal parameter values. The image
and CGl-requests are handled by the built-in Web server.

* To send URL commands in the address bar of your web browser, please remember to
disable the Cross-Site Request Forgery (CSRF) protection in Configuration > Security
> Miscellaneous.

VIVOT=K

Home Client settings [el{i-[IcI{LIH Language

Security > Miscellaneous

Miscellaneous
Enable Cross-Site Request Forgery(CSRF) protection.

We strongly recommend not to disable this protection. Disabling this feature will expose your

camera to risks.

User accounts

HTTPS
Access list
IEEE 802.1x

Miscellaneous

PTZ

Event

Applications

Recording

Storage

Version: 1.2101.35.01b_IRissue

* For up-to-date documentation of URL commands, please go to VIVOTEK’s website,
register an account with a business mail address and submit for authorization for SDK
in Support > Downloads > SDK.

zVIV@'IEK Products  Solutions Pariners Support About Us Investor Relations Where fo Buy

Cybersecurity Downloads
Support * Cerfificate * Brochure
« ALE * Flyer
Leamning ¢ Product Flles * Successful Cases
TODE s Firmwars = Video Library
e Software * Webinar
Legacy Products .« SDK * White Paper
Cybersecurity Cormperate
s Hardening Guide = VI Guidelines

» Green Certification

* lLogo

» For any further technical support, please contact our technical support department.



Symbols and Statements in this Document

INFORMATION: provides important messages or advices that might help prevent
inconvenient or problem situations.

/ NOTE: Notices provide guidance or advices that are related to the functional integrity of
the machine.

N ' “ Tips: Tips are useful information that helps enhance or facilitae an installation, function,
@ or process.

WARNING: or IMPORTANT:: These statements indicate situations that can be
dangerous or hazardous to the machine or you.

A Electrical Hazard: This statement appears when high voltage electrical hazards might
occur to an operator.

Physical Description

() Outer View

\

Dome cover

4§ NOTE:

Some of the suffix syntax used in model naming are listed below:

w/ heater for extreme weather

Focal length w/ number

w/ Remote focus lens

w/ PoE repeater

w/ High Dynamic Range functionality

Im—|;<'lm




Top View

Through holes for ceiling-mount or AM-21C

Threaded holes for AM-529 \

Top mounting _
plate h

O Inner View

RJ45
Ethernet port

Slide track
|

w Lens (sensor) module,
F—— 3-axis adjustable

@ = ) > Reset button

Microphone
contacts J8 header

J14 header |}

\Ey/ N Cable gland for Ethernet
,/

Cable gland for I1/0O combo
cable

Status LEDs

\

» Safety tether wire



IR LED
contacts y

MicroSD card slot

For the installation using optional accessories, refer to
the Optional Accessories Installation Guide




(O Power Consumption

802.3at
PoE
24V 3.5A injector

Due to its onboard heater for operation in the low temperature environments, care
should be taken when selecting the power source for the camera. Listed below are the
requirements for powering the camera:

Use conditions Power consumption & Input

-40°C ~ 50°C (IR ON), 60°C (IR OFF) |PoE+: 25W (PoE Plus mid-span or switch)
-40°C ~ 50°C (IR ON), 60°C (IR OFF) |AC 24V input: 28W

In warmer areas that do not need a heater, a PoE+ switch can drive the camera. In areas
where temperature can drop below -20°C, an AC 24V power adaptor is required.

A IMPORTANT:

* Many copper coated aluminum (CCA) and other non-standard conductors cabling
products are masqueraded as CATSE or CAT6 cables. Please avoid using these CCA
products especially when cascading PoE cameras. It is a must to use Ethernet cables
compliant with the 3P/ETL standard.

« The camera is able to operate in low temperature environments. However, when
starting these cameras in a very low temperature condition, e.g., -40°C, the embedded

heater may take half an hour to warm up the camera. When the temperature within the
canister reaches -10°C, the camera automatically starts.

Hardware Reset

The reset button is used to reset the system or restore the factory default settings.
Sometimes resetting the system can return the camera to normal operation. If the system
problems remain after reset, restore the factory settings and install again.

Reset: Press the recessed reset button. Wait for the Network Camera to reboot.

Restore: Press and hold the reset button until the status LED rapidly blinks. Note that all
settings will be restored to factory default. Upon successful restore, the status LED will
blink green and red during normal operation.

MicroSD/SDHC/SDXC Card Capacity

This network camera is compliant with SD/SDHC/SDXC 16GB / 8GB / 32GB / 64GB / ,
and up to 512 / 1024GB and other preceding standard SD cards.



Mounting Options

NP With its remote focus lenses, the lens modules can be aiming at different areas
'@' at different distances.

Below are some sample scenarios with lenses' shooting directions adapted to
them. The Zoom function is found in Configuration > Media > Image > Focus
window.
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VIVOTEK

L When installed at a corner, one of its lens can be turned facing downward to
'@' cover the area directly underneath the camera.

3

o] .
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Ceiling Mount
For other mounting options, please refer to the Installation Guide for Optional Accessories.
The camera can be directly installed to a wall or ceiling. Refer to the following discussion

for more on pendant mount, pole mount, and corner mount options.

See the installation details below for how to install the camera to a ceiling.

1. Jot down the camera's MAC address for later reference.

Network Camera % VIVET=EK

Model No: XXXXXX
(MAC: 0002D10766AD )

AMERTANRAnm- zons

CEFEC @ R

XXXXX

Pat.6, 930, 709

2. Open the dome cover by loosening 8 T10 anti-tamper screws. Turn slightly counter-
clockwise to remove the dome cover.




3. Remove the camera from the top mounting plate by pressing the release button. Turn
the camera counter-clockwise, and then lift it off the mounting plate.

Main body

Base plate

4. Remove the waterproof connectors. If you do not need to route I/O wires, leave the
plastic cap in place. If you need to connect I/O wires, keep the stainless nut.

26mm hex
socket




5. Install a MicroSD card if onboard storage is preferred.

Drilljhole

Q

®
C TP -=oA====Smfmmmmmm




7. Route cables through the routing hole, and secure the top mounting plate to ceiling by
driving the included screws.

8. Connect the safety tether wire to the latch anchor on the mounting plate.

(> —
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9. Connect a ground wire to the grounding screw on top of the mounting plate.

Equipment bo]

Equipment enclosure

Equipment grounding

10. Pass an Ethernet cable through the cable gland through hole.




11. Secure the camera to the mounting plate by aligning and turning clock-wise. The

camera will snap into place.

12. Install and tighten the components of the waterproof connector.

26mm hex socket




13. Leave 19 centimeters of cable length inside the camera, and connect the Ethernet
cable to the RJ45 connector.

/

19cm

L Pass the I1/0O combo cable (if applied) through the routing hole, and attach a
'@' rubber seal ring. Install the combo cable with the white headers inside the
camera, and tighten the stainless hex nut from the inside of the camera.

1 \
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Connect the white headers to J9 and J14 heades on camera PCB board. Carefully route
the cables along the the camera base.

On the outside of the cameras, the 1/0O wires connection should be protected against
moisture by using putties.

f Mind the electrostatic damage by avoiding contact with exposed circuitry.




VIVOTEK

14. When the Ethernet and I/O wires connection is done and the camera is powered up, try
find the camera using VIVOTEK's Shepherd utility.

Double-click on the camera's entry on Shepherd to open a web console to the camera.
A browser session will open.

The program will search for VIVOTEK Video Receivers, Video Servers or Network
Cameras on the same LAN.

Shepherd

66 device(s) found o

22 - User's Manual




Software Installation

15. Install the Shepherd utility, which helps you locate and configure your Network Camera
in the local network. If your camera comes without the CD, go to VIVOTEK’s website,
and locate the utility in the Downloads > Software page.

%VWQEK Products Support Downloads Solutions  L¢

Product Files
Brochure
Firmware

Flyer ‘

Wall Paper

for Tougl®

13 device(s) found &
-] [ vt |




15-3. The program will search for all VIVOTEK network devices on the same LAN.

15-4. After a brief search, the installer window will prompt. Click on the MAC and model
name that matches the one printed on the product label. You can then double-click on
the address to open a management session with the Network Camera.

1 selected @

MAC:0002D1730202 N11360

O O »

MA9321-EHTV 192.168.4.151 00-02-D1-73-02-02

192.168.4.148

0002D1730202

Forceful Password Configuration

16. The first time you log in to the camera, the firmware will prompt for a password
configuration for security concerns.

16-1. Since your camera is used for the first time, there is no password. Enter “root” as the
user name, and nothing for the password.

F -

Windows Security @

The server 169.254.205.23% is asking for your user name and
password. The server reports that it is from streaming_server.

VWarning: Your user name and password will be sent using basic
authentication on a connection that isn’ tsecure.

| ®mE || EmH




16-2. Enter the combination of alphabetic and numeric characters to fulfill the password
strength requirement. The default name for the camera administrator is “root”, and can
not be changed.

Y viverzk

Language

Configure password

Al least & characters with no space, one alphabet
character{uppercase or lowercase), and one numeric

character

User name - root

User password - (AT ISR RIS EL Y]
Confirm user password : sessesesssrens

Enable htips connection to secure the
configuration for password

*The new password will be applied to all connections

Save ‘ Cancel ‘

Some, but not all special ASCII characters are supported: !, $, %, -, ., @, », _, and ~.
You can use them in the password combination.

FEAE (5wl

You have used invalid characters. These characters are valid:A-Z,
l % a-z,0-9and 15%-.@"_~

16-3. Another prompt will request for the password you just configured. Enter the password
and then you can start configure your camera and see the live view.

F -

Windows Security @

The server 169.254.205.23% is asking for your user name and
password. The server reports that it is fram streaming_server.

VWarning: Your user name and password will be sent using basic
authentication on a connection that isn’ tsecure.

| root |

Remember my credentials




If you are not sure whether the field of view can properly cover the area of your interest,
you can check the live view at the installation site, at a position of your estimation.

VT
L\lll.)li |

T

17. With a live view displayed on your laptop, you can adjust the lens shooting direction to
obtain an optimal fied of view. Check the live view to ensure the image is in focus.

\ o/




Note that you do not need any tools when changing the lens shooting direction.

You can move a lens module from side to side, turn the lens shooting direction up or
down, or rotate the module to cover the area of your interest.

& IMPORTANT:

When adjusting the shooting angle, please avoid touching the exposed circuit board or
ribbon cable. Static discharge can cause damages.

ESD




18. Perform necessary adjustments such as the image alignments on the panoramic view
from the 4 sensors. Go to Configuration > Media > Image > Focus. Zoom in on the
individual lens if necessary. The automated focus function can help you acquire the

best image.

The zoom in/ zoom out function is performed

in the Focus window.
Channe\:

General seftings | Image settings || Exposure | Focus | Privacy mask

2017i7128 09:02:49

Zoom

Focus

==
I -y

Auto Focus

[Full-range scan | Fully-cpened iris Perform auto focus

Focus window
(@ Full view

(O Custom

19. Replace the 2 desiccant bags on the sides of the camera. This ensures the
components are free from the moisture. Replace the desiccant every time you open the
dome cover.




20. Aim the center of the dome cover (the center of the VIVOTEK logo) and align with the
alignment mark on the camera body. Aim and then turn clockwise.

21. Secure the dome cover by fastening the T10 anti-tamper screws. You may need to
carefully route the safety tether wire aside.

N
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22. Install the black cover for the IR lights by pressing up firmly to the groove. Press on all
sides until the cover is snapped into place. Match the indent with VIVOTEK logo.

v+ If you need to open the dome cover, you need to remove the IR cover first. Use

-@- a medium size flat-blade screwdriver as a lever. Find the small access holes on
the side and the rear of the IR cover. Use the screwdriver to slowly yet firmly lever
down on the edge of the cover. You need to perform this action on both of the

access points




The IR cover should then be removed.

DI/DO Diagram

Dry contact with external DC power source to supply a relay. Dry contact is the safest connection

to protect devices.

DI-
1 ‘
DO+]
DI+ [ " Switch L
DO-
[ i
L T Photo
v Coupler
»l
1 AR
DCOV
NO NC

DC ) External DC power

External AC power
pcov with Protected Earth
PE

&)

External Device

User's Manual - 31



Wet contact with external DC power source to supply a relay.

DI-
DO+]
DI+ Switch
I g oM |
DO-
.
‘ U
DCov

P @ External DC power

External AC power

e with Protected Earth
PE

&

External Device

. The DO+ pin provides a 5V output voltage, and the max. load is 50mA.
. The max. voltage for DO- pins is 30VDC (External power).
In order to control AC devices, the above diagram can be taken in consideration. The
diagram uses a relay to control the ON/OFF condition of the AC device.
3. An external relay can be triggered by using DO+ or by an external power source,
depending on the type of relay you use.
4. In case of using an individual relay (instead of using a relay module), for protection
against voltage or current spikes, a transient voltage suppression diode must be
connected in parallel with the inductive load.

N —

Dry contact and using camera’s DO+ to supply a relay.

DI-
DO+[
DI+ Switch
[ s o— |
DO-

al

External AC power
c with Protected Earth

External Device




Network Deployment

General Connection (PoE)

O When using a PoE-enabled switch

The Network Camera is PoE-compliant, allowing transmission of power and data via a sin-
gle Ethernet cable. Follow the below illustration to connect the Network Camera to a PoE-
enabled switch via Ethernet cable.

802.3at
PoE Switch

; SRR L
[ TR

Depending on the requirements of your installation site, select an appropriate power source,
such as an 802.3at PoE (30W) for operating temperature higher than -10°C. For extremely low
temperature, you will need a power source higher than 21W, such as 24V AC.

If using an 802.3at PoE as the power source, the lowest operating temperature is -20°C.

O When using a non-PoE switch

Use a 802.3at PoE power injector (optional) to connect between the Network Camera and a
non-PoE switch.

PoE Power Injector
(optional)

Non-PoE Switch

NOTE:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed I.T.E. with PoE output.



Internet connection via a router

Before setting up the Network Camera over the Internet, make sure you have a router and follow
the steps below.

1. Connect your Network Camera behind a router, the Internet environment is illustrated below.
Regarding how to obtain your IP address, please refer to Software Installation on page 23 for
details.

&

IP address : 192.168.0.3
Subnet mask : 255.255.255.0
WAN (Wide Area Network )

Default router : 192.168.0.1
Router IP address : from ISP,

Internet

LAN (Local Area Network)
Router IP address : 192.168.0.1

= §
Cable or DSL Modem ‘

IP address : 192.168.0.2
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.

m HTTP port: default is 80

m RTSP port: default is 554

m RTP port for video: default is 5556
m RTCP port for video: default is 5557

If you have changed the port numbers on the Network page, please open the ports
accordingly on your router. For information on how to forward ports on the router, please refer
to your router’s user’s manual.

3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).

Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 98 for details.

Internet connection with static IP

Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN setting on page 97 for details.

Internet connection via PPPoE (Point-to-Point over Ethernet

Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 98 for details.



Configure the router, virtual server or firewall, so that the router can forward any data com-
ing into a preconfigured port number to a network camera on the private network, and
allow data from the camera to be transmitted to the outside of the network over the same
path.

From Forward to
122.146.57.120:8000 (192.168.2.10:80
122.146.57.120:8001 [192.168.2.11:80

When properly configured, you can access a camera behind the router using the HTTP
request such as follows: http://122.146.57.120:8000

If you change the port numbers on the Network configuration page, please open the ports
accordingly on your router. For example, you can open a management session with your
router to configure access through the router to the camera within your local network.
Please consult your network administrator for router configuration if you have troubles with
the configuration.

For more information with network configuration options (such as that of streaming ports),
please refer to Configuration > Network Settings. VIVOTEK also provides the automatic
port forwarding feature as an NAT traversal function with the precondition that your router
must support the UPnP port forwarding feature.

Gat P address. autcmatcaly

General ssttings Uee foied P address
Sireaming proteoots ¥, Enable UPnP presenistion
DOHS ¥ Enabie UPSP por forwarding
Dol PPRE

SHMP ¢ Enable PG

_ The device & configurng now. Yisar brosw ser will neconnect
Security IPv6 informy b hitpr1SE 168 4. 180-80¢
Hihe connson fply, please manualy enler the sbinve P

Lanualy
PTZ ddnesy in yoar Browaer

Save




VIVOTEK

Cybersecurity

Once you open the web console, enter Configuration > Applications > Package
management, and click on Trend Micro loT Security. Turn on the protection to fend off cyber
attacks.

In here, you can let the camera automatically update the virus codes or manually update the
virus codes.

VIVOT=K

Home Client settings eI [IEIIGLE Language
Applications > Package management

System W m

Media ~ Upload
Select file = Upload
Network e 2
Security . status
CPU loading: 8%
P1Z
Internal storage total size: 1951.828 MB Free size: 1805.843 MB
Event Memory total size: 1982.039 MB Free size:  1033.066 MB
Applications
Motion detection - Clean
Smart Tracking Advanced Notice! It will erase system temporary files and the files upload from FTP. |
Dland DO
Tampering detection
Audio detection o list
Package management Name Version Status  License size W
O Trend Micro loT Security 1.3e.a1.8.4 Installed N/A 6.304MB ©F 0
Recordin
9 (O  smart tracking advanced 6.15.1.1-3e OFF Pass 14761 MB 4 1
Storage @) Stratocast 13e.a153 ON N/A 3085MB ©4 0
[ Start Il Stop |[___schedule

Cybersecurity

>

Trend Micro loT Security On/off @)
Signature update
Current Version: 1.028

Auto Update ‘)

Manual Update:

Select Signature File : | | m=_ || Upgrade

Event Tigger for 3rd party Software

Brute force attack D
Cyber attack ‘)
Quarantine event [ @

License Expiration event @)

Attack Block Summary

Since 2020/05/05, block total 0 hits
@Copyright VIVOTEK Inc




VIVOTEK

Ready to Use

1.A browser session with the Network Camera should prompt as shown below.

2.You should be able to see live video from your camera. You may also install the 32-channel
recording software from the software CD in a deployment consisting of multiple cameras. For
its installation details, please refer to its related documents.

3. Click to expand the Video stream menu to select to display individual sensor.

User's Manual - 37




Accessing the Network Camera

This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and VIVOTEK recording software.

Using Web Browsers

Use the Shepherd utility to access the Network Cameras on LAN.

If your network environment is not a LAN, follow these steps to access the Netwotk Camera:

1. Launch your web browser (e.g., Microsoft® Internet Explorer or Mozilla Firefox).

2. Enter the IP address of the Network Camera in the address field. Press Enter.

3. Live video will be displayed in your web browser.

4. If it is the first time installing the VIVOTEK network camera, an information bar will prompt as
shown below. Follow the instructions to install the required plug-in on your computer.

<} O K& G Psewar Jprovnes @ORSEB

e [ sz 9551

ontrof from VIVOTEK INC., Clck here to nsta.

Mega-Pixel Network Camera

This is  plug-in (ActiveX). f you see this text, your browser is not support or disable ActiveX.

(o)) (s)(o] (] n] ) () #](=]

e abous the Information Bas

@ pone © intemet one




» By default, the Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to set a password for the Network Camera.
For more information about how to enable password protection, please refer to Security on
page 118.

» If you see a dialog box indicating that your security settings prohibit running ActiveX®
Controls, please enable the ActiveX® Controls for your browser.

1. Choose Tools > Internet Options > Security > Custom Level.

Internet Options

General| Secuity | Privacy | Content | Connections | Programs | Advanced

Select a'web content zone to specify itz security settings.

® €« 0 @
Localintranet  Trusted sites  Restricted
gihes

Internet

Thiz zohe containg all'web sites you
haven't placed in ather zones

Security level for this zone

Custom
Cusztom zettings.
- To chahge the settings, click Customn Level.
- Ta use the recommended settings, click Default Level

’ Custom Lewvel .. ] Default Level ]

[ 0k H Canicel ]

2. Look for Download signed ActiveX® controls; select Enable or Prompt. Click OK.

Setkings:

Activer controls and plug-ins ”
E] Dovnload signed Activer controls
() Disable
II:II Enable
(@) Promnpk
] Download unsigned Activei conkrols
() Disable
IIEII Enable
'Z:_:Z' Pronipk
E] Initialize and scripk ActiveX controls nok marked as safe
() Disable
IIEII Enable
'Z:_:Z' Pronipk

i I TSI, WS SRy Y SpRpy ey PRppepups [Py RPpepy

£ b4

Reset cuskom setkings

Reset ka: | Medium b

[ K l[ Cancel ]

3. Refresh your web browser, then install the ActiveX® control. Follow the instructions to
complete installation.



A IMPORTANT:

Currently the Network Camera utilizes a 32-bit ActiveX plugin. You CAN NOT open a
management/view session with the camera using a 64-bit IE browser.
If you encounter this problem, try execute the lexplore.exe program from C:\Windows\
SysWOW64. A 32-bit version of IE browser will be installed.
On Windows 7, the 32-bit explorer browser can be accessed from here:

C:\Program Files (x86)\Internet Explorer\iexplore.exe

If you open a web session from the Shepherd utility, a 32-bit IE browser will be
opened.

-‘@’- Tips:
1. The onscreen Java control can malfunction under the following situations: A PC con-

nects to different cameras that are using the same IP address (or the same camera

running different firmware versions). Removing your browser cookies will solve this
problem.

2. If you encounter problems with displaying the configuration menus or Ul items, try dis-
able the Compatibility View on IE8 or IE9.

al )| J® http://www joinsmsn.com L ~|28c X

You may also press the F12 key to open the developer tools utility, and then change the
Browser Mode to the genuine IE8 or IEQ mode.

T El@
File Find Disable View Images Cache Tools Yalidate DDcumentMDde: IE9 standards =
HTML | CS55 Console Script  Profiler Metwork Internet Explorer 7 P
h = | 4 2 il Internet Explorer &

- <IDOCTYPE html PUBLIC “-//W3C//DTD XHTHL 1.p | Y IntemetExplorerd

H-<html xmlns="http://www.i /1999 xhtml"> Internet Explorer 8 Compatibility View

* In the event of plug-in compatibility issues, you may try to uninstall the plug-in that was
previously installed.

Business Explorer
Camera Stream Controller
¢ Uninstall

Catalyst Control Center

m



Using RTSP Players

To view the streaming media using RTSP players, you can use one of the following players that
support RTSP streaming.

{“‘, VLC media player

1. Launch the RTSP player.

2. Choose File > Open URL. A URL dialog box will pop up.

3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
stream1 or stream2>

As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 106.
For example: A

A Open Media -
Playlist (") File @) Disc &2 Network [EF Capture Device
Playlist Network Protocol

Media Librar Please enter a network URL;

Jrtsp://192.168.51.64:554/livels].sdp)

My Computer
My Videos

4. The live video will be displayed in your player.
For more information on how to configure the RTSP access name, please refer to RTSP
Streaming on page 106 for details.

A rtsp://192.168.51.145:554/lives1.5dp - VLC media player - o X
Media Playback Audio Video Subtitle Tools View Help

.t <
00:25 00:00
.3

I w2t (5 S o ]




Using 3GPP-compatible Mobile Devices

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page

34.
To utilize this feature, please check the following settings on your Network Camera:

1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 106.

2. As the the bandwidth on 3G networks is limited, you will not be able to use a large video size.
Please set the video streaming parameters as listed below.
For more information, please refer to Stream settings on page 84.

Video Mode H.264
Frame size 176 x 144
Maximum frame rate 5 fps
Intra frame period 1S

Video quality (Constant bit rate) 40kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 106.

4. Launch the player on the 3GPP-compatible mobile devices (e.g., VLC player).
5. Type the following URL commands into the player.

The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming
access name for stream # with small frame size and frame rate>.

For example: 3 :
£ Open Media - X
Playlist [) File @) Disc %2 Network [=F Capture Device
Playlist Network Protocol
i Media Librar Please enter a network URL:
My Computer lis0.7192.168.51.64:554/live s sd) v
My Videos
My Music
[ZZ] My Pictures
Devices
@ Discs
\/
e D Show more options
Play |~ Cancel
| e[l o L)

You can configure Stream #2 into the suggested stream settings as listed above for live
viewing on a mobile device.



Using VIVOTEK Recording Software

The product software CD also contains a VAST recording software, allowing simultaneous
monitoring and video recording for multiple Network Cameras. Please install the recording
software; then launch the program to add the Network Camera to the Channel list. For detailed
information about how to use the recording software, please refer to the user’s manual of the
software or download it from http://www.vivotek.com.

WV VAsST

FE8180

1920x1920: \

H264 \‘
i\

-‘@’- Tips:
1. If you encounter problems with displaying live view or the onscreen plug-in control, you may try

to remove the plug-ins that might have been installed on your computer. Remove the following
folder: C:\Program Files (x86)\Camera Stream Controller\.

2. If you forget the root (administrator) password for the camera, you can restore the camera
defaults by pressing the reset button for longer than 5 seconds.

3. If DHCP is enabled in your network, and the camera cannot be accessed, run the Shepherd
utility to search the network. If the camera has been configured with fixed IP that does not
comply with your local network, you may see its default IP 169.254.x.x. If you still cannot find
the camera, you can restore the camera to its factory defaults.

4. If you change your network parameters, e.g., added a connection to a LAN card, re-start the
Shepherd utility.


http://www.vivotek.com

Main Page

This chapter explains the layout of the main page. It is composed of the following sections:
VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, Menu, and Live
Video Window.

Resize Buttons Configuration Area

Vng/gOOTEK & MA9322-EHTVL Host Name
T— [ ] _ ) _ = e

Camera Control
Area

Live View Window

VIVOTEK INC. Logo
Click this logo to visit the VIVOTEK website.

Host Name

The host name can be customized to fit your needs. The name can be changed especially there are many
cameras in your surveillance deployment. For more information, please refer to System on page 56.

Camera Control Area

Stream profile: This Network Camera supports multiple streams simultaneously. You can select any of
them for live viewing. Each profile corresponds to one video stream for one sensor (CH, channel). There
are 4 sensors, and each sensor (CH) supports 3 different video streams.

CH1 Max view - Stream 1 (configurable, default 2688 x 1920)
CH1 Recording - Stream 2 (configurable, default 1280 x 960
CH2 Max view- Stream 1 (configurable, default 2688 x 1920
CH2 Recording - Stream 2 (configurable, default 1280 x 960
CH3 Max view- Stream 1 (configurable, default 2688 x 1920
CH3 Recording - Stream 2 (configurable, default 1280 x 960)
CH4 Max view - Stream 1 (configurable, default 2688 x 1920)
CH4 Recording - Stream 2 (configurable, default 1280 x 960)

I—"

—"

I—"

I~—"




For more information about multiple streams, please refer to page 71 for detailed information.

Manual Trigger: Click to enable/disable an event trigger manually. Please configure an event setting on
the Application page before you enable this function. A total of 3 event configuration can be configured.
For more information about event setting, please refer to page 136. If you want to hide this item on
the homepage, please go to Configuration> System > Homepage Layout > General settings >
Customized button to deselect the “show manual trigger button” checkbox.

Digital Output: Click to turn the digital output device on or off.

Configuration Area

Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 50.

Configuration: Click this button to access the configuration page of the Network Camera. It is suggested
that a password be applied to the Network Camera so that only the administrator can configure the
Network Camera. For more information, please refer to Configuration on page 55.

Language: Click this button to choose a language for the user interface. Language options are available
in: English, Deutsch, Espafiol, Frangais, Italiano, P 3%, Portugués, @ i+ ¢ <, %4%8¢ < and Pycckuii.
Please note that you can also change a language on the Configuration page; please refer to page 55.

Hide Button
You can click the hide button to hide or display the control panel.

Resize Buttons

B Sl B 100%: | EH S0% | BH 254 | |

Click the Auto button, the video cell will resize automatically to fit the monitor.
Click 100% is to display the original homepage size.

Click 50% is to resize the homepage to 50% of its original size.

Click 25% is to resize the homepage to 25% of its original size.




Live Video Window

m The following window is displayed when the video mode is set to H.265 or H.264:

H.264 Protocol and Media Options

CTITE Client settings | Config

Video Title

d_|—Time
Title and Time

Zoom Indicator-

PTZ panel and Global view are available
when displaying the Recording profile.

Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 70.

H.264 or H. 265 Protocol and Media Options: The transmission protocol and media options for H.264
video streaming. For further configuration, please refer to Client Settings on page 50.

Time: Display the current time. For further configuration, please refer to Media > Image > Genral settings
on page 70.

Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Media > Image > General settings on page 75.

PTZ Panel: This Network Camera supports “digital® (e-PTZ) pan/tilt/zoom control, which allows roaming
a smaller view frame within a large view frame. Please refer to PTZ settiings on page 133 for detailed
information.

Global View: Click on this item to display the Global View window. The Global View window contains a
full view image (the largest frame size of the captured video) and a floating frame (the viewing region of
the current video stream). The floating frame allows users to control the e-PTZ function (Electronic Pan/
TiltYZoom). For more information about e-PTZ operation, please refer to E-PTZ Operation on page 133.
For more information about how to set up the viewing region of the current video stream, please refer to
page 133.

= Global View:

The viewing region of
the curruent video
stream

The largest frame size

Moving Instantly



Note that the PTZ buttons on the panel are not operational unless you are showing only a portion of the
full image. If the live view window is displaying the full view, the PTZ buttons are not functional.

Move Instantly: If you choose to display only a portion of the total field of view, say, zoomed in on the
current field of view using the Global View setting, you can select or deselect the “Move Instantly” option.
Move Instantly means the process of moving from one portion to another is not shown on screen.

Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

¥ Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

2 Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

Disable digital ptz

Zoom Factor:

\-j |~
. 100% 400%

IEI Pause: Pause the transmission of the streaming media. The button becomes the ' » | Resume button
after clicking the Pause button.

- Stop: Stop the transmission of the streaming media. Click the | ® Resume button to continue
transmission.

| » | Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the @ Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving

Options on page 51 for details.

Volume: When the |"¥2 Mute function is not activated, move the slider bar to adjust the volume on the
local computer.

"19 Mute: Turn off the volume on the local computer. The button becomes the A" Audio On button after
clicking the Mute button.

¥ Talk: Click this button to talk to people around the Network Camera. Audio will project from
the external speaker connected to the Network Camera. Click this button [El again to end talking
transmission.

Mic Volume: When the | ¥ Mute function is not activated, move the slider bar to adjust the
microphone volume on the local computer.



@ NOTE:

1. For a megapixel camera, it is recommended to use monitors of the 24" size or larger, which
are capable of 1600x1200 or better resolutions.
2. Below are the defaults for Audio settings:
For cameras with built-in microphone: Not Muted.
For cameras without built-in microphone: Muted.

To receive audio input from an external microphone, you may need to enable the audio input
from Media > Audio. Refer to page 94 for more information.

@ Mute: Turn off the Mic volume on the local computer. The button becomes the Mic On button
after clicking the Mute button.

@ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.

m The following window is displayed when the video mode is set to MJPEG:

T Client settings | Configural
Video Title +—Time

Title and Time

Zoom Indicator

o)[2)[e][c] cob—ssesn Video Control Buttons



Video Title: The video title can be configured. For more information, please refer to Media > Image
on page 75.

Time: Display the current time. For more information, please refer to Media > Image on page75.

Title and Time: Video title and time can be stamped on the streaming video. For more information,
please refer to Media > Image on page 75.

Video Control Buttons: Depending on the Network Camera model and Network Camera
configuration, some buttons may not be available.

3 Snapshot: Click this button to capture and save still images. The captured images will be
displayed in a pop-up window. Right-click the image and choose Save Picture As to save it in
JPEG (*.jpg) or BMP (*.bmp) format.

2 Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The
navigation screen indicates the part of the image being magnified. To control the zoom level, drag
the slider bar. To move to a different area you want to magnify, drag the navigation screen.

Disable digital ptz

Zoom Factor:

—
100%

@ | Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.
Press the El Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4
Saving Options on page 51 for details.

[ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to
normal mode.



Client Settings

This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.

H.265 / H.264 Media Options

H.265/H.264 media options

Video and audio| v |

Select to stream video or audio data or both. This is enabled only when the video mode is set to H.264.

H.265 / H.264 Protocol Options

H.265/H.264 protocol options
TCP ]

Depending on your network environment, there are four transmission modes of H.264 streaming:

UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.

UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 105.

TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of the UDP protocol.

HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users inside a firewall can utilize this protocol to allow
streaming data through.



Two way audio
Two way audio

@ Half-duplex

Full-duplex

Half duplex: Audio is transmitted from one direction at a time, e.g., from a PC holding a web console with
the camera.
Full duplex: Audio is transmitted in both directions simultaneously.

MP4 Saving Options

MP4 saving options

Folder; ClRecord

File name prefix  cLIP

Add date and ime sufiixio file name

Users can record live video as they are watching it by clicking | ® ' Start MP4 Recording on the main
page. Here, you can specify the storage destination and file name.

Folder: Specify a storage destination on your PC for the recorded video files. The location can be
changed.

File name prefix: Enter the text that will be appended to the front of the video file name. A specified folder
will be automatically created on your local hard disk.

Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.

( 1\

CLIP_20190321-180853

toot

File name prefix Date and time suffix
The format is: YYYYMMDD_HHMMSS

Local Streaming Buffer Time

Local streaming buffer time

0 Millisecond

| save |

In the case of encountering unsteady bandwidth, live streaming may lag and video streaming may not be
very smoothly. If you enable this option, the live streaming will be stored temporarily on your PC’s cache
memory for a few milli seconds before being played on the live viewing window. This will help you see
the streaming more smoothly. If you enter 3,000 Millisecond, the streaming will delay for 3 seconds.



Joystick settings

Enable Joystick

Connect a joystick to a USB port on your management computer. Supported by the plug-in
(Microsoft’s DirectX), once the plug-in for the web console is loaded, it will automatically detect if
there is any joystick on the computer. The joystick should work properly without installing any other
driver or software.

Then you can begin to configure the joystick settings of connected devices. Please follow the
instructions below to enable joystick settings.

1. Select a detected joystick, if there are multiple, from the Selected joystick menu. If your joystick
is not detected, if may be defective.

2. Click Calibrate or Configure buttons to configure the joystick-related settings.

Joystick settings

Selected joystick: | [TEEIE T |
| Calibrate | | Configure buttons
| Save |
{) NOTE:

* If you want to assign Preset actions to your joystick, the preset locations should be configured
in advance in the Configuration > PTZ page. In Windows, use the search function on the Start
menu to search for Game Controller.

+ If your joystick is not working properly, it may need to be calibrated. Click the Calibrate button
to open the Game Controllers window located in Microsoft Windows control panel and follow the
instructions for trouble shooting.

* The joystick will appear in the Game Controllers list in the Windows Control panel. If you want to
check out for your devices, go to the following page: Start -> Control Panel -> Game Controllers.

Game Controllers @E]

e Thesze zettings help you configure the game contrallers inztalled on
I

-k
.f}-;:" pour cornpuiber.

Inztalled game controllers

Controller Status
CH PRODUCTS IF DESKTOF COMTROLLER

Add... l [ Femove l [ Properties l

[ Advanced... ][ Troubleshoat... ]




Buttons Configuration

In the Button Configuration window, the left column shows the actions you can assign, and the right
column shows the functional buttons and assigned actions. The number of buttons may differ from

different joysticks.

Please follow the steps below to configure your joystick buttons:

1. Choosing one of the actions and click Assign will pop up a dialog. Then you can assign this
action to a button by pressing the joystick button or select it from the drop-down list.
For example: Assign Home (move to home position) to Button 1.

i\l
Assigned Actions

Actions

oarm 16
Zoorm Cut

+- Focus

+- Iris
Pan
Stop
Patraol

+- Preset
Page p
Page Downh
Record to AV
Shapshot Auto Mamming

Buttons Azzigned Actions

M

Press the joystick button to assign to "Home" or
select the button from the list below,

[Buttonl
Buttonz
Button3
Buttond
ButtonS
ButtonG
Button?
Buttong

] [ Canicel

J

Buttong

Buttonlo
Buttonll
Buttonlz

Cancel

x|

2. Click OK to confirm the configuration.

L
Aszigned Actions

Actions

¥ "Home"

Home
Zoam In
Zoom Ot
+-Focus
£ Iris
Pan
Stop
Patrol
= Preset
Preszet]
Preszetd
Preszet3
Preszet4

Buttonl

Press the joystick button to assign to "Horme" or
select the button from the list below,

Click "Ck" to assign " to buttonl

3

Lssign

Clear Selected

] [ Cancel




Buttons Configuration

Click the Configure Buttons button, a window will prompt as shown below. Please follow the steps

below to configure your joystick buttons:

1. Select a button number from the Button # pull-down menu.

G IR

€] http://192.168.6.231/setup//canfigure_buttens.html

>Joystick Settings

-‘@’- Tips:

If you are not sure of the locations of each
button, use the Properties window in the Game

= Macally AirStick p
Seffings  Test |

21X

Test the game contraller. If the cantralleris not functioning properly. it sy
need to be calbrated. To calbiatz it go to the Setlings page

m"

Hbds /Y Bods Sld

Pairt of Yiew Hat |

O

0900000660
oODD®®

2. Select a corresponding action, such as Patrol or Preset#.
(@ nitp//192.168.6.231/eetup/eonTigre b | (l=in|

| £ http://192.168.6.231 /setup/configure_buttons.html |

>Joystick Settings
Actions: Toggle play/pause -
Toggle play/pause -

3. Click the Assign button to assign an action to
the button. You can delete an association by
selecting a button number, and then click the
Delete button.

Repeat the process until you are done with the
configuration of all preferred actions.

The buttons you define should appear on the
button list accordingly.

. Please remember to click the Save button
on the Client settings page to preserver your
settings.

el | o |

Actions: | Toggle playipause  [«|
Controllers utility.
Button: |1
OK
i =
Button |3 Assigned Actions 20|
-] ; FLl ” S creen ‘ %L“:;h ;:ue'scens’:'t:llw‘r:g's help you configure the game controllers installed on
2 i} Stop Instalied game contraliers
7 Confioller [ Status
3 g Zoomin Macally AitStick oF.
4 9
10
5 1 Patrol
6 12 Toggle play/pause Add | Remove | Propeies |
7
Advanced.. Troubleshoot,
8
9 o |
10 |
11
12 Snapshot
€ EREE | SR M fa v ®100% «

[

Button:

Button

== N = L )

10
"
12

@ FE

Stop streaming
Snapshot

Full Screen

Start'stop recording
Pan

Patrol

Stop

Zaomin

Zaoom out

Digital output on/off 1
Digital output on/off 2
Digital output onfoff 3
Digital cutput on/off 4
Manual trigger on/off 1
Manual trigger on/off 2
Manual trigger onfoff 3
Preset 1

Preset 2

Preset 3

Preset 4

Preset 5

Preset 6

Preset 7

Preset 8

Preset9

Preset 10

Preset 11

Preset 12

Preset 13

Assign

ararm |




Configuration

Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.

VIVOTEK provides an easy-to-use user interface that helps you set up your network camera
with minimal effort. In order to simplify the user interface, detailed information will be hidden
unless you click on the function item. When you click on the first sub-item, the detailed
information for the first sub-item will be displayed; when you click on the second sub-item, the
detailed information for the second sub-item will be displayed and that of the first sub-item will
be hidden.

The following is the interface of the main page:

VIVOT=K - . ;
ome Client settings COnﬁguratlon

System > General settings

Navigation Area

System
General settings Host name: MA9322-EHTVL
IEEEEED Ee! () Tum off the LED indicator
Logs
Parameters System time
Maintenance Time zone:
GMT+08:00 Beijing, Chongging, Hong Kong, Kuala Lumpur, Singapore, Taipei, Irkutsk v

(@ Keep current date and time
() Synchronize with computer time
(O Manual

PTZ (O Automatic

Applications

Configuration List
Recording

Storage

fersion: 0100d Firmware Version

Each function on the configuration list will be explained in the following sections.

The Navigation Area provides access to all different views from the Home page (for live viewing),
Configuration page, and multi-language selection.
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System > General settings

This section explains how to configure the basic settings for the Network Camera, such as the
host name and system time. It is composed of the following two columns: System, and System
Time. When finished with the settings on this page, click Save at the bottom of the page to
enable the settings.

System

System

Host name: Mega-Pixel Network Camera

[ 1Tum off the LED indicator

Host name: Enter a desired name for the Network Camera. The text will be displayed at the top of the
main page, and also on the view cells of the ST7501 and VAST management software.

Turn off the LED indicators: If you do not want others to notice the network camera is in operation, you
can select this option to turn off the LED indicators.
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System time

System time
Time zone:

GMT+08:00 Beijing, Chongging, Hong Kong, Kuala Lumpur, Singapore, Taipei, Irkutsk

[«

() Keep current date and time
(_)Synchronize with computer time
() Manual
(@) Automatic
NTF server: pool.ntp.org

Updating interval: One hour ||

Save

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
power of the system is turned off.

Synchronize with computer time: Select this option to synchronize the date and time of the Network
Camera with the local computer. The read-only date and time of the PC is displayed as updated.

Manual: The administrator can enter the date and time manually. Note that the date and time format are
[yyyy/mm/dd] and [hh:mm:ss].

Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.

NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers. The precondition is that the camera must
have the access to the Internet.

Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.

Time zone : Select the appropriate time zone from the list. You can scroll down on the Time zone menu to
find the Customize option and use the POSIX TZ variables. For example, http://www.gnu.org/software/

libc/manual/html_node/TZ-Variable.html.

Time zone:
Customize
POSIX TZ: WGT3

[e

Enable daylight saving time
Starting time:

Ending time:

Here are some examples for TZ values, including the appropriate Daylight Saving Time and its
dates of applicability. In North American Eastern Standard Time (EST) and Eastern Daylight
Time (EDT), the normal offset from UTC is 5 hours; since this is west of the prime meridian,
the sign is positive. Summer time begins on March’s second Sunday at 2:00am, and ends on
November’s first Sunday at 2:00am. EST+5EDT,M3.2.0/2,M11.1.0/2

Israel Standard Time (IST) and Israel Daylight Time (IDT) are 2 hours ahead of the prime
meridian in winter, springing forward an hour on March’s fourth Thursday (i.e., on the first Friday
on or after March 23), and falling back on October’s last Sunday.

IST-2IDT,M3.4.4,M10.5.0



Western Argentina Summer Time (WARST) is 3 hours behind the prime meridian all year.
There is a dummy fall-back transition on December 31 at 25:00 daylight saving time (i.e.,
24:00 standard time, equivalent to January 1 at 00:00 standard time), and a simultaneous
spring-forward transition on January 1 at 00:00 standard time, so daylight saving time is in
effect all year and the initial WART is a placeholder.

The format is TZ = local_timezone,date/time,date/time.
Here, date is in the Mm.n.d format, where:

Mm (1-12) for 12 months
n (1-5) 1 for the first week and 5 for the last week in the month
d (0-6) 0 for Sunday and 6 for Saturday

CST6CDT is the name of the time zone

CST is the abbreviation used when DST is off

6 hours is the time difference from GMT

CDT is the abbreviation used when DST is on
,M3 is the third month

.2 is the second occurrence of the day in the month
.0 is Sunday

/2 is the time

,M11 is the eleventh month

.1 is the first occurrence of the day in the month
.0 is Sunday

/2 is the time

The minimum specifier is down to the hour.



System > Homepage layout

This section explains how to set up your own customized homepage layout.

General settings

This column shows the settings of your hompage layout. You can manually select the background and
font colors in Theme Options (the second tab on this page). The settings will be displayed automatically
in this Preview field. The following shows the homepage using the default settings:

General settings | | Theme options

VIVOT=ZK MA9322-EHTVL

Video stream

# Manual triggers:

*

Digital output: |']_rI:T| z

02l e](e] x|kl c

[ [P VIVOTeK —

[[J Hide Powered by VIVOTEK

m Hide Powered by VIVOTEK: If you check this item, it will be removed from the homepage.

Logo graph
Here you can change the logo that is placed at the top of your homepage.

|_1'H_|n |JI4'||}|I

A customized loga (Gif, JPG or PHG) can bhe uploaded for main page. it will he resized to
160x50 pixels to replace the previous logo.

i~ pefault ¥ Custom

- |— e |
Y viverzk -

Logo link: | hitp:iteenas vivotek com

Follow the steps below to upload a new logo:

1. Click Custom and the Browse field will appear.

2. Select a logo from your files.

3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.

5. Click Save to enable the settings.

Customized button
If you want to hide manual trigger buttons on the homepage, please uncheck this item. This item is
checked by default.

Customized button

V| Show manual trigger button




Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you
to choose from. The new layout will simultaneously appear in the Preview filed. Click Save to enable the

settings.

General settings

VIVOT=K

Font Color

Background Color of the
Control Area

Font Color of

Video stream

# Manual triggers:

Theme options

MA9322-EHTVL

Digital output: | on| Of ¢
the Configuration Area
02 n]j(e][o[x] « B[ ¥] =]
Background Color of the | | Powered by VIVOTEK | |
Configuration Area
Themes Color
Font color:
Font color of configuration area: #FFFFFF
@ 9
Preset pattems Font color of video title:
O - Bk color of control area: #EBEBEB
- Bk color of configuration area: -
O
[ | Bk color of video area: #FFFFFF
O Custom Frame color: #FFFFFF

Save

VIVOT=K

Video stream
# Manual triggers:

Digital output: |on|of

Powered by VIVOTEK

MA9322-EHTVL

L]

SO TP

VIVOT=K

Video stream

Manual triggers:

Digital output:

Powered by VIVOTEK

MA9322-EHTVL

g"ﬂ y Y >

=ML

aloli[e] ol Rl ]c!

Font Color of the
Video Title

Background Color of
the Video Area

Frame Color



m Follow the steps below to set up the customed homepage:
1. Click Custom on the left column.
2. Click the field where you want to change the color on the right column.

Themes Color
Font color:
Font color of configuration area: #FFFFFF
f— 9

Color Selector
Font color of video title:

Bk color of control area:
Bk color of configuration area:

|| - Bk color of video area:

Custom s Custom Frame color;
Pattern

3. The palette window will pop up as shown below.

Hex: #000000 h
Red: 1]

Green: 0

Blue: 1]

Hue: 1] Hue: 212
Saturation: |0 Saturation: IE
Yalue: 1] Y alue: 4.1

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will be displayed in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.



System > Logs

This section explains how to configure the Network Camera to send the system log to a remote
server as backup.

Log server settings
Log server settings
7| Enable remote log
|IP address:

port: 514

Save

Follow the steps below to set up the remote log:

1. Select Enable remote log.

2. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.

3. When completed, click Save to enable the setting.

You can configure the Network Camera to send the system log file to a remote server as a log backup.
Before utilizing this feature, it is suggested that the user install a log-recording tool to receive system log
messages from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.
com/kiwi-syslog-daemon-overview/.

(=] )
30 Days left in evalustion
i Message
06272011 17:08:48 Sysloginfo  192.168.4.103 syslogd 1.5.0: restart
06272011 1706557 Userlnfo 192.168.4.103 [RTSP SERVER]: Stop
06272011 1706557 Userlnfo 192.168.4.103 last message repeated
06-27-2011 17:06:13 User.Info 192.168.4.103 [RTSP SERVER]: Start
06-27-2011 17:06:12 192.168.4.103 [RTSP SERVER]: src/: 0. XMLSParser. _Readall File /var/iun/sessioninfo failed! "M
06-27-2011 17:06:12 192.168.4.103 [RTSP SERVER]: XML ent element at line 6°M

06-27-2011 17:06:12
06-27-2011 17:06:12
06:27-2011 17:06:10
06-27-2011 17:06:08
06:27-2011 17:06:07
06-27-2011 17:06:06
06-27-2011 17:06:06
06-27-2011 17:06:05
06-27-2011 17:06:03
06272011 17:06:01
06-27-2011 17:06:00 Daer
06-27-2011 17:06:00 Daer

192168.4.103 [RTSP SERVER]: Stop
192.168.4.103 [RTSP SERVERL:
192.168.4.103 [UPNP DEVICEL
192.168.4.103 [DRM Servicel: Starting DRM service.

1921684103 [ I Ready to watch htpd.

e 192168.4.103 ug s 192.168.0.10 192.168.0.20
e 192168.4.103 uc ter 192.168.4.1
e 192168.4.103 udhcpe: IP 192168.4.103
192168.4.103 [EVENT MGRI: the process

ask 255.255.255.0

ent #1 is skipped because of low priority 0

e 192168.4.103 udhcpe: router 192.16¢
e 192168.4.103 udhcpo: IP 192.168.4.103 netmask 255.255.255.0
e 192.168.4.103 udhepe: deconfig

System log

save
System log | Access log

Jan 5 11:36:07 syslogd 1.5.0: restart.

Jan 5 11:36:08 [swatchdog]: Ready to watch httpd.

Jan 5 11:36:09 [EVENT MGR]: Starting eventmgr with support for EcTun

Jan 5 11:36:11 [DRM Service]: Starting DRM service.

Jan 5 11:36:20 [UPnPIGDCP]: Search IGD failed

Jan 5 11:36:23 automount[718]: >> mount: mounting /dev/immcblkOp1 on /mnt/aute/CF failed: No such
device or address i
Jan 5 11:36:23 automount[718]: mount(generic): failed to mount /dev/immcblkOp1 (type vfat)

on /mnt/auto/CF

Jan 5 11:36:23 [IR Cut Control]: Day mode

Jan 5 11:36:23 automount[728]: >> mount: mounting /dev/mmcblkOp1 on /mnt/auto/CF failed: No such
device or address

Jan 5 11:36:23 automount[728]: mount(generic): failed to mount /dev/immcblkOp1 (type viat)

on /mnt/auto/CF

Jan 5 11:36:23 [IR Cut Control]: Day mode

Jan 5 11:36:23 [SYS]: Serial number = 0002D10ED4C9

Jan 5 11:36:23 [SYS]: System starts at Wed Jan § 11:36:23 UTC 2011

This column displays the system log in a chronological order. The system log is stored in the Network
Camera’s buffer area and will be overwritten when reaching a certain limit.
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You can install the included VAST recording software, which provides an Event
Management function group for delivering event messages via emails, GSM short

messages, onscreen event panel, or to trigger an alarm, etc. For more information, refer to
the VAST User Manual.

VIVOTEK Network Cameras

f\\

3G Cell phone

Email
Cell phone GSM Server with
Short message Modem

VAST Recording Software .
C'? . b )

Deterrent

Digital output PTZ
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Access log

save

System log | | Access log | | Set parameter log | VADP log

Jan 5 11:36:28 [RTSP SERVER]: Start one session, IP=172.16.2.52
Jan 5 11:49:15 [RTSP SERVER]: Start one session, [P=192.168.4.105
Jan 5 13:11:20 [RTSP SERVER]: Start one session, IP=192.168.4.105

Access log displays the access time and IP address of all viewers (including operators and
administrators) in a chronological order. The access log is stored in the Network Camera’s buffer
area and will be overwritten when reaching a certain limit.

Set Parameter log

VADP log contains the history of changes made to system parameters such as recording, imaging
parameters, and all other parameters.

VADP log

VADP log contains the information for the onboard VADP packages, including memory usage,
module load and unload information.

System log | Access log | | Set parameter log | VADP log

Jan 14 20:22:30 MADP]: Jan 14 20:22:30 [VADP]: File system disk space usage Jan 14 20:22:30

ADF]: Filesystem Size Used Available Use% Mounted on Jan 14 20:22:30 WADP]: ™
ubi1-flashis2 323 42M 26.4M 14% fmntflash2 Jan 14 20:22:30 [VADP]:
""""""""""""""" Jan 14 20:22:30 WADP].  Start to upgrade preload package

Jan 14 2002230 [VADP], s s Jan 14 20:22:30 WADP]: Preload

package Size: 3.2M Jan 14 20:22:32 [WADPL: Untar package Size: 6.9M Jan 14 20022:32 MMADPI:
Trend Micro loT Security Preload Package Version: 1.1b.a1.7.5 Jan 14 20:22:41 [WADP]: Update
configuration.._ Jan 14 2002242 WVADP]: Jan 14 20:22:42 NADP]: Trend Micro loT Security is
stopped Jan 14 20:22:43 [WADFP]: File system disk space usage Jan 14 20:22:43 [WADP]: Upgrade

Filesystem Size  Used Available Use Mounted on Jan 14 20:22:43 [VADP]: Before
Lbi1:flashfs2 323M 1AM 205M 3% /mintfflash2 Jan 14 20:22:43 [WADP]: After
ubi1:flashfs2 323M B6.0M 246M 20% /mntflash2 Jan 14 20:22:43 [MADP]: File space

usage: Jan 14 20:22:43 WADP]: Upgrade 3Size PathJan 14 202243 MMADP]: Before 0Jan 14
20:22:43 VADP]: After  6.9M  /mntMash2ivadp0 Jan 14 20:22:43 WADF]: Uparade preload
Trend Micro loT Security package successfully Jan 14 20:22:43 WADP]. Jan 14 20:22:43 WADPT:
Freload package Size: 1.0M Jan 14 20022:43 [WADP]: Untar package Size: 2.3M Jan 14 20:22:44
["ADF]: Stratocast Preload Package Version: 1.1b.a1.4.2 Jan 14 20:22:50 MWADF): Update
configuration... Jan 14 20:22:57 [WVADP]: Jan 14 20:22:57 WADFP]: File system disk space usage

Jan 14 20:22:53 MMADP]: Upgrade Filesystem Size  Used Available Use% Mounted on
Jan 14 20:22:53 MMADP]: Before ubil:flashfs2 323 50M  256M 16% /mntflash?
Jan 14 20:22:53 VADP]: After  ubil:flashfs2 323 6.5M 240M 21% /mntflashz Jan

14 20:22:58 [VADP]: File space usage: Jan 14 20:22:58 WADP]: Upgrade Size PathJan 14
20:22:58 VADP]: Before 0.Jan 14 20:22:58 [WADP]: After  2.3M  /mntfash2ivadp/ Jan 14
20:22:58 [WADP]: Upgrade preload Stratocast package successfully Jan 14 20:22:58 [WADF]: Jan

14 202258 DA DR AR Jan 14 20:22:58 MWADP]:  Upgrade
preload package end Jan 14 20:22:58 WA DR, o s s Jan 14
20:22:58 [WADP]: File system disk space usage Jan 14 20:22:58 WADP]: Filesystem Size v

Used Available Use% Mounted on Jan 14 20:22:538 NWADPIL: ubil:flashfs2 32.3M 6.5M
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System > Parameters

The View Parameters page lists the entire system’s parameters. If you need technical
assistance, please provide the information listed on this page.

— Parameters

system_hostname="'MA9322-EHTVL" .
system_ledoff="8'

system_lowlight="1"

system_date="'2022/07/11'

system_time='23:37:23'

system_datetime=""'

system_ntp=""

system_daylight_enable="0"

system_daylight_auto_begintime="Not Support'
system_daylight_auto_endtime="Not Support'
system_daylight_timezones=',-366,-320,-280,-246,-241,-200,-140,-121,-46,
©,40,41,80,82,83,140,380,480'

system_updateinterval='6e'

system_info_modelname="MA9322-EHTVL'
system_info_extendedmodelname="'MA9322-EHTVL'
system_info_serialnumber='6002D1A16901"
system_info_firmwareversion='MA9322-VVTK-81eed'
system_info_language_count='18"

system_info_language_i®='English'

system_info_language_il='Deutsch'

system_info_language_i2='Espafiol’

system_info_language_i3='Fran¢ais'

system_info_language_id4='Italiano’

system_info_language_i5='HZIZE"

system_info_language_i6='Portugués'

system_info_language_i7="E{fH1C"

system_info_language_i8='EfEh "

system_info_language_i9='Pycckuit'

system_info_language_ile=""'

system_info_language_ill="" -

L . e e
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System > Maintenance

This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, efc.

General settings > Upgrade firmware

Upgrade firmware

Select firmware file: Browse... [ Upgrade ]

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do not power off the Network Camera during the upgrade!

Follow the steps below to upgrade the firmware:

1. Download the latest firmware file from the VIVOTEK website. The file is in .pkg file format.

2. Click Browse... and locate the firmware file.

3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.

If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, re-
access the Network Camera.

The following message is displayed when the upgrade has succeeded.

Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.
4 N\
Starting firmware upgrade...

Do not power down the server during the upgrade.

The server will restart automatically after the upgrade is
completed.

This will take about 1 - 5 minutes.

Wrong PKG file format

Unpack fail

(. J

General settings > Reboot

Reboot

Reboot

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the reboot process.

The device is rebooting now. Your browser will reconnect to hitp:/192.168.5.151:80/

Ifthe connection fails, please manually enter the above IP address in your browser.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.
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A IMPORTANT:

Through extensive use, temporary files may accumulate that disable a firmware upgrade. You can
use the Clean up function in the Application > Package management window to solve this problem.

VIVOT=K

System
Media
Network
Security
PTZ
Event

Applications

Motion detection

‘Smart Tracking Advanced
Dl and DO

Tampering detection
Audio detection

Package management

Recording

Storage

Version: 1.2101.35.01b_IRissue

Home Client settings NeJiil+[II£1{0IN Language
Applications > Package management

Select file | BT Upload

— R status
CPU loading: 8%
Internal storage total size: 1951.828 MB Free size: 1805.839 MB
Memory total size: 1982.039 MB Free size: 1031.218 MB

— Clean i

Notice! It will erase system temporary files and the files upload from FTP. ‘

— list

on S
(O  Trend Micro IoT Security 1.3e.a1.8.4 Installed N/A 6.304MB O

(O  smart tracking advanced 6.15.1.1-3e OFF Pass 14.761MB ¢
O Stratocast 13e.a153 ON N/A 3085MB ¢
[ Start Il Stop |[ schedule

User's Manual - 67




General settings > Restore
Restore
Restore all settings to factory default except settings in

[] Metwork [] Daylight saving time [_] Custom language [_| VADP | Focus position
‘ Restore |

This feature allows you to restore the Network Camera to factory default settings.

Network: Select this option to retain the Network Type settings (please refer to Network Type on page
98).

Daylight Saving Time: Select this option to retain the Daylight Saving Time settings (please refer to
Import/Export files below on this page).

Custom Language: Select this option to retain the Custom Language settings.

VADP: Retain the VADP modules (3rd-party software stored on the SD card) and related settings.
Focus position: Retain the lens focus position using the previously saved position parameters.

If none of the options is selected, all settings will be restored to factory default. The following message is
displayed during the restoring process.

The device is rebooting now. Your browser will reconnect to hitp:M192.168.5.151.80/
[fthe connection fails, please manually enter the above IP address in your browser.

Import/Export files

This feature allows you to Export / Update daylight saving time rules, custom language file, configuration
file, and server status report.

General settings | | Import/Export files

Export files

Export language file Export

Export configuration file Export

Export server status report Export

Upload files

Update custom language file: Browse... | Upload
Upload configuration file: Browse.. | Upload

Browse...

Export daylight saving time configuration file: Click to set the start and end time of DST (Daylight Saving).

Follow the steps below to export:

1. In the Export files column, click Export to export the daylight saving time configuration file from the
Network Camera.

2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.



The following message is displayed when attempting to upload an incorrect file format.

Microsoft Internet Exploren

L] E The file must hawve a ,xml filename suffix,
L3

Lok |

Export language file: Click to export language strings. VIVOTEK provides nine languages: English,
Deutsch, Espafiol, Frangais, Italiano, P # 3, Portugués, B{&kH3, ¥4+ <, and Pycckun..

Update custom language file: Click Browse... and specify your own custom language file to upload.

Export configuration file: Click to export all parameters for the device and user-defined scripts.

Update configuration file: Click Browse... to update a configuration file. Please note that the model and
firmware version of the device should be the same as the configuration file. If you have set up a fixed IP
or other special settings for your device, it is not suggested to update a configuration file.

Export server staus report: Click to export the current server status report, such as time, logs,
parameters, process status, memory status, file system status, network status, kernel message ... and so
on.

-‘@’- Tips:

If a firmware upgrade is accidentally disrupted, say, by a power outage, you still have a last resort method to
restore normal operation. See the following for how to bring the camera back to work:

Applicable scenario:

(a) Power disconnected during firmware upgrade.
(b) Unknown reason causing abnormal LED status, and a Restore cannot recover normal working
condition.

You can use the following methods to activate the camera with its backup firmware:

(a) Press and hold down the reset button for at least one minute.

(b) Power on the camera until the Red LED blinks rapidly.

(c) After boot up, the firmware should return to the previous version before the camera hanged. (The
procedure should take 5 to 10 minutes, longer than the normal boot-up process). When tthis
process is completed, the LED status should return to normal.



Media > Image

Channel: Select a Channel (one of the 4 sensors) before making configurations. These 4 sensors
can be individually configured.

This section explains how to configure the image settings of the Network Camera. It is
composed of the following function groups: General settings, Image settings, Exposure,
Focus, and Privacy mask.

Channel: (1 v

ings  llluminators | Image settings ~Exposure | Focus | Privacy mask | Pixel

General settings

Video font (.t):
Color:

Pouwer line frequency.

Video orientation:

Day/Night settings
Switch to BAW in night mode

IR out filter Auto mode v

Darkest Brightest

Day/Night sensitivity: J

Select auto mode will disable profile of exposure settings.

Video title

Show_timestamp_and video_title in_video_and_snapshots: Enter a name that will be displayed on
the title bar of the live video as the picture shown below. A zoom indicator will be displayed on the
Home page when you zoom in/out on the live viewing window as shown below. You may zoom in/
out on the image by scrolling the mouse wheel inside the live viewing window, and the maximum
zoom in will be up to 4 times.

Video Title Video 2014/7/09 17:08:56
Title and Time

Zoom Factor

a/2ln][e]o](wu/w (g

Position of timestamp and video title on image: Select to display time stamp and video title on the
top or at the bottom of the video stream.

Timestamp and video title font size: Select the font size for the time stamp and title.

Video font (.ttf): You can select a True Type font file for the display of textual messages on video.

Color: Select to display color or black/white video streams.

Power line frequency: Set the power line frequency consistent with local utility settings to eliminate
image flickering associated with fluorescent lights. Note that after the power line frequency is
changed, you must disconnect and reconnect the power cord of the Network Camera in order for
the new setting to take effect.




Video orientation: Flip - vertically reflect the display of the live video; Mirror - horizontally reflect the
display of the live video. Select both options if the Network Camera is installed upside-down (e.g.,
on the ceiling) to correct the image orientation. Please note that if you have preset locations, those
locations will be cleared after flip/mirror setting.

Rotate -
Normal Flip Mirror Rotate 90°
[V Rotate  gg [+ Degrees = b L clogtulss
L] L] —
The rotation here indicates clockwise \/{ M
rotation. Rotation can be applied with
flip, mirror, and physical lens rotation L]
(see below) settings to adapt to different L
mounting locations. \/[(

The figures in the illustration are shown in
a consecutive order.

2N B
[]

233 Eh D

The camera may be installed on a vertical, side-facing, or tilted surface in order to accommodate
the interior or exterior design of a building. The interior of a building can be shaped as a narrow
rectangular space, such as a corridor. The conventional HD image, such as that of a 16:9 aspect
ratio, will be incongruous with its wide horizontal view. With video rotation, the camera can more
readily cover the field of view on a tall and narrow scene.



Day/Night Settings Day/Night settings

Switch to B/W in night mode

IR cut filter: Auto mode ~

Darkest Brightest

Day/Night sensitivity: -

Select auto mode will disable profile of exposure settings.

Switch to B/W in night mode
Select this to enable the Network Camera to automatically switch to Black/White during night
mode.

IR cut filter
With a removable IR-cut filter, this Network Camera can automatically remove the filter to let IR
light enter the light sensor during low light conditions.

m Auto mode
The Network Camera automatically removes the filter by judging the level of ambient light.

m Day mode
In day mode, the Network Camera switches on the IR cut filter at all times to block infrared light
from reaching the sensor so that the colors will not be distorted.

m Night mode
In night mode, the Network Camera switches off the IR cut filter at all times for the sensor to
accept infrared light, thus helping to improve low light sensitivity.

m Synchronize with digital input
The Network Camera automatically removes the IR cut filter when a Digital Input is triggerred.
For example, an external IR light may come with its own detection circuits.

m Schedule mode
The Network Camera switches between day mode and night mode based on a specified
schedule. Enter the start and end time for the day mode. Note that the time format is [hh:mm]
and is expressed in 24-hour clock time. By default, the start and end time of day mode are set to
07:00 and 18:00.

Sensitivity of IR cut filter
Tune the responsiveness of the IR cut filter to lighting conditions as Low, Normal, or High.

When completed with the settings on this page, click Save to enable the settings.



lHlluminators

Turn on built-in IR illuminator in night mode
Select this to turn on the camera’s onboard IR illuminator when the camera detects low light
condition and enters the night mode.

Anti-overexposure

When enabled, the camera automatically adjusts the IR projection to adjacent objects in order to
avoid over-exposure in the night mode.

The Smart IR function is more beneficial when the spot of intrusions or an object of your interest
is close to the lens and the IR lights. For example, if an intruder has a chance of getting near the
range of 3 meters, Smart IR can effectively reduce the over-exposure. For a surveillance area at a
greater distance, e.g., 5 meters or farther away, the Smart IR function may not bring as significant
benefits as in close range.

Smart IR disabled; distance: 5M Smart IR enabled; distance: 5M

Smart IR disabled; distance: 3M Smart IR enabled; distance: 3M




-‘@’- Tips:

If there is an object in close proximity, the IR lights
reflected back from it can mislead the Smart IR’s
calculation of light level. To solve this problem, you
can place an “Exposure Exclude” window on an
unavoidable object in the Exposure setting window.
See page 77 for how to do it.

You can also configure the “Exposure Exclude”

window in a night mode “Profile” setting so that your
day time setting is not affected.

=Profile of exposure settings

[ Add inclusive window ] [ Add exclusive window

Activated period

{ { y 4 1
R
Enable and apply this profile to EXcl ude X
) Day mode rli — : i

.

@ Night mode

© Schedule mode

Measurement window

© Full view
@ Ccustom

© BLC



Image settings
On this page, you can tune the White balance and Image adjustment.

Cnannel:g

General settings | | llluminators | | Image settings | | Exposure | Focus | | Privacy mask

Mormal light mode | | Profile mode

White balance o5
Auto bt

Image adjustment
Brightness. 50%

Contrast: 50%

Saturation: 50%

000

Sharpness: 50%

[Goimez v

‘ Restore || Save ‘

Channel: Select one of the 4 Channels (sensors).

White balance: Adjust the value for the best color temperature.
m You may follow the steps below to adjust the white balance to the best color temperature.

1. Place a sheet of paper of white or cooler-color temperature color, such as blue, in front of the
lens, then allow the Network Camera to automatically adjust the color temperature.

2. Click the On button to Fix current value and confirm the setting while the white balance is being
measured.

m You may also manually tune the color temperature by pulling the RGain and BGain slide bars.

Image Adjustment
m Brightness: Adjust the image brightness level, which ranges from 0% to 100%.

m Contrast: Adjust the image contrast level, which ranges from 0% to 100%.
m Saturation: Adjust the image saturation level, which ranges from 0% to 100%.
m Sharpness: Adjust the image sharpness level, which ranges from 0% to 100%.
m Gamma curve: Adjust the image sharpness level, which ranges from 0 to 0.45.
You may let firmware Optimize your display or select a value to change the preferred level of

Gamma correction towards higher contrast or towards the higher luminance for detailed expression
for both the dark and lighted areas of an image.

This option is disabled when the WDR feature is enabled.



Defog: Defog helps improve the visibility quality of captured image in poor weather conditions such
as smog, fog, or smoke.

Highlight mask

m Strong light sources will be masked from the scene, and the image contrast will be strengthened.
This function is useful to prevent the spot-light effects in a high dynamic scene.

False color may be observed around the edges of strong light sources.

Noise reduction

m Enable noise reduction: Check to enable noise reduction in order to reduce noises and flickers
in image. This applies to the onboard 3D Noise Reduction feature. Use the pull-down menu to
adjust the reduction strength. Note that applying this function to the video channel will consume
system computing power.

3D Noise Reduction is mostly applied in low-light conditions. When enabled in a low-light
condition with fast moving objects, trails of after-images may occur. You may then select a lower
strength level or disable the function.

Note that the Preview button has been cancelled, all changes made to image settings is directly
shown on screen. You can click Restore to recall the original settings without incorporating the
changes. When completed with the settings on this page, click Save to enable the setting. You
can also click on Profile mode to adjust all settings above in a tabbed window for special lighting
conditions.

Profile | | Restore | | Save

Enable and apply these settings at: Select the mode this profile to apply to: Day mode, Night mode,
or Schedule mode. Please manually enter a range of time if you choose Schedule mode. Then
check Save to take effect.
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Exposure

On this page, you can configure the Exposure measurement window, Exposure level, Exposure
mode, Exposure time, Gain control settings. You can configure two sets of Exposure settings: one
for normal situations, the other for special situations, such as the day/night/schedule mode.

Channel: (1 v
Generalsettingsg F [lmageseuingsH Exposure | | Focus [Privacymask} Pixel
calculator

B 100%

‘ Normal light mode ‘ ‘

Select auto mode will disable profile of exposure settings.

— Exp e strategy

Measurement window: ~ @ Fullview (O Custom () Center

Metering mode: @ Auto OBLC QHLe

— Exposure control

Exposure level:

Flickerless

Exposure time: \-} 1/32000 - 1/15

[ Restore ] [ Save ]

Measurement Window: This function allows users to configure measurement window(s) for low
light compensation. For example, where low-light objects are posed against an extremely bright
background. You may want to exclude the bright sunlight shining through a building's corridor.

m Full view: System calculates the full range of view and provides appropriate light compensation.

m Custom: This option allows you to manually add customized windows as inclusive or exclusive
regions. A total of 10 windows can be configured. Please refer to the next page for detailed
illustration.
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The inclusive window refers to the “weighted window"; the exclusive window refers to “ignored
window®. It adopts the weighed averages method to calculate the value. The inclusive windows
have a higher priority. You can overlap these windows, and, if you place an exclusive window
within a larger inclusive window, the exclusive part of the overlapped windows will be deducted
from the inclusive window. An exposure value will then be calculated out of the remaining of the
inclusive window.

i)

Include X

- Weighted region

Include X
Exclude X

Ignored region

Add inclusive window ] [ Add exclusive window

Measurement window

) Fullview @ Custom () BLC

m BLC (Back Light Compensation): This option will automatically add a “weighted region® in the
middle of the window and give the necessary light compensation.

m HLC: (Highlight Compensation). Firmware detects strong light sources and compensates on
affected spots to enhance the overall image quality. For example, the HLC helps reduce the
glares produced by spotlights or headlights.

Exposure control:

m Exposure level: You can manually configure the Exposure level, which ranges from -2.0 to
+2.0 (dark to bright). You can click and drag the semi-circular pointers on the Exposure time
and Gain control slide bars to specify a range of shutter time and Gain control values within
which the camera can automatically tune to an optimal imaging result. You may prefer a shorter
shutter time to better capture moving objects, while a faster shutter reduces light and needs to be
compensated by electrical brightness gains.

- Flickerless:
Fixed iris models can encounter image rolling band issues when operating under incongrous

power line frequency with fluorescent lights. To solve the problem, the Flickerless mode can limit
the exposure time to 1/120 ~ 1/5 second. For the Auto iris models, when the exposure time is
limited to 1/120 ~1/5 second, iris size is automatically adjusted, and that the image brightness
is appropriately adjusted. Although the chance is rare, for Fixed iris models, when the exposure
time is limited to 1/120 ~ 1/5 second, they may encounter image over-exposure. If the Flickerless
option is selected, and users discover over-exposure from the live view, they can disable the
Flickerless option.



m AE Speed Adjustment:

This function applies when you need to monitor fast changing lighting conditions. For example,
the camera may need to monitor a highway lane or entrance of a parking area at night where
cars passing by with their lights on can bring fast changes in light levels. The same applies if
the camera is installed on a vehicle, and when it needs to adapt to fast changes of light when
entering and leaving a tunnel.

= WDR Pro:

This refers to the Wide Dynamic Range function that enables the camera to capture details in
a high contrast environment. Use the checkbox to enable the function, and use the slide bar
to select the strength of the WDR Pro functionality, depending on the lighting condition at the
installation site. You can select a higher effect when the contrast is high (between the shaded
area and the light behind the objects).

Enable WDR enhanced: This function allows users to identify more image details with an extreme
contrast from an object of interest with one shadowed side against a bright background, e.g., an
entrance. You may select the Enable WDR enhanced checkbox, and then adjust the strength (low,
medium, high) to reach the best image quality.

You can click Restore to recall the original settings without incorporating the changes. When
completed with the settings on this page, click Save to enable the settings.

If you want to configure another sensor setting for day/night/schedule mode, please click Profile to
open the Profile of exposure settings page as shown below.

Activated period: Select the mode this profile to apply to: Night mode or Schedule mode. Please
manually enter a range of time if you choose Schedule mode. Then check Save for the configuration
to take effect.

Note that the Profile mode configuration is not =¥
available When the IR Cut filer is Configured in the General settings  llluminators  Image settings | Exposure | Focus || Privacy mask
Auto mode.

Please follow the steps below to configure a profile:

1. Select the Profile mode tab.

2. Select the applicable mode: Night mode or
Schedule mode. Please manually enter a range of
time if you choose the Schedule mode.

3. Configure Exposure control settings in the folowing
columns. Please refer to previous dicussions for

detailed information. Normal ighemode | Profe made
4. Click Save to enable the setting and click Close to 9 Ensble b aplybese stings = A
exit the page. © Nghtmode O Sohasulemode
EOR—
Measurement window: @ Full vew O Cusom O BLC OHCe
e
Exposure level: 0 ¥

Flidkerless

Restore | Sawe |



Focus

Focus here refers to the Remote Focus, is applicable to Network Cameras that are
equipped with stepping motor lens. The automated focus adjustment function eliminates
the needs to physically adjust camera focus. In an outdoor deployment consisting of a
large number of cameras, the auto focus function can be very helpful when these cameras
become out of focus after days or weeks of operation. And that can easily result from
the effects of natural forces, e.g., shrink and expand due to a wide range of operating
temperatures and the vibration caused by wind.

ral settings | | llluminators | Image settings | Exposure | Focus @ Privacy mask | Pixel

=] ——— - H 22
Focus < | < } + + > |
Auto Focus @

(] Full-range scan Fully-opened iris Perform auto foct

Focus win dow
@ Full view
O Custom

Below is the procedure to perform the automated Focus function:

1. Select a Channel (one of the 4 sensors).

2. Select from the bottom of the screen whether you want to perform focus adjustment on
the Full view or within a Custom focus window. You can create a custom window and
click and drag the window to a desired position on screen.

3. You can use the Fully-opened iris checkbox (default) to increase the iris size for a
better focus adjustment result.

4. Click on the Perform auto focus button. When the Full-range scan checkbox is

selected, a full-range scan through the camera's entire focal length can take about 30
to 80 seconds. If not, the auto focus scan will only go through the length where optimal
focus may occur, and that takes about 15 to 20 seconds. In theory, best results of the
auto scan can be acquired when the camera's iris is fully open.



Privacy mask

Click Privacy Mask to open the settings page. On this page, you can block out sensitive zones to
address privacy concerns.

Channel: é 0

General settings | | llluminators | Image settings || Exposure | Focus Privacy mask | Pixel

@ calculator
[] Enable privacy mask
g C 20171012 -
Window name Q

Mask_win1 ®

Mask_win2 b 4

O, =
5)

m To configure privacy mask windows,

1. Select a Channel (one of the 4 sensors).

2. Click New to add a new window.

3. You can use 4 mouse clicks to create a new masking window. You can pull the corner marks to
adjust the coverage.

4. Enter a Window Name, such as Neighbor's window.

5. Click Save to preserve the setting.

6. Click on the Enable privacy mask checkbox to enable this function.

@ NOTE:

» Up to 5 privacy mask windows can be configured on the same screen.

» If you want to delete the privacy mask window, please click the x’ mark on the side of window
name.



Pixel Calculator

Click the Add button at the lower screen to create a pixel calculator window. Place your cursor on
the window to move it to an area of your interest, and change the size of window to fit the area of
interest.

Once they are drawn, the numbers of pixels on the sides of windows will appear. This allows you to
calculate if your current configuration fulfills a requirement, for instance, for recognizing the faces
of persons passing through a location. A facial recognition usually requires around 130 pixels per
meter or higher.

The pixels thus calculated are listed
at the lower screen on a per-stream
basis depending on the frame size you
configured for each video stream.

General settings | | lluminators | | Image settings | Exposure | | Privacy mask | | Pixel calculator

| E= At E3 W0

Pixel Counter
Window1 (H)x{V) Window2 (H)x{V)
Stream1: 551x373 Streami: 555x370
Streamz: 55x37 Stream?: 55x37

Stream3: 551x373 Streamd: 5535x370
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Media > Video

Mode

Media > Video
Mode | Stream

() 4-Megapixel (16:9) (MAX 30fps) (WDR Pro)

(@ 5-Megapixel (4:3) (MAX 12fps) (WDR Pro)

The applicable video modes include:
m 5-Megapixel (4:3)(MAX 12fps) (WDR Pro): This is the full resolution at 5 megapixels in a 4:3

screen aspect ratio, with the WDR function enabled.
m 4-Megapixel (16:9)(MAX 30fps) (WDR Pro): This is the full resolution at 4 megapixels in a 16:9

screen aspect ratio, with the WDR function enabled.
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Stream settings

Media > Video
Channel:[1 v]

Stream

= Video settings for stream 1

% \Video settings for stream 2 Viewing Window

Save

This Network Camera supports multiple streams with frame sizes ranging from 448 x 320 to 2688 x
1920 pixels.

m Stream 1: Users can define the "Region of Interest" (viewing region) and the "Output Frame Size"
(size of the live view window).
m Stream 2: The default frame size for Stream 2 is set to the 1280 x 960.

Click Viewing Window to open the viewing region settings page. On this page, you can configure
the Region of Interest and the Output Frame Size for a video stream. For example, you can crop
only a portion of the image that is of your interest, and thus save the bandwidth needed to transmit
the video stream. As the picture shown below, the area of your interest in a parking lot should be
the vehicles. The blue sky is of little value for the surveillance purpose.




Channel: 3 »

Stream | | Viewing Window

Video stream :

Full view: 2688x1920

Region of interest : | (0,0) 2638x1920 custom e | Save

Please follow the steps below to configure the settings for a stream:

1. Select a stream for which you want to set up the viewing region.

2. Select a Region of Interest from the drop-down list. The floating frame, the same as the one
in the Gloabl View window on the home page, will resize accordingly. If you want to set up
a customized viewing region, you can also resize and drag the floating frame to a desired
position using your mouse.

3. Choose a proper Output Frame Size from the drop-down list according to the size of your
monitoring device.

ﬁ NOTE:

» All the items in the “Region of Interest” should not be larger than the “Output Frame Size*
(current maximum resolution).

When completed with the settings in the Viewing Window, click Save to enable the settings and
click Close to exit the window. The selected Output Frame Size will immediately be applied to
the Frame size of each video stream. Then you can go back to the home page to test the e-PTZ
function. For more information about the e-PTZ function, please refer to page 133.

VIVOT=EK MA9322-EHTVL

Region of Interest|
(Viewing Region)

Bl EJ T covl=swme=~

Output Frame Size
(Size of the Live View Window)




Click the stream item to display the detailed information
settings in the above Viewing Window sections.

Channel: [1 v]

Mode  Stream

“ Video settings for stream 1
) H.265
@H.264
Resolution:
Maximu frame rate:

Intra frame period

2688x1920 v
121ps v

15 v

Dynamic intra frame period ((help))

Bit rate control
@ Constrained bit rate:
Target qualty:
Maximum bit rate:
Policy:
Smart Q
O Fixed quality:
) MJPEG

“ Video settings for stream 2 Viewing Window

OH.265

@H.264
Resolution:
Maximum frame rate:

Intra frame period

Defailed v
8Mbps v
Frame rate priority v |

ON v

1280x960 v
12fps -

15 v

Dynamic intra frame period ((help))

Bit rate control
@ Constrained bit rate:
Target quality
Maximum bit rate:
Policy:
Smart Q:
O Fixed quality

O MIPEG

Detailed v
iMbps v
Frame rate priority v

ON v

. The maximum frame size will follow your

This Network Camera offers real-time H.265, H.264, and MJPEG compression standards (Triple
Codec) for real-time viewing. If the H.265 or H.264 mode is selected, the video is streamed via
RTSP protocol. There are several parameters through which you can adjust the video performance:

* Video settings for stream 1

m Frame size

@H.265
Resolution: 2688x1920 |
Maximum frame rate: 121fps v]
15 v

Intra frame period:

Dynanmic intra frame period ((help))
Bit rate control
@ Constrained bit rate:
Detailed

Target quality:

Maximum bit rate: 6Mbps  v|

Polioy: Frame rate priority v

smartQ ON v

O Fixed quality:

(OH.264

MJPEG

You can set up different video resolutions for different viewing devices. For example, set a
smaller frame size and lower bit rate for remote viewing on mobile phones and a larger video
size and a higher bit rate for live viewing on web browsers, or recording the stream to an NVR.
Note that a larger frame size takes up more bandwidth.

m Maximum frame rate
This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother
video quality and for recognizing moving objects in the field of view.

If the power line frequency is set to 50Hz , the frame rates are selectable at 1fps to 25fps. If the
power line frequency is set to 60Hz, the frame rates are selectable at 1fps to 30fps. You can also
select Customize and manually enter a value.



m Intra frame period

Determine how often for firmware to plant an | frame. The shorter the duration, the

more likely you will get better video quality, but at the cost of higher network bandwidth
consumption. Select the intra frame period from the following durations: 1/4 second, 1/2
second, 1 second, 2 seconds, 3 seconds, and 4 seconds.

Smart stream lll

m Dynamic Intra frame period
High quality motion codecs, such as H.264, utilize the redundancies between video frames to
deliver video streams at a balance of quality and bit rate.

The encoding parameters are summarized and illustrated below. The I-frames are completely

self-referential and they are largest in size. The P-frames are predicted frames. The encoder
refers to the previous |- or P-frames for redundant image information.

H.264/265 Frame Types

PIPPPPPPPIPPPPPPPI

By dynamically prolonging the intervals for I-frames insertion to up to 10 seconds, the bit rates
required for streaming a video can be tremendously reduced. When streaming a video of a
static scene, the Dynamic Intra frame feature can save up to 53% of bandwidth. The amount of
bandwidth thus saved is also determined by the activities in the field of view. If activities occur
in the scene, firmware automatically shortens the I-frame insertion intervals in order to maintain
image quality. In the low light or night conditions, the P-frames can have a larger size due to the
noises, and hence the bandwidth saving effect is also reduced.

Streaming a typical 2MP scene normally requires 3~4Mb/s of bandwidth. With the Dynamic Intra
frame function, the bandwidth for streaming a medium-traffic scene can be reduced to 2~3Mb/s,
and during the no-traffic period of time, down to 500kb/s.

A Dynamic Intra Frame w/
ﬁ| . static scenes

Static scene

PIPPPPPPPPPPPPPPPPPPPI

Iq4
4 > |

Dynamic Intra Frame w/

@ activities in scenes

=

PIPPPPPPPI PPPPPPPIPPP Activities

< >| < >
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With the H.265 codec in an optimal scenario and when Dynamic Intra frame is combined with
the Smart Stream function, an 80% of bandwidth saving can be achieved compared with using
H.264 without enabling these bandwidth-saving features.

m Smart FPS
In a static scene, the algorithm puts old frames in queue when no motions occur in scene. When
motions occur, the encoding returns to normal to deliver real-time streaming.

H-HHHHHH-

f1 f1 £l f1 f5 f5 {5 f5 {9

Mo Occur.
-~
f1 fi1 3 f4 f5 f6 (7 8 ({9

By queuing the old frames from a static scene, both the computing efforts and the size of P
frames are reduced. It is beneficial for keeping up with the frame rate requirements.

A default frame difference threshold, 1%, is embedded in firmware for returning from Smart FPS
to normal encoding when motions occur.

/) NOTE:

Comparing with Smart Stream Il, Smart Stream IIl has two more configurable options: Smart Q,
and Smart FPS.
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m Smart codec effectively reduces the quality of the whole or the non-interested areas
on a screen and therefore reduces the bandwidth consumed.

You can manually specify the video quality for the foreground and the background
areas.

Smartstream Il

Dynamic intra frame period (Help)

mert coder: Slide bar to the right - higher quality in the ROI
ose: areas
Manual window setting
Quality priority: (Help) b { a2
The user can adjust the quality balance between RCI (Region of Interest) 0 Sllde bar to the Ieft - hlgher quallty |n the nOn-ROl
and non-ROI area. Moving the selector to the right side gives more quality
priority on ROl area, whereas moving the selector to the left side gives more areas_

quality priority on non-ROl area

Select an operation mode if Smart codec is preferred.

- Auto tracking: The Auto mode configures the whole screen into the non-interested
area. The video quality of part of the screen returns to normal when one or
more objects move in that area. The remainder of the screen where there are
no moving objects (no pixel changes) will still be transmitted in low-quality
format.

- Manual: The Manual mode allows you to configure 3 ROI windows (Region of
Interest, with Foreground quality) on the screen. Areas not included in any
ROI windows will be considered as the non-interested areas. The details in
the ROI areas will be transmitted in a higher-quality video format.

As illustrated below, the upper screen may contain little details of your
interest, while the sidewalk on the lower screen is included in an ROI
window.

E3 100%

Restore | | Close | | Save




As the result, the lower screen is constantly displayed in high details,
while the upper half is transmitted using a lower-quality format. Although
the upper half is transmitted using a lower quality format, you still have an
awareness of what is happening on the whole screen.

" non-ROl: lower-quality

iy

- Hybrid: The major difference between the “Manual” mode and the “Hybrid”
mode is that:

In the “Hybrid“ mode, any objects entering the non-interested area will
restore the video quality of the moving objects and the area around
them. The video quality of the associated non-interested area is
immediately restored to normal to cover the moving objects.

In the “Manual” mode, the non-interested area is always transmitted
using a low-quality format regardless of the activities inside.

L

CQuality pricrity: {Help) ald L a

- Quality priority: Use the slide bar to tune the quality contrast between the ROI
and non-interested areas.

The farther the slide bar button is to the right, the higher the image
quality of the ROI areas. On the contrary, the farther the slide bar button
to the left, the higher the image quality of the non-interested area.

In this way, you may set up an ROl window as a privacy mask by
covering a protected area using an ROl window, while the remaining
screen become the non-interested area. You may then configure the
non-interested area to have a high image quality, or vice versa.

You should also select the Maximum bit rate from the pull-down menu as the
threshold to contain the bandwidth consumption for both the high- and low-
quality video sections in a smart stream.



m Bit rate control

Constrained bit rate:

A complex scene generally produces a larger file size, meaning that higher bandwidth
will be needed for data transmission. The bandwidth utilization is configurable to
match a selected level, resulting in mutable video quality performance. The bit rates
are selectable at the following rates: 20Kbps, 30Kbps, 40Kbps, 50Kbps, 64Kbps,
128Kbps, 256Kbps, 512Kbps, 768Kbps, 1Mbps, 2Mbps, 3Mbps, 4Mbps, 6Mbps,
8Mbps, 10Mbps, 12Mbps, 14Mbps, ~ to 80Mbps. You can also select Customize
and manually enter a value up to 40Mbps.

« - Target quality: Select a desired quality ranging from Medium to Excellent

- Maximum bit rate: select a bit rate from the pull-down menu. The bit rate ranges
from 20kbps to a maximum of 40Mbps. The bit rate then becomes the Average or
Upper bound bit rate number. The Network Camera will strive to deliver video streams
around or within the bit rate limitation you impose.

- Policy: If Frame Rate Priority is selected, the Network Camera will try to maintain
the frame rate per second performance, while the image quality will be compromised.
If Image quality priority is selected, the Network Camera may drop some video

frames in order to maintain image quality.

Smart Q: Select ON or OFF to enable or disable the feature. Smart Q is scene-aware.
The Smart Q reduces frame size and bit rate consumption through the following:

m Dynamically adjusting the image quality for scenes in different luminosities while
keeping the same imaging quality in low light.

m Endorsing different qualities for the | frames and P frames.

m Dividing a single frame into different sections, and giving these sections different
quality values. For a highly complex image section (high frequency area), such
as an area with dense vegetation, screen windows, or repeated patterns (wall
paper), having a lower quality actually poses little effects on human eyes.



Fixed quality:
On the other hand, if Fixed quality is selected, all frames are transmitted with the
same quality; bandwidth utilization is therefore unpredictable. The video quality

can be adjusted to the following settings: Medium, Standard, Good, Detailed, and
Excellent. You can also select Customize and manually enter a value.

Maximum bit rate: With the guaranteed image quality, you might still want to place
a bit rate limitation to control the size of video streams for bandwidth and storage
concerns. The configurable bit rate starts from 1Mbps to 40Mbps.

The Maximum bit rate setting in the Fixed quality configuration can ensure a
reasonable and limited use of network bandwidth. For example, in low light conditions
where a Fixed quality setting is applied, video packet sizes can tremendously
increase when noises are produced with electrical gains.

You may also manually enter a bit rate number by selecting the Customized option.



If the JPEG mode is selected, the Network Camera sends consecutive JPEG images to the client,
producing a moving effect similar to a filmstrip. Every single JPEG image transmitted guarantees
the same image quality, which in turn comes at the expense of variable bandwidth usage. Because
the media contents are a combination of JPEG images, no audio data is transmitted to the client.
There are three parameters provided in MUPEG mode to control the video performance:

@ MJPEG
Resolution: 2688x1920 v
Maximum frame rate: 10 fps v

Bit rate control
() Constrained bit rate:

@ Fixed quality:

Quality:
Maximum bit rate: 80Mbps v

m Frame size

You can set up different video resolution for different viewing devices. For example, set a smaller
frame size and lower bit rate for remote viewing on mobile phones and a larger video size and
a higher bit rate for live viewing on web browsers. Note that a larger frame size takes up more
bandwidth.

m Maximum frame rate

This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother
video quality.

If the power line frequency is set to 50Hz, the frame rates are selectable at 1fps, 2fps, 3fps,
5fps, 7fps, 10fps, and up to 25fps. If the power line frequency is set to 60Hz, the frame rates are
selectable at 1fps, 2fps, 3fps, 5fps, 7fps, 10fps, and up to 30fps. You can also select Customize
and manually enter a value. The frame rate will decrease if you select a higher resolution.

m Video quality

Refer to the previous page setting an average or upper bound threshold for controlling the
bandwidth consumed for transmitting motion jpegs. The configuration method is identical to that
for H.264.

For Constant Bit Rate and other settings, refer to the previous page for details.

ﬁ NOTE:

» Video quality and fixed quality refers to the compression rate, so a lower value will produce higher
quality.

» Converting high-quality video may significantly increase the CPU loading, and you may encounter
streaming disconnection or video loss while capturing a complicated scene. In the event of
occurance, we suggest you customize a lower video resolution or reduce the frame rate to obtain
smooth video.



Media > Audio

Audio Settings

Audio settings

Mute
Microphone source: Internal [v|
Internal microphone input gain: J 70%
External microphone input gain: {_J 70%
Audio type

® G [l

() G726 bit rate: 32 Kops | v|

Save

Mute: Select this option to disable audio transmission from the Network Camera to all clients. Note
that if muted, no audio data will be transmitted even if audio transmission is enabled on the Client
Settings page. In that case, the following message is displayed:

Warning

The media type has been changed to video only because the media from server contains no audio

Microphone source: Select the source of audio input as the onboard microphone (on the dome
cover), or the external microphone you connected via the I/O combo cable.

Internal microphone input gain: Select the gain of the external audio input according to ambient
conditions. Adjust the gain from 0% to 100%.

External microphone input gain: Select the gain of the external audio input according to ambient
conditions. Adjust the gain from 0% to 100%.

Audio type: Select audio codec and the sampling bit rate .

m G.711 also provides good sound quality and requires about 64Kbps. Select pcmu (u-Law) or
pcma (A-Law) mode.

m G.726 is a speech codec standard covering voice transmission at rates of 16, 24, 32, and 40kbit/
S.

When completed with the settings on this page, click Save to enable the settings.



Audio clips

m Output gain: Use the slide bar to change the audio output gains value.

m Audio clip: When the camera's audio input is connected to a microphone, you can record a short
period of audio recordings (1 to 10 seconds). You can also use the camera's embedded microphone to
record an audio clip, if available. Because the memory space is limited, a recording count down will be
available on screen.

You can also upload an audio file to the camera's flash memory. With amplified speakers, you can
playback the audio, e.g., to deter an intruder. A maximum of 2 audio clips in wav format are supported.
The maximum size of the audio file to be uploaded is 2,000Kbytes.

The voice alert is enabled in the Event settings > action > Play Audio Clip. The action can be
associated with triggering conditions.

Audio settings | | Audio clips

Output gain
85%
—
Audio clip
Add a new audio clip:
(@) Record a sound file ("wav) from camera:
Mame:
Wait for | 3 seconds before recording [1~10]

() Upload a pre-recorded sound file (*.wav):

2 http;//172.16.7.214/setup/media/record.. — O -
a http://172.16.7.214/setup/media/record_audioclip.html?pre_seconds-

e

Recording finished.

H145% -
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Media profiles

You can configure a different video stream for each of the 3 default profiles, Max. view,
Recording, Live view, and App.

The related video stream information will display, including stream number, resolution,
codec used, frame rate, etc. The Multicast port number, and address for video, audio, and
Metadata configuration will also be listed.

> Stream profiles setup
Pote rame

Always multicast for this stream profile

- Video configuration

Setup a video configuration

— Source
Stream No: Sfream 1
Codec: H.264 Resolution: 2048x2048
Frame rate: 15 Bit rate (kbit/s). 6000000

— Multicast
Port: 15560 Address: 239.240.7.99
RTCF Port: 15561 Multicast TTL [1~255]: 15

- Audio configuration

Setup an audio configuration

— Source
Codec: G711
— Multicast
Port: 15562 Address: 239.240.7.99
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Network > General settings

This section explains how to configure a wired network connection for the Network
Camera.

Network Type Network type
@ LAN
2! Get IP address automatically
Use fixed IP address
| Enable UPnP presentation
Enable UPnP port forwarding
PPPOE
Enable IPvE
LAN e —

Select this option when the Network Camera is deployed on a local area network (LAN) and is
intended to be accessed by local computers. The default setting for the Network Type is LAN.
Please rememer to click on the Save button when you complete the Network setting.

Get IP address automatically: Select this option to obtain an available dynamic IP address assigned
by the DHCP server each time the camera is connected to the LAN.

Use fixed IP _address: Select this option to manually assign a static IP address to the Network
Camera.

Network type

@ LAN
Get IP address automatically

@ lse fixed IP address

IP address: 172.16.168.10
Subnet mask: 25525500
Default router: 172.16.01
Primary DNS: 182.168.0.21
Secondary DNS: 182.168.0.22
Primary WINS server: 192.168.0.21
Secondary WINS server: 1892.168.0.22

| Enable UPnP presentation
Enable UPnP port forwarding
PPROE

Enable IPvG

| Save |

1. You can make use of VIVOTEK Installation Wizard 2 on the software CD to easily set up the
Network Camera on LAN. Please refer to Software Installation on page 23 for details.

2. Enter the Static IP, Subnet mask, Default router, and Primary DNS provided by your ISP or
network administrator.

Subnet mask: This is used to determine if the destination is in the same subnet. The default value
is “255.255.255.0".

Default router: This is the gateway used to forward frames to destinations in a different subnet.
Invalid router setting will disable the transmission to destinations across different subnets.



Primary DNS: The primary domain name server that translates hostnames into IP addresses.

Secondary DNS: Secondary domain name server that backups the Primary DNS.

Primary WINS server: The primary WINS server that maintains the database of computer names
and IP addresses.

Secondary WINS server: The secondary WINS server that maintains the database of computer
names and IP addresses.

Enable UPnP presentation: Select this option to enable UPnP™ presentation for your Network
Camera so that whenever a Network Camera is presented to the LAN, the shortcuts to connected
Network Cameras will be listed in My Network Places. You can click the shortcut to link to the web
browser. Currently, UPnP™ is supported by Windows XP or later. Note that to utilize this feature,
please make sure the UPnP™ component is installed on your computer.

b My Network Places g@@
"

File Edit ‘“iew Favorites Tools Help

> ) if p D Search Faolders Ev

Address \JJ Iy Metwork Places b a e

Local Network
Network Tasks kS

v e
J Add a network place - ! Ev\u'ireless Networ)k Camera -! Mega-pixel Network Camera (192.168.5.151)
192,165.5.128

& View network connections

';ﬁ Set up a home or smal

+ RV
office network - Wwireless Metwork Camera with
f()‘ Wi workgroup computers PanTilt (192.168.5. 141}

Enable UPnP port forwarding: To access the Network Camera from the Internet, select this option
to allow the Network Camera to open ports automatically on the router so that video streams can
be sent out from a LAN. To utilize of this feature, make sure that your router supports UPnP™ and
it is activated.

PPPoE (Point-to-point over Ethernet)

Select this option to configure your Network Camera to make it accessible from anywhere as long
as there is an Internet connection. Note that to utilize this feature, it requires an account provided
by your ISP.

Follow the steps below to acquire your Network Camera’s public IP address.

1. Set up the Network Camera on the LAN.

2. Go to Configuration > Event > Event settings > Add server (please refer to Add server on page
142) to add a new email or FTP server.

3. Go to Configuration > Event > Event settings > Add media (please refer to Add media on page
150).
Select System log so that you will receive the system log in TXT file format which contains the
Network Camera’s public IP address in your email or on the FTP server.

4. Go to Configuration > Network > General settings > Network type. Select PPPoE and enter the
user name and password provided by your ISP. Click Save to enable the setting.

Network type
LAN
® PPPoE
User name:
Password:

Confirm password:

Enable IPvE

[ Save

5. The Network Camera will reboot.
6. Disconnect the power to the Network Camera; remove it from the LAN environment.



@ NOTE:

» If the default ports are already used by other devices connected to the same router, the Network
Camera will select other ports for the Network Camera.

» If UPnP™ is not supported by your router, you will see the following message:
Error: Router does not support UPnP port forwarding.

» Steps to enable the UPnP™ user interface on your computer:

Note that you must log on to the computer as a system administrator to install the UPnP™
components.

1. Go to Start, click Control Panel, then click Add or Remove Programs.

® Control Panel

Fle Edt View Favories Took Help

3] ;T ) search ([ Foders

Pick a category

- —

@

ﬁ? Network and Internet Connections

-
Y —

.“! , Sounds, Speech, and Audio Devices. Accessibility Options

_‘ Performance an d Maintenance

2. In the Add or Remove Programs dialog box, click Add/Remove Windows Components.

6 Add or Remove Programs

%j Currently installed programs:

i Apple Software Update

Remave ) N
Programs Click here For support information.
T change this program or remave it From your computer,
Addlew & Tnctallation Wizard PE———
Programs

E} Microsoft Office Professional Edition 2003 Size  381.00MB

@ WMozila Firefox (2.0.0.6)

Size  20.34MB
addiremave | i3 PostgreSoL 8.2 Size  57.50MB
Cﬁ:‘iﬂg;ts & QuickTime: Size  74.39MB

) virtual Machine Additions Size  0.90MB
§ vivotek Installation Wizard 2 Sige  G.EOME
[ vIvOTEK ST7501 Size  66.96ME

§5) windows Genine Advantage Validation Tool (KES92130)
@ ‘windowes XP Hotfi - KBB23559
G5 windows xP Hotfix - KB325741
G5 windows 1P Hotfix - KBE33407

G50 windows 1P Hotfix - KB35732
I ud

Clase

3. In the Windows Components Wizard dialog box, select Networking Services and click
Details.

Windows Components Wizard |z‘

Windows Components
*You can add of remove components of Windaws XP.

To add o remove a component, click the checkbox, & shaded box means that anly
part of the companent will be installed. To see what's included in  component, click
Datails.

Components

[] &2 Message Queving 00Me
w

>

L1 55 Other Network. Fils and Print Services 00ME —
¥l = Indate Ront Cerificates nnwe >

Desciiption: Contains a variety of specialized, network-slated services and protacals

Total disk space required, L.0HE (s )
Space available on disk: 121254 MB

<Back || Mew> | [ Canedl |




4. In the Networking Services dialog box, select Universal Plug and Play and click OK.
Networking Services @

To add or remove a component, click the check box. & shaded box means that only part
of the component will be inztalled. To see what's included in a component, click Details.

Subcomponents of Metworking Services:

L RIP Listener 0.0 MB
Simple TCP/IP Services 0.0 ME
Universal Plug and Play 0.2 mMe

Description:  Listens for route updates sent by routers that use the Fouting Infarmation
Protocol version 1 [RIP«1].

Total disk space required: 0.0ME
Space available on digk: 121254 MB

[ 0K l[ Cancel ]

5. Click Next in the following window.

Windows Components Wizard @

Windowsz Components
You can add or remove components of Windowes 3P,

To add or remove a component, click the checkbox. & shaded box means that only
part of the component will be installed. Ta see what's included in a companent, click

Details.
Components:
[ 52 Message Queuing 0.0MB

¥ SN Explorer 13.5 MB
=N ing
O EQD er Metwork File and Print Services 0.0 MB
1 B Indate Ront Carificates 111 44R

v

Descriptior:  Contains a variety of specialized, network-related services and protocols

Total disk space required: 0.0 ME

Space avalable on disk:

< Back [ Next ][ Canicel ]

6. Click Finish. UPnP™ s enabled.

» How does UPnP™ work?
UPnP™ networking technology provides automatic IP configuration and dynamic discovery of
devices added to a network. Services and capabilities offered by networked devices, such as
printing and file sharing, are available among each other without the need for cumbersome
network configuration. In the case of Network Cameras, you will see Network Camera shortcuts
under My Network Places.

» Enabling UPnP port forwarding allows the Network Camera to open a secondary HTTP port on
the router-not HTTP port-meaning that you have to add the secondary HTTP port number to the
Network Camera’s public address in order to access the Network Camera from the Internet. For
example, when the HTTP port is set to 80 and the secondary HTTP port is set to 8080, refer to
the list below for the Network Camera’s IP address.

From the Internet In LAN

http://203.67.124.123:8080 http://192.168.4.160 or
http://192.168.4.160:8080

» If the PPPoE settings are incorrectly configured or the Internet access is not working, restore
the Network Camera to factory default; please refer to Restore on page 68 for details. After the
Network Camera is reset to factory default, it will be accessible on the LAN.



Enable IPv6

Select this option and click Save to enable IPv6 settings.
Please note that this only works if your network environment and hardware equipment support
IPv6. The browser should be Microsoft® Internet Explorer 6.5, Mozilla Firefox 3.0 or above.

Network type
LAN
@ PPPOE
Username:
Passwaord:
Confirm password:

| Enable IPvG

IPvE information

Manually setup the IP address

| Save |

When IPVv6 is enabled, by default, the network camera will listen to router advertisements and be
assigned with a link-local IPv6 address accordingly.

IPv6 Information: Click this button to obtain the IPv6 information as shown below.

close

[ethO address]
f280:0000:0000:0000:0202:d"1f-feDe-d4cB/64@Link
[Gateway]

IPv6 address list of gateway

[DNS]

IPv6 address list of DNS

If your IPv6 settings are successful, the IPv6 address list will be listed in the pop-up window. The
IPv6 address will be displayed as follows:

Refers to Ethernet

[eth) address]
2000 00325000000 d 1 104 25 f 40 @G okal Link-global IPv6 address/network mask

FER0-00000000:0000CR02: AL T-fie0d S5 £ 454 @ Link Link-local IPv6 address/network mask

[Gateway]

fed0 211 d 8 a2 122k
[DME]
20100050578



Please follow the steps below to link to an IPv6 address:

1. Open your web browser.
2. Enter the link-global or link-local IPv6 address in the address bar of your web browser.

3. The format should be:

http://[2001:0c08:2500:0002:0202:d 1ff:fe04:6 5f4]/

1

IPvé address

4. Press Enter on the keyboard or click Refresh button to refresh the webpage.
For example:

2 Network Camera - Microsoft Internet Explorer

File Edit ‘“iew Fawaorites Tools  Help

@Back - & \ﬂ @ _:j /—T-‘J Search ‘»:'-';J Favarites E? [7 - —,; % ‘:‘j

Address ‘.ﬁj http://[2001:0c08:2500:0002:0202:d1ff:fe04:65f4]/

WWW ., viveo T

| Y viverzk

NOTE:

» If you have a Secondary HTTP port (the default value is 8080), you can also link to the webpage
using the following address format: (Please refer to HTTP streaming on page 104 for detailed
information.)

http://[2001:0c08:2500:0002:0202:d 1f:fe04:6 5f4]/

f t

IPvé address

» If you choose PPPoE as the Network Type, the [PPP0O address] will be displayed in the IPv6
information column as shown below.

[ethD address]

B CO00CL 00000002024 L4 fe] 12259984 @Link
[ppp0 address]

{8 0:000C0000.0000:0202:d1 £l 122991 0@ Link
2000 bl 0001 000020202 d1 1] 12295450 @ Glohal
[Gateway]

fed0:20:1a00:4142: 80ad

[DNE]
2001 :b000::1

Manually setup the IP address: Select this option to manually set up IPv6 settings if your network
environment does not have DHCPv6 server and router advertisements-enabled routers. If
you check this item, the following blanks will be displayed for you to enter the corresponding
information:




VIVOTEK

Enable IPvG

1Pv6 information
Manually setup the IP address

Optional IP address / Prefix length |

Optional default router | |

Optional primary DS | |
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Network > Streaming protocols

@ NOTE:

The metadata information can only be transmitted through the HTTP main port. Metadata is not
available through the secondary HTTP port.

HTTP streaming

To utilize HTTP authentication, make sure that your have set a password for the Network Camera
first; please refer to Security > User account on page 118 for details.

HTTP | | RTSP | SIP

Authentication:
HTTP port: 80

Secondary HTTP port: 8080

Channel 1

Access name for stream 1: video1s1.mjpg

Access name for stream 2: videols2.mjpg
Channel 2

Access name for stream 1: video2s1.mjpg

Access name for stream 2: video2s2.mjpg
Channel 3

Access name for stream 1: video3s1.mjpg

Access name for stream 2: video3s2.mjpg
Channel 4

Access name for stream 1: video4s1.mjpg

Access name for stream 2: video4s2.mjpg

‘ Save ‘

Authentication: Depending on your network security requirements, the Network Camera provides
two types of security settings for an HTTP transaction: basic and digest.

If basic authentication is selected, the password is sent in plain text format and there can be
potential risks of being intercepted. If digest authentication is selected, user credentials are
encrypted using MD5 algorithm and thus provide better protection against unauthorized accesses.

HTTP port / Secondary HTTP port: By default, the HTTP port is set to 80 and the secondary HTTP
port is set to 8080. They can also be assigned to another port number between 1025 and 65535. If
the ports are incorrectly assigned, the following warning messages will be displayed:

Microsoft Internet Explorer X Microsoft Internet Explorer:

1 HTTP port must be 80 or from 1025 to 65535 L Secondary HTTP port must be from 1025 to 65535
LI e

To access the Network Camera on the LAN, both the HTTP port and secondary HTTP port can
be used to access the Network Camera. For example, when the HTTP port is set to 80 and the
secondary HTTP port is set to 8080, refer to the list below for the Network Camera’s IP address.

On the LAN

http://192.168.4.160 or
http://192.168.4.160:8080

Access name for stream 1 or 2: This Network camera supports multiple streams simultaneously.
The access name is used to identify different video streams. Users can click Media > Video >
Stream settings to configure the video quality of linked streams. For more information about how
to configure the video quality, please refer to Stream settings on page 83.

When using Mozilla Firefox to access the Network Camera and the video mode is set to JPEG,
users will receive video comprised of continuous JPEG images. This technology, known as “server
push”, allows the Network Camera to feed live pictures to Mozilla Firefox.



URL command -- http://<ip address>:<http port>/<access name for stream 1 or 2>
For example, when the Access name for Channel 1 stream 2 is set to video1s2.mjpg:
1. Launch Mozilla Firefox or Netscape.

2. Type the above URL command in the address bar. Press Enter.

3. The JPEG images will be displayed in your web browser.

(820 SEE #&Y Ex© SEE 150 REH - - ree®
CERVCEA R RN LI Sl & msn 23 | Windows 10, Win X

<~ X @ (0 http://192.168.5.151/video1s2.mjpg
[

E92E @ Getting Started Storage [ Agentflow Portal

NOTE:

» Microsoft® Internet Explorer does not support server push technology; therefore, you will not be
able to access a video stream using hitp://<ip address>:<http port>/<access name for stream 1,
or2>.

RTSP Streaming

To utilize RTSP streaming authentication, make sure that you have set a password for controlling
the access to video stream first. Please refer to Security > User account on page 118 for details.

HTTP RTSP  SIP

Authentication: digest v
RTSP port 554
RTP port for video: 5556

RTCP port for video:
RTP port for metadata: 6556
RTCP port for metadata

RTP port for audio: 5558

RTCP port for audio:

Video
Channel No: [Channel 1 v]
Multicast settings for Stream 1 v
1P version: 1Pv4 v
Multicast video address: 239.240.7.99
Multicast video port: 15560
Multicast video TTL [1~255]: 15
Audio
Multicast settings:
IP version: 1Pv4 v
Multicast audio address: 239.240.7.99
Multicast audio port 15562
Multicast audio TTL [1~255]: 15
Metadata
Channel No: [Channel 1 v|
Multicast settings:
1P version [1Pv4 v |
Multicast metadata address: 239.240.7.99
Multicast metadata port: 16560
Multicast metadata TTL [1~255]: 15

Save



Authentication: Depending on your network security requirements, the Network Camera provides
three types of security settings for streaming via RTSP protocol: disable, basic, and digest.

If basic authentication is selected, the password is sent in plain text format, but there can be
potential risks of it being intercepted. If digest authentication is selected, user credentials are
encrypted using MD5 algorithm, thus providing better protection against unauthorized access.

The availability of the RTSP streaming for the three authentication modes is listed in the following
table: VLC

Disable
Basic
Digest

X O O

Access name for Channel # and stream #: This Network camera supports multiple streams
simultaneously. The access name is used to differentiate the streaming source.
If you want to use an RTSP player to access the Network Camera, you HAVE TO set the video
mode to H.265 or 264 and use the following RTSP URL command to request transmission of the
streaming data.
rtsp://<ip address>:<rtsp port>/<access name for stream1 ~ 4>
For example, when the access name for stream 1 is set to live1s1.sdp:
1. Launch an RTSP player.
2. Choose File > Open URL. A URL dialog box will pop up.
3. Type the above URL command in the address field.
4. The live video will be displayed in your player as shown
below.

A Open Media -

Playlist P File @Dic % Nework B Capture Device
Playlist Network Protocol
Media Library Please enter a network URL:

My Computer 1507710216851 64:5¢ 4/IivelsLsd

My Videos

My Music
[] My Pictures
Devices p be.c

@) Discs

A IMPORTANT:

The Multicast metadata port is utilized by VIVOTEK VADP modules to transfer video analytics
results, PTZ stream, textual data, and event messages between the camera and the client side
running and observing the video analysis. If your client side computer is located outside the local
network, you may need to open the associated TCP port on routers and firewall.



RTSP port /RTP port for video, audio/ RTCP port for video, audio

m RTSP (Real-Time Streaming Protocol) controls the delivery of streaming media. By default, the
port number is set to 554.

m The RTP (Real-time Transport Protocol) is used to deliver video and audio data to the clients. By
default, the RTP port for video is set to 5556 and the RTP port for audio is set to 5558.

m The RTCP (Real-time Transport Control Protocol) allows the Network Camera to transmit the

data by monitoring the Internet traffic volume. By default, the RTCP port for video is set to 5557
and the RTCP port for audio is set to 5559.

The ports can be changed to values between 1025 and 65535. The RTP port must be an even
number and the RTCP port is the RTP port number plus one, and thus is always an odd number.
When the RTP port changes, the RTCP port will change accordingly.

If the RTP ports are incorrectly assigned, the following warning message will be displayed:

Microsoft Internet Explorer

! E Invalid port number, RTP video port must be an even number,
-

OF

Multicast settings for stream #1 ~ #3: Click the items to display the detailed configuration
information. Select the Always multicast option to enable multicast for streams #1 ~ #3.

Video
Multicast settings for
IP version:
Multicast video address: 239.240.7.99
Multicast video port: 15560
Multicast video TTL [1-255]: 13
Audio
Multicast settings:
IP version:
Multicast audio address: 239.240.7.99
Multicast audio port: 15562
Multicast audio TTL [1~255]: 15
Metadata

Multicast settings:

IP version:
Multicast metadata address: 239.240.7 99
Multicast metadata port: 16560

Multicast metadata TTL [1~255]: 15



Unicast video transmission delivers a stream through point-to-point transmission; multicast, on the
other hand, sends a stream to the multicast group address and allows multiple clients to acquire
the stream at the same time by requesting a copy from the multicast group address. Therefore,
enabling multicast can effectively save Internet bandwith.

The ports can be changed to values between 1025 and 65535. The multicast RTP port must be an
even number and the multicast RTCP port number is the multicast RTP port number plus one, and
thus is always odd. When the multicast RTP port changes, the multicast RTCP port will change
accordingly.

If the multicast RTP vid
displayed:

Jowing warning message will be

Microsoft Internet Explorer

! E Invalid port number. Multicast stream 1 video port must be an even nur
L

Ok

Multicast TTL [1~255]: The multicast TTL (Time To Live) is the value that tells the router the range
a packet can be forwarded. Each hop decreases TTL by one.

Initial TTL Scope

0 Restricted to the same host

1 Restricted to the same subnetwork
15 Restricted to the same site

64 Restricted to the same region

128 Restricted to the same continent
255 Unrestricted in scope

A IMPORTANT:

The Multicast metadata port is utilized by VIVOTEK VADP modules to transfer video analytics
results, PTZ stream, textual data, and event messages between the camera and the client side
running and observing the video analysis. If your client side computer is located outside the local
network, you may need to open the associated TCP port on routers and firewall.



SIP

SIP is short for Session Initiation Protocol. If necessary, you can change the default port number,
5060, to one between 1025 and 65535.

Two way audio port: By default, the two way audio port is set to 5060. Also, it can also be assigned
to another port number between 1025 and 65535.

The Network Camera supports two way audio communication so that operators can transmit and
receive audio simultaneously. By using the Network Camera’s built-in or external microphone and
an external speaker, you can communicate with people around the Network Camera.

Note that as JPEG only transmits a series of JPEG images to the client, to enable the two-way
audio function, make sure the video mode is set to "H.264" on the Media > Video > Stream settings

page and the media option is set to “Media > Video > Stream settings” on the Client Settings page.
Please refer to Client Settings on page 50 and Stream settings on page 86.

<«

Audio fransmitted to operators
N

Audio transmitted from operators



Network > DDNS

This section explains how to configure the dynamic domain name service for the Network
Camera. DDNS is a service that allows your Network Camera, especially when assigned
with a dynamic IP address, to have a fixed host and domain name.

Express link

Express Link is a free service provided by VIVOTEK server, which allows users to register
a domain name for a network device. One URL can only be mapped to one MAC address.
This service will examine if the host name is valid and automatically open a port on your
router. If using DDNS, the user has to manually configure UPnP port forwarding. Express
Link is more convenient and easier to set up.

Express link | | Manual setup

| Enable express link

http:h'“ Zbthere.net Help Save

By Express link, all users need to do is create host name for the camera. It will generate the link to
access the camera from internet.

Please follow the steps below to enable Express Link:

1. Make sure that your router supports UPnP port forwarding and it is activated.
2. Check Enable express link.

3. Enter a host name for the network device and click Save. If the host name has been used by
another device, a warning message will show up. If the host name is valid, it will display a
message as shown below.

Express link | | Manual setup

[#] Enable express link
hitp:ll 000201123456 2bthere.net H&Igl Save

The camera can now be accessed at http:0002011 23456, 2bthere.net

-2 Network Camera - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help

eBack M > \ﬂ \g _.lj /..-\J Search ‘f‘\'{Favorites 6‘3 - .,_’; E 3

ﬂ’|€| https://0002D1123456.2bthere.net

%/VIVG)EK Mega-Pixel Network Camei

Www, vIve TE, Som

Video Stream | 1 vi [ B2 uto [0 2 0] B2 25 |

= Manual Trigger:
Digital Output E 1 !
Focus Assist [On E | .d.-‘




Manual setup

DDNS: Dynamic domain name service
DDNS: Dynamic domain name service
[] Enable DDNS:
Provider: Dyndns.org(Dynamic)
Host name:
User name:

Password:

Enable DDNS: Select this option to enable the DDNS setting.

Provider: Select a DDNS provider from the provider drop-down list.

VIVOTEK offers Safe100.net, a free dynamic domain name service, to VIVOTEK customers. It
is recommended that you register Safe100.net to access VIVOTEK'’s Network Cameras from the
Internet. Additionally, we offer other DDNS providers, such as Dyndns.org(Dynamic), Dyndns.
org(Custom), TZO.com, DHS.org, CustomSafe100, dyn-interfree.it.

Note that before utilizing this function, please apply for a dynamic domain account first.

m Safe100.net

1. In the DDNS column, select Safe100.net from the drop-down list. Click | accept after reviewing
the terms of the Service Agreement.

2. In the Register column, fill in the Host name (xxxx.safe100.net), Email, Key, and Confirm Key,
and click Register. After a host name has been successfully created, a success message will
be displayed in the DDNS Registration Result column.

Register
Host name: ‘u"'u"l'l»{.
Email: wik@vivotek.com
Key: sase
Confirm key: sane

To apply for a domain name for the camera, or to modify the previously registered information, fill in

the following fields and then click "Reqgister”.

DDME Registration Result;

[Register] Successfully Your account information has 28

been mailed to registered e-mail address =

Upaon successful registration, you can c:Iic:km{o automatically upload relevant information to the

DDME form or you can manually fill it in. Then, click "Save™ to save new settings.

3. Click Copy and all the registered information will automatically be uploaded to the corresponding
fields in the DDNS column at the top of the page as seen in the picture.



DDMS: Dynamic domain name service

Enable DDNE:

Provider: Safe100.net ¥
Host name: YWTK.safe100.net [*.5afe100.net]
Email: wik@vivotek.com
Key: T
Register

Host name: WTK.safe100.net

Email: wik@vivotek.com

Key: rene Forget key

Confirm key: T

To apply for a domain name for the camera, or to modify the previously registered information, fill in

the following fields and then click "Register”.

DDMNS Reagistration Result:

[Register] Successfully Your account information has A

been mailed to registered e-mail address 3

Upon successful registration, you can click copy to automatically upload relevant information to the

DDMS form or you can manually fill itin. Then, click "Save™ to save new settings.

4. Select Enable DDNS and click Save to enable the setting.

m CustomSafe100

VIVOTEK offers documents to establish a CustomSafe100 DDNS server for distributors and
system integrators. You can use CustomSafe100 to register a dynamic domain name if your
distributor or system integrators offer such services.

1. In the DDNS column, select CustomSafe100 from the drop-down list.

2. In the Register column, fill in the Host name, Email, Key, and Confirm Key; then click Register.
After a host name has been successfully created, you will see a success message in the DDNS
Registration Result column.

3. Click Copy and all for the registered information will be uploaded to the corresponding fields in
the DDNS column.

4. Select Enable DDNS and click Save to enable the setting.

Forget key: Click this button if you have forgotten the key to Safe100.net or CustomSafe100. Your
account information will be sent to your email address.

Refer to the following links to apply for a dynamic domain account when selecting other
DDNS providers:
m Dyndns.org(Dynamic) / Dyndns.org(Custom): visit http://www.dyndns.com/


http://www.dyndns.com/

Network > QoS (Quality of Service)

Quality of Service refers to a resource reservation control mechanism, which guarantees a certain
quality to different services on the network. Quality of service guarantees are important if the
network capacity is insufficient, especially for real-time streaming multimedia applications. Quality
can be defined as, for instance, a maintained level of bit rate, low latency, no packet dropping, etc.

The following are the main benefits of a QoS-aware network:
m The ability to prioritize traffic and guarantee a certain level of performance to the data flow.

m The ability to control the amount of bandwidth each application may use, and thus provide higher
reliability and stability on the network.

Requirements for QoS
To utilize QoS in a network environment, the following requirements must be met:

m All network switches and routers in the network must include support for QoS.
m The network video devices used in the network must be QoS-enabled.

QoS models

IEEE802.1p defines a QoS model at OSI Layer 2 (Data Link Layer), which is called CoS, Class of
Service. It adds a 3-bit value to the VLAN MAC header, which indicates the frame priority level from
0 (lowest) to 7 (highest). The priority is set up on the network switches, which then use different
queuing disciplines to forward the packets.

Below is the setting column for CoS. Enter the VLAN ID of your switch (0~4095) and choose the
priority for each application (0~7).
Cos

4| Enable Cos

WLAN ID: 1

Live videa: o -
Live sudia: o
Ewvent/Alarm: o -
lManagement: o -

If you assign Video the highest level, the switch will handle video packets first.

ﬁ NOTE:

» A VLAN Switch (802.1p) is required. Web browsing may fail if the CoS setting is incorrect.

P The Class of Service technologies do not guarantee a level of service in terms of bandwidth
and delivery time, they offer a "best-effort." Users can think of CoS as "coarsely-grained” traffic
control and QoS as "finely-grained” traffic control.

» Although CoS is simple to manage, it lacks scalability and does not offer end-to-end guarantees
since it is based on L2 protocol.



DSCP-ECN defines QoS at Layer 3 (Network Layer). The Differentiated Services (DiffServ) model
is based on packet marking and router queuing disciplines. The marking is done by adding a field
to the IP header, called the DSCP (Differentiated Services Codepoint). This is a 6-bit field that
provides 64 different class IDs. It gives an indication of how a given packet is to be forwarded,
known as the Per Hop Behavior (PHB). The PHB describes a particular service level in terms of
bandwidth, queueing theory, and dropping (discarding the packet) decisions. Routers at each
network node classify packets according to their DSCP value and give them a particular forwarding
treatment; for example, how much bandwidth to reserve for it.

Below are the setting options of DSCP (DiffServ Codepoint). Specify the DSCP value for each
application (0~63).

Go SIDSCP

W| Enable QoS/DSCP

Live videa: u]
Live audic: a
EventiAlam: a
Management: a

| Save |

Note that different vendors of network devices might have different methodologies and unique
implementations. Shown below is a sample corresponding information from a Cisco switch. You
should enter a DSCP tag value according to the information provided by the network devices.

DSCP to Queue Table
Ingress DSCP  Output Queue Ingress DSCP  Output Queue Ingress DSCP | Output Queue Ingress DSCP | Output Cueue

0(BE) v 16(CS2) 2v 32(CS4) av 48(CS6) 3v
) - 17 2w 33 3v 49 T QoS/DSCP
2 v 18(AF21) 27 34(AF41) v 50 3v Enable QoS/DSCP
< M = 2T E v it E I Live videa: 32 0
4 v 20(AF22) 2v 36(AF42) av 52 3v
A - e o = o = - Live audio’ 0
5 v 22(AF23) 27 3B(AF43) av 54 v EventiAlarm: g
7 v 23 2w 39 av 55 3w Management 0

B(CS1) v 24(CS3) av 40(CS5) 4w 56(CST) 3v

9 v 25 av 41 4w 57 3

10(AF11) v 26(AF31) av 42 4v 58 3v
11 v 27 v 43 4w 50 3v

12(AF12) v 28(AF32) av 44 4w 60 3
13 v 29 av 45 4v 61 3v

14(AF13) v 30(AF33) av 46(EF) 4w 62 3w
15 v 31 av 47 4w 63 3

Queue 1 has the lowest priority, queue 4 has the highest priority.

[ Apply ] | Cancel ] [ Restore Defaults]

QoS Baseline/Technical Marketing Classification and Marking Recommendations

Application Layer3 Classification Layer 2 CoS/MPLS EXP
IPP PHB DSCP

IP Routing 6 CS6 48 6

Voice 5 EF 46 5

Interactive Video 4 AF41 34 4 QoS B

Streaming-Video 4 CS4 32 4

Locally-defined Mission- 3 - 25 3

Critical Data

Call-signaling 3 AF31/CS3 26/24 3

Transactional Data 2 AF21 18 2

Network Management 2 CS2 16 2

Bulk Data 1 AF11 10 1




Network > SNMP (Simple Network Management Protocol)

This section explains how to use the SNMP on the network camera. The Simple Network
Management Protocol is an application layer protocol that facilitates the exchange of
management information between network devices. It helps network administrators to
remotely manage network devices and find, solve network problems with ease.

m The SNMP consists of the following three key components:

1. Manager: Network-management station (NMS), a server which executes applications that
monitor and control managed devices.

2. Agent: A network-management software module on a managed device which transfers the status
of managed devices to the NMS.

3. Managed device: A network node on a managed network. For example: routers, switches,
bridges, hubs, computer hosts, printers, IP telephones, network cameras, web server, and
database.

Before configuring SNMP settings on the this page, please enable your NMS first.

SNMP Configuration

Enable SNMPv1, SNMPv2c

Select this option and enter the names of Read/Write community and Read Only community
according to your NMS settings.

Enahble SMNMPv1, SNMPVZC
SHNMPv1, SNMPv2c Settings
Read/\Vrite community: Frivate
Read only community: Public
Enable SNMPv3

This option contains cryptographic security, a higher security level, which allows you to set the
Authentication password and the Encryption password.

m Security name: According to your NMS settings, choose Read/Write or Read Only and enter the
community name.

m Authentication type: Select MD5 or SHA as the authentication method.
m Authentication password: Enter the password for authentication (at least 8 characters).

m Encryption password: Enter a password for encryption (at least 8 characters).
Enable SNIMPv3

SHMPv3 Settings
Read/Write Security name; Frivate
Authentication Type: MD5 »
Authentication Passwaord:
Encryption Password:
Read only Security name:  Fublic
Authentication Type: MD5
Authentication Passwaord:

Encryption Password:



Network > FTP

The newer firmware disabled the FTP port for security concerns. You can manually enable the FTP
server service to enable the FTP function. You can disable the FTP server function when it is not in
use.

FTP port: The FTP server allows the user to save recorded video clips. You can utilize VIVOTEK's
Shepherd utility to upgrade the firmware via FTP server. By default, the FTP port is set to 21. It can
also be assigned to another port number between 1025 and 65535.

-"- Tips:

You can FTP the camera’s IP address to download videos recorded in the SD card, or use the “nttp://
ip/cgi-bin/admin/Isctrl.cgi?cmd=search” command to examine the recorded files on your SD card.

SETP:

This is the embedded SFTP client. Host Key: A host key is the SFTP server's public key.
Ensuring the SFTP server is validated is an important aspect of the SFTP protocol. It is
designed to protect against man-in-the-middle attacks where the hacker intercepts and
relays an impersonated message to the other party.

Click the Save button and the camera SFTP server MD5 key will display. The default
format is ED25519 and RSA.

SFTP

Enable SFTP server
SFTF port 22

Host Key:

MD5:b0:fdied:28:36:fei80:2bi2bred el 4596122122142 (R34}
MD5:0e:ac:24:ba:0f:4b:03:09:70:a84:56:2b:db:e6:03:2e (EDZ23519)

Save



Bonjour

To access the camera from a Mac computer, go to Safari, click on Bonjour and select the camera
from a drop-down list.

You can go to Safari > Preferences to enter your user name and password, and provide the root
password the first time you access the camera. The camera main page will open in your browser.

[ ] Discovery

, Tep.

_nttp._tep. (World Wide Web HTTP)

_rtsp._tep. (Real e Streaming Protocol (RTSP)) - 1 items
-00 ABCDABCDEF

Some later iOSes may come without the Bonjour option. Install the Discovery utility instead.

Find the Discovery (formerly Bonjour Browser) from the Mac App Store.

Discovery is a utility that displays all the Bonjour services on your local network or on Wide-Area
Bonjour domains. The utility is previously called Bonjour Browser, it is now distributed on the Mac

App Store.

Discovery requires macOS 10.12 or higher. For older versions of Mac OS you can download the
old version of Bonjour Browser.

Bonjour Browser (obsolete)
http://www.tildesoft.com/files/BonjourBrowser.dmg - Version 1.5.6

Discovery for iOS
https://itunes.apple.com/us/app/discovery-dns-sd-browser/id305441017?mt=8



Security > User accounts

This section explains how to enable password protection and create multiple accounts.

Account management

Security > User accounts

Account management | | Privilege management

—New user-- v|

User name: root

User password: [TTTIT LY

Confirm user passwoard: ssssssenee »
Privilege: Administrator W

Add

The administrator account name is “root”, which is permanent and can not be deleted. If you want

to add more accounts in the Account management window, please apply the password for the “root”
account first.

The administrator can create up to 20 user accounts.

To create a new user,

1. Click to unfold the pull-down menu. Select New user.

2. Enter the new user’s name and password. Type the password identically in both text boxes.

Some, but not all special ASCII characters are supported: !, $, %, -, ., @, », _, and ~.
You can use them in the password combination.

The strength of your password combination is shown on the right, use the combination of

alphabetic, numeric, upper case, and lower case characters until the password strength is good
enough.

3. Select the privilege level for the new user account. Click Add to enable the setting.
The privilege levels are listed below:

Administrator |Full control

Operator Control DO, white-light illuminator, snapshot, and PTZ;
the operator is unable to enter the camera Configuration page.
Viewer Control DO, white-light illuminator, view, listen, PTZ, and talk through the

camera interface.

Access rights are sorted by user privilege (Administrator, Operator, and Viewer). Only
administrators can access the Configuration page. Although operators cannot access the
Configuration page, they can use the URL Commands to get and set the value of parameters.
Viewers can only access the main page for live viewing.

Here you can also change a user’s access rights or delete user accounts.
1. Select an existing account to modify.

2. Make necessary changes and click Update or Delete to enable the setting.



VIVOTEK

Privilege management

|Ac1:nunt management ‘ ‘ Privilege management |

Operator: Digital output PTZ control
Viewer: [] Digital output PTZ control

Digital Output & PTZ control: You can modify the management privilege as operators or viewers.
Select or de-select the checkboxes, and then click Save to enable the settings. If you give Viewers
the privilege, Operators will also have the ability to control the Network Camera through the main

page.

User's Manual - 119




Security > HTTPS (Hypertext Transfer Protocol over SSL)

This section explains how to enable authentication and encrypted communication over
SSL (Secure Socket Layer). It helps protect streaming data transmission over the Internet
on higher security level.

Create and Install Certificate Method

Before using HTTPS for communication with the Network Camera, a Certificate must be created
first. There are three ways to create and install a certificate:

Create self-signed certificate

1. Select this option from a pull-down menu.

2. In the first column, select Enable HTTPS secure connection, then select a connection option:
“‘HTTP & HTTPS” or “HTTPS only”.

3. Click Create certificate to generate a certificate.

HTTPS

+| Enable HTTPS secure connection

= Mode:

@ HTTP & HTTPS HTTPS only

Please wait while the cerlificate is being

= Certificate: generated...

Certificate information _

Status: Not installed

method: Create self-signed certificate E|

Country: TV

State or province: Asia

Locality: Asia

Organization: VINOTEK.Inc

Organization unit: VINOTEK.Inc

Common name: www vivotek.com

Validity: 3550 days

Create certificate

4. The Certificate Information will automatically be displayed as shown below. You can click Certifi-
cate properties to view detailed information about the certificate.

Certificate information

Status: Active

method: Create self-signed certificate
Country: ™

State or province: As=ia

Locality: Axsia

COrganization: VIVOTEK.Inc

Organization unit: VINOTEK.Inc

Common name: www . vivotek.com

Certificate properties Remove certificate



5. Click Save to preserve your configuration, and your current session with the camera will change
to the encrypted connection.

6. If your web session does not automatically change to an encrypted HTTPS session, click Home
to return to the main page. Change the URL address from “http://” to “https://“ in the address bar
and press Enter on your keyboard. Some Security Alert dialogs will pop up. Click OK or Yes to
enable HTTPS.

https://

‘A Network Camera - Microsoft Internet Explorer,

File  Edit

jiew  Favorites  Tools  Help
@Back < J @ @ ,_h /-:\J Search “i:(Favorites {:‘3 [sz' :\4 ﬁ

Addres! @_https:// |92.1 68.5.151/index.html

%VIV@E!( Mega-Pixel Network Camera
Video stream: 1~ = EEEEE BCEITI Client settings | Configura

& Manual triggers:
Digital output:

Focus assist; | On [Of §

PTZ control: Digital :

LA
|
= == = g “r'ou are about to view pages over a secure connection.
Shp 1 Fatol e - = Ay information you exchange with tis site cannot be
Pane ; 0 s 4 = = viewed by anyone elze on the ‘Web.
Tilt speed: 0 - ; : [ I the Future, do ot shaw tis warning
Zoom speed: O

T S _ ? [ 0K, H Morelnfo] |

w Global view:

Security Alert Security Information | |
rir“'l Infarmation you exchange with thiz site cannat be viewed or r‘,‘"‘i This page containzs both secure and nonsecure
?. changed by others. However, there iz a problem with the zite's ?. items
; = P &l ’
secLrity certificate.

Do pou want to dizplay the nonsecure ikems?
The zecurity certificate was izsuad by a company vou have
not chosen to trust. Yiew the certificate to determine whether
you want to trust the certifying authaority.

[ es H Mo ] ’ b e |rifio

a The zecurity certificate date iz walid.

The name on the security certificate iz invalid or does not
rnatch the name of the: site

Do you want to proceed?

Tes ] I Mo ] [\-"iew Certificate




Create certificate request and install

1. Select the option from the Method pull-down menu.

2. Click Create certificate to proceed.

3. The following information will show up in a pop-up window after clicking Create. Then click Save
to generate the certificate request.

~ Certificate:

Certificate information

Status: Not installed

Method: Create certificate request and install IZ|
Country: ™

State or province: Asia

Locality Asia

Organization: VIVOTEK Inc.

Organization unit: VIVOTEK Inc.

Common name: www vivotek.com

Create cerificate

Please wait while the certificate is being
generated...

4. The Certificate request window will prompt.
(@ tetpi//192.158 4 153/zetup/securityjcersificate_ragquest html - Windows latarn

Create certificate request completed

el o ]

Copy the PEM format request below and send it to a CA for identify validation. After that, you have to install it
by clicking the "Upload™ button on HTTPS page.

Certificate request (PEM format)

MITBszCCARWCAQRIwezELMAKCAI UEBhMCVF cxDTALBgNVBAGTEEFzaWEXDTALEGHY
BRCTBEFzZaWEXFIATEgQNVEBROTDFZIVkSURUsSgSHS JLjEVMBMERIUECKMMVEIWT1RE
SyBIbmMuMRqwFgYDVRIDEWS 3d3cudm] 2b3R1ay5 b2 OwgZ SwDQ¥ JKoZ ThweNAQER
BRADGYOAMICIAOCBALEFSjkjhlCcuOHpd 3£0HUngCEPLQ8zi84HCTbr svhpun/W
ADZJRAYEHShLOwEpmpsMy3crSYtulJuGTbkbLAUHN/ T3 7RAVZAUCOXEvINSAgZISIe
ZpnCIZP¥59Ll244VnhuairewvwR1VHONEixf1odDZUEKmC3UHpNLBES IS TvASAgME
BREgADANEgkghkiGIwlBAQUFAROBgRBdQgpKdUL chwid 1 REnEUSEEMEnBr i KHmQY
rk/igl7ELXXPWEESKALgi3T4XpFN]AVBUs 0 LwlUCCh/ nyHRScZaZ tEZWiSJhD1ALIFm
IZXNPLIAvCA6220hobqT9e SILEEVL lwClpRXNmoEulgNz dM¥VyzRgd3zoeQuZsSVz
SMoerfluow=—

If you see the following Information bar, click OK and click on the Information bar at the top of
the page to allow pop-ups.

@Back A > | Iﬂ |§| _h /.7\‘ Search ‘-:.‘\?Favorltas 9 | - :7I '3

Address |2j httpi//192,168.5, 151 fsetup/https. html
Pop-up blacked. Ta ses this pop-up or additional aptians click here. ..

* viverk

Home Qe lyiil:[NeVGLE Language

Information Bar,

Did you notice the Information Bar?
The Information Bar alerts you when Intemnet Explorer blocks a
pop-up windaw or file download that might nat be safe. If &

‘web page doss nat display praperly. look for the Information
Bar (near the top of your browse)

User account

HTTPS

Access list

[[] Do not shaw this message again.

IEEE 802.1x

Network Leamn ahout the Information Bar._.




5. Look for a trusted certificate authority, such as Symantec’s VeriSign Authentication Services, that
issues digital certificates. Sign in and purchase the SSL certification service. Copy the certificate
request from your request prompt and paste it in the CA’s signing request window. Proceed with
the rest of the process as CA’s instructions on their webpage.

‘ + 5L Certificates - Secure your Website ‘ v Symantec™ Trust Center - Mana... [ | F

Help & Support |H Feedback =

\/Symantec. Trust Center

o)
Free Trial >3 CsR Ehat with s R
Enter Certificate Signing Request (CSR)
Server platform: & Sample CSR Order details
Sel i N B BT e oD s e 80
electone e T e e B ot Symantec™ SSL Test Certificate

@: JaMCeATE uta;{ggnigmegnm&%u&ﬁwbawisnuzﬁwm
B e e L mm.ﬁa.-k«mmam‘?mr.mu * Validty period: 30 days
Digen e HnPlR i
R0 A ez g T
AESTAOREOE: memmn1r‘«')nax-:|zusumi‘4u?1
HTGAUC + FLCLU1 FABa L O Sy 2w Dt S G T8 F s acfoe Total: (Free Trial) Us $0

401 DTN VR ZIZXMEL L Jod YINES L 2TNES M Frve
D CERTIFIGATE REGUEST
Paste Certificate Signing Request (CSRy:
--—--BEGIN CERTIFICATE REQUEST--—- ;I x
MIBs|CC AR C A QR ELMAKGATUEBHMCYFoxDT ALB VB AYTBEF ZaWEXDTALBGNY

BACTBEF ZaWEF TATBgNYEALTOF ZJWkIURU sg SWESLIEWMBME A1 UEC MMV KIATIRF & What is a CSR?

B. QVDYQGD mLAMT oYLk T CBnz ANBGK kGl BAGEF

OB AWV YEAZIGTS 2y 29 LBEDT Rge+ Db LINL cirva260H sef 20 3pS
510G+ HEG0G2NREDEL shDF QEEEANIDE gEGhCI 2SR OZH UK YEEOXGZGRI A CSR is generated fram your server and is
S HCLGT P B P ST IS SR Q25 gmoCFefRaS2aphiCAWE S your server's unique "ingerprint’. The CSR

1GSh3DEEEEGELU. Gk Icr GRS v hD2PSlbk4LIOF TRSGimAr includes your server's public key, which
TRAcwrLEImgSY 2aNzVECyZalEY PRDGZRCGLYAUOWI Y Py Boe. Y 329B0JHSIOf enables server authentication and secure

DG HRPIMG 3K DSIME] ANIBC 25 RET 7 aPihNGEF by communication
2zt Meed hely cenerating a CSR? >
<o END CERTIFICATE REGUEST -

Close
Totak:US 40 (FreeTiia) < Back | Cancel | Continue |

T?is\h -i J‘NOI’IO(I =
| pone 2 4
6. Once completed, your SSL certificate should be delivered to you via an email or other means.
Copy the contents of the certificate in the email and paste it in a text/HTML/hex editor/converter,
such as IDM Computer Solutions’ UltraEdit.

immediately, please dial B66.893.6565 or 650.426.5112 option 3 or send an email to internet-sales@verisign.com

Thank you for your interest in Symantec!
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7. Open a new edit, paste the certificate contents, and press ENTER at the end of the contents to
add an empty line.
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8. Convert file format from DOS to UNIX. Open File menu > Conversions > DOS to Unix
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9. Save the edit using the “.crt” extension, using a file name like “CAcert.crt.”
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10. Return to the original firmware session, use the Browse button to locate the crt certificate file,
and click Upload to enable the certification.

A NEW CEFMTION OF HD Home Client settings J«:LGIIEWCLE Language
Security > HTTPS
Syslen HTTPS
Media [¥ Enable HTTPS secure connection
Network = Mode:
Security @& HTTP &HTTPS € HTTPS anly
User accounts o Cerificate:
HTTPS Certificate information
Access list Status: Waiting for certificated
IEEE 802.1x Select certificate file: CADosurments and 3= [Browse.i| _Upload |
P12 Method Create cerificate request and install
Event Country: T
. State or province: Asia
Applications
Locality: Agia
B Organization: YIVOTEK Inc.
Local storage Qrganization unit. VIVOTEK Inc.
Camron harne: whi vivotek com
[ Basic mode | Remove ceificate




11. When the certifice file is successfully loaded, its status will be stated as Active. Note that
a certificate must have been created and installed before you can click on the “Save"
button for the configuration to take effect.

HTTPS

= hiode:

@ HTTP & HTTPS  HTTPS only

« Certificate:

Certificate information

Status: Active

Method: Create cedificate request and install
Coauntry: Ty

State or province: Asia

Locality: Asia

Organization: YIVOTEK Inc.

Qrganization unit: YIVOTEK Inc.

Commaon name: wenni vivotek.com

Certificate properties Remove cerificate |
Save |

12.To begin an encrypted HTTPS session, click Home to return to the main page. Change the URL
address from “http://” to “https://“ in the address bar and press Enter on your keyboard. Some
Security Alert dialogs will pop up. Click OK or Yes to enable HTTPS.

X

rl_o fou are about to view pages over a secure connection.

ri?‘l Thiz page containg both secure and nonsecure

il i
Any infarmation you exchange with this site cannot be ?.. 2.
viewed by anyone elze on the Web. ) .
Do pou want to dizplay the nonsecure items?

[ I the future, da naot show this warning

| ok |[ Hore Infa ] [ Yes H Ma ] [ More Info

Security Alert @

ri‘l Information you exchange with thiz site cannot be viewed or
?. changed by otherz. However, there iz a problem with the site's
: security certificate.

& The zecurity certificate was issued by a company you have
not chozen bo trust, Wiew the certificate to determing whether
yau want to trust the certifving autharity,

g The zecurity certificate date iz walid.

@ The name on the zecurity certificate iz invalid or does not
match the name of the site

Do you want to procesd?

YVes ] [ Mo l [ Wiew Certificate




Security > Access List

This section explains how to control access permission by verifying the client PC’s IP
address.

General Settings

General settings

Maximum number of concurrent streaming: | 10 [«] | Connection management |

Maximum number of concurrent streaming connection(s) limited to: Simultaneous live viewing for
1~10 clients (including stream 1 to stream 3). The default value is 10. If you modify the value and
click Save, all current connections will be disconnected and automatically attempt to re-link (IE
Explorer or Quick Time Player).

View Information: Click this button to display the connection status window showing a list of the
current connections. For example:

IP address Elapsed time User ID
Il 17216.2.53 00:00:05

Il 192.168.4.104 01:49:35

Refresh Add to deny list Discannect Close

Note that only consoles that are currently displaying live streaming will be listed in the View
Information list.

m |P address: Current connections to the Network Camera.
m Elapsed time: How much time the client has been at the webpage.

m User ID: If the administrator has set a password for the webpage, the clients have to enter a
user name and password to access the live video. The user name will be displayed in the User
ID column. If the administrator allows clients to link to the webpage without a user name and
password, the User ID column will be empty.

There are some situations that allow clients access to the live video without a user name and

password:

1. The administrator does not set up a root password. For more information about how to set up
a root password and manage user accounts, please refer to Security > User account on page
118.

2. The administrator has set up a root password, but set RTSP Authentication to “disable”. For
more information about RTSP Authentication, please refer to RTSP Streaming on page 105.
3. The administrator has set up a root password, but allows anonymous viewing. For more

information about Allow Anonymous Viewing, please refer to page 118.



m Refresh: Click this button to refresh all current connections.

m Add to deny list: You can select entries from the Connection Status list and add them to the
Deny List to deny access. Please note that those checked connections will only be disconnected
temporarily and will automatically try to re-link again (IE Explorer or Quick Time Player). If you
want to enable the denied list, please check Enable access list filtering and click Save in the
first column.

m Disconnect: If you want to break off the current connections, please select them and click this
button. Please note that those checked connections will only be disconnected temporarily and
will automatically try to re-link again (IE Explore or Quick Time Player).

Filter
Enable access list filtering: Check this item and click Save if you want to enable the access list
filtering function.

Filter type: Select Allow or Deny as the filter type. If you choose Allow Type, only those clients
whose IP addresses are on the Access List below can access the Network Camera, and the others
cannot. On the contrary, if you choose Deny Type, those clients whose IP addresses are on the
Access List below will not be allowed to access the Network Camera, and the others can.

Filter
Enable access listfiltering
Filter type: ) Allow @ Deny

IPv4 access list

| Add || Delete
IPv6 access list

| Ada || Delete

Then you can Add a rule to the following Access List. Please note that the IPv6 access list column
will not be displayed unless you enable IPv6 on the Network page. For more information about
IPv6 Settings, please refer to Network > General settings on page 97 for detailed information.



There are three types of rules:
Single: This rule allows the user to add an IP address to the Allowed/Denied list.

For example:
Filter address

Rule: Single El

IF address: 1 192.168.2.1

| OK || Cam:el|

Network: This rule allows the user to assign a network address and corresponding subnet mask to
the Allow/Deny List. The address and network mask are written in CIDR format.

For example:
P Filter address

Rule: | Network =]
Metwork address / Metwork maskl 192 162.2.0 !

OK || Cancel |

IP address range 192.168.2.x will be bolcked.

If IPv6 filter is preferred, you will be prompted by the following window. Enter the IPv6 address and
the two-digit prefix length to specify the range of IP addresses in your configuration.

>Add ipv6 filter list

Filter address

Rule: | network[=]

Metwork address / Metwork mask: !
| OK || Cancel |

Range: This rule allows the user to assign a range of IP addresses to the Allow/Deny List.
Note: This rule only applies to IPv4 addresses.

For example:
Filter address

Rule: Ranqge Izl

IF address - IP address: | 192.168.2.0 - 1192.168.2.255|

| OK || Cam:el|

Administrator IP address

Always allow the IP address to access this device: You can check this item and add the
Administrator’s IP address in this field to make sure the Administrator can always connect to the
device.

Administrator IP address

Always allow the IP address to access this device

Save




Security > IEEE 802.1X

Enable this function if your network environment uses IEEE 802.1x, which is a port-based network
access control. The network devices, intermediary switch/access point/hub, and RADIUS server
must support and enable 802.1x settings.

The 802.1x standard is designed to enhance the security of local area networks, which provides
authentication to network devices (clients) attached to a network port (wired or wireless). If all
certificates between client and server are verified, a point-to-point connection will be enabled; if
authentication fails, access on that port will be prohibited. 802.1x utilizes an existing protocol, the
Extensible Authentication Protocol (EAP), to facilitate communication.

m The components of a protected network with 802.1x authentication:

— ey — N

Supplicant Authenticator Authentication Server
(Network Camera) (Network Switch) (RADIUS Server)

. Supplicant: A client end user (camera), which requests authentication.

. Authenticator (an access point or a switch): A “go between” which restricts unauthorized end
users from communicating with the authentication server.

3. Authentication server (usually a RADIUS server): Checks the client certificate and decides

whether to accept the end user’s access request.

N —

m VIVOTEK Network Cameras support two types of EAP methods to perform authentication: EAP-
PEAP and EAP-TLS.

Please follow the steps below to enable 802.1x settings:

1. Before connecting the Network Camera to the protected network with 802.1x, please apply
a digital certificate from a Certificate Authority (i.e., your network administrator) which can be
validated by a RADIUS server.

2. Connect the Network Camera to a PC or notebook outside of the protected LAN. Open the
configuration page of the Network Camera as shown below. Select EAP-PEAP or EAP-TLS as
the EAP method. In the following blanks, enter your ID and password issued by the CA, then
upload related certificate(s).

|IEEE 802.1x

Enable IEEE B802.1x

EAP method: EAP-PEAP |»

|dentity:

Fassword:

CA cerificate: Browse... Lpload

Status: nofile



IEEE 802.1x
Enable 8302.1x
EAP method: EAP-TLS |
|dentity:

Private key passord:

CA cerificate: Browse... pload
Status: nofile
client cerificate: Browse... pload
Status: nofile
Client private key: Browse... Upload

Status: nofile

3. When all settings are complete, move the Network Camera to the protected LAN by connecting
it to an 802.1x enabled switch. The devices will then start the authentication automatically.

NOTE:

P The authentication process for 802. 1x:

1. The Certificate Authority (CA) provides the required signed certificates to the Network Camera
(the supplicant) and the RADIUS Server (the authentication server).

2. A Network Camera requests access to the protected LAN using 802.1X via a switch (the
authenticator). The client offers its identity and client certificate, which is then forwarded by the
switch to the RADIUS Server, which uses an algorithm to authenticate the Network Camera and
returns an acceptance or rejection back to the switch.

3. The switch also forwards the RADIUS Server's certificate to the Network Camera.

4. Assuming all certificates are validated, the switch then changes the Network Camera’s state to
authorized and is allowed access fo the protected network via a pre-configured port.

Certificate Authority

o 7 O

Certificate Certificate

" o i
@ =X |

VIVOTEK Network Switch RADIUS Server
Network Camera

Protected LAN



Security > Miscellaneous

The embedded TrendMicro utitlity provides the protection against Cross-Site Request
Forgery. Cross-site request forgery is also known as one-click attack or session riding and
is abbreviated as CSRF. CSRF is a type of malicious exploit of a website, in this case, the
camera. Unauthorized commands are transmitted from a user that the web application
trusts, using the mechanism of forging a trusted user's own request with a request
containing his own cookies, etc. Different ways can be used for a malicious website to
transmit such commands. They can be specially-crafted image tags, hidden forms, and
JavaScript XMLHttpRequests. The malicious attack can occur without users' interaction or
even knowing it.

Miscellaneous

Enable Cross-Site Request Forgery(CSRF) protection.

We strongly recommend not to disable this protection. Disabling this feature will expose your
camera to risks.

Save
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PTZ > PTZ settings

This section explains how to control the Network Camera’s Pan/Tilt/Zoom operation.

Digital: Control the e-PTZ operation. Within a field of view, it allows users to quickly move the
focus to a target area for close-up viewing without physically moving the camera.

Digital PTZ Operation (E-PTZ Operation)

The e-PTZ control settings section will be displayed as shown below:

Channel: Stream :
TR =
\ | [« wome [ » |
v
[=] zoom
Pan speed: 0 w
Tilt speed: 0 w
Zoom speed: 0 w
Auto panipatrol speed: 1 W
Go to: | - Select one — W
— Home location settings
| Set current position as home || Restore home position to default
— Preset and patrol settings -
Mame:| Add preset location Select Preset Loc ationg for Patrol
User preset locations Patrol locations m&llti;il::]
low er_left A low er_left EA
center center 5
right (2] [ rine 5 I
upper_right upper_right 5
W
left left 5 v
Remove
| | [ [a]lx]
— Misc settings
Zoom factor display

For e-PTZ related details, please refer to page 135.

Auto pan/patrol speed: Select the speed from 1~5 (slow/fast) to set up the Auto pan/patrol speed control.

Zoom factor display

If you check this item, the zoom indicator will be displayed on the home page when you zoom in/out the
live viewing window as the picture shown on the next page.

When completed with the e-PTZ settings, click Save to enable the settings on this page.
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Home page in the E-PTZ Mode

MA9322-EHTV

CTTITE Client settings | Configuration | Languag!
2019 7.20.0

e
20197 20:01

a(@u(s]le] Wk ]G cofEmTm

low er_left
canter

right
upper_right
left
upper_left
low er_right

m The e-Preset Positions will also be displayed on the home page. Select one from the drop-down
list, and the Network Camera will move to the selected position.

m If you have set up different preset positions for different streams, you can select one of the video
streams to display its separate preset positions.

Global View

In addition to using the e-PTZ control panel, you can also use the mouse to drag or resize the
floating frame to pan/tilt/zoom the viewing region. The live view window will also move to the
viewing region accordingly.

Moving Instantly

If you check this item, the live view window will switch to the new viewing region instantly after you
move the floating frame. If not selected, the process of moving from one position to another will be
shown.

Click on Image
The e-PTZ function also supports “Click on Image®. When you click on any point of the Global View
Window or Live View Window, the viewing region will also move to that point.

Note that the”Click on Image” function only applies when you have configured a smaller “Region
of Interest” out of the maximum output frame! e.g., an 800 x 600 region from out of the camera’s
maximum frame size.

Patrol button: Click this button, then the Network Camera will patrol among the selected preset
positions continuously.



Patrol settings

You can select some preset positions for the Network Camera to patrol.
Please follow the steps below to set up a patrol schedule:

. Select the preset locations on the list, and click .

. The selected preset locations will be displayed on the Patrol locations list.

. Set the Dwelling time for the preset location during an auto patrol.

. If you want to delete a preset location from the Patrol locations list, select it and click Remove.
. Select a location and click  a | ¥| to rearrange the patrol order.

. Select patrol locations you want to save in the list and click Save to enable the patrol settings.
. To implement the patrol schedule, please go to homepage and click on the Patrol button.

NOoO OB~ OWN-

Digital

Channel: Stream :

Tilt speed:
Zoom speed:

Pan speed:

Auto pan/patrol speed:

Go to: | - Select one - v
Home location settings
| Set current position as home | Restore home position to defauit |
0 Preset and patrol settings
Mame:| Add preset location Select Preset Locations for Patrol e
; . Dwell time
User preset locations 9 Patrol locations (sec]
low er_left N lowe er_left 5 A
center center c
right right 5
upper_right upper_right 5
L

et [ sV

Remove

[ Remove J[a ][ v]

Misc settings

Zoom factor display 6

| Save
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() NOTE:

* The Preset Positions will also be displayed on the Home page. Select one from the Go to
menu, and the Network Camera will move to the selected preset position.

» Click Patrol: The Network Camera will patrol along the selected positions repeatedly.
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Event > Event settings

This section explains how to configure the Network Camera to respond to particular situations
(event). A typical application is that when a motion is detected, the Network Camera sends
buffered images to an FTP server or e-mail address as notifications. Click on Help, there is
an illustration shown in the pop-up window explaining that an event can be triggered by many
sources, such as motion detection or external digital input devices. When an event is triggered,
you can specify what type of action that will be performed. You can configure the Network
Camera to send snapshots or videos to your email address or FTP site.

Event
Hame Status Sun Mon Tue Wed Thu Fri  Sat Time Trigger
Add Help

close or EscKey

Event Trigger — Action (What to do)

Ex.
Motion detection, Periodically,
Digital input, System boot

Media (What to send) Server (Where to send)

Ex. Ex.

Snapshot, Video Clip, System log Email, FTP, HTTP Server,
Metwork storage

Event

To configure an event with reactive measures such as recording video or snapshots, it is necessary to
configure the server and media settings so that the Network Camera will know what action to take (such
as which server to send the media files to) when a trigger is activated. An event is an action initiated
by a user-defined trigger source. In the Event column, click Add to open the event settings window.
Here you can arrange three elements -- Schedule, Trigger, and Action. A total of 3 event settings can be
configured.

Event
Hame Status Sun Mon Tue Wed Thu Fri  Sat Time Trigger
Add Help
Event name:
Enable this event
Priority: | Normal [+

Detect next motion detection or digital input after 10 second(s)
Event Schedule
V] sun [¥] Mon [7] Tue [¥] Wed [¥] Thu [7] Fri [7] Sat
1. Schedule
Time
@ Always
From to [hh:mm]

2. Trigger

3. Action

Saveevent || Close ||




m Event name: Enter a name for the event setting.
m Enable this event: Select this checkbox to enable the event setting.

m Priority: Select the relative importance of this event (High, Normal, or Low). Events with a higher
priority setting will be executed first.

m Detect next motion detection or digital input after [ ] seconds: Enter the duration in seconds to pause
motion detection after a motion is detected. This can prevent event-related actions to take place too
frequently.

1. Schedule

Specify the period of time during which the event trigger will take effect. Please select the days of the
week and the time in a day (in 24-hr time format) for the event triggering schedule. For example, you
may prefer an event to be triggered only during the off-office hours.

2. Trigger

This is the cause or stimulus which defines when to trigger the Network Camera. The trigger source can
be configured to use the Network Camera’s built-in motion detection mechanism or external digital input
devices.

There are several choices of trigger sources as shown on the next page. Select the item to display the
detailed configuration options.

m Video motion detection
This option makes use of the built-in motion detection mechanism as a trigger source. To enable this
function, you need to configure a Motion Detection Window first. For more information, please refer to
Motion Detection on page 154 for details.

@ Video motion detection

% Channell
¥ Channel2
# Channel3

# Channel4

Note: Please configure Motion detection first

m Periodically
This option allows the Network Camera to trigger periodically for every other defined minute. Up to 999
minutes are allowed.

Trigger every aother 4 minutes

m Digital input
This option allows the Network Camera to use an external digital input device or sensor as a trigger
source. Depending on your application, there are many choices with digital input devices on the market
which help detect changes in temperature, vibration, sound, light, etc.

m System boot
This option triggers the Network Camera when the power to the Network Camera is disconnected and
re-connected.

m Recording notify
This option allows the Network Camera to trigger when the recording disk is full or when recording
starts to overwrite older data.



m Audio detection
A preset threshold can be configured with an external microphone as the trigger to system event. The
triggering condition can be an input exceeding or falling below a threshold. Audio detection can take
place as a complement to motion detection or as a method to detect activities not covered by the
camera's view.

m Camera tampering detection
This option allows the Network Camera to trigger when the camera detects that it is being tampered
with. To enable this function, you need to configure the Tampering Detection option first. Please refer
to page 158 for detailed information.

m Manual Triggers
This option allows users to enable event triggers manually by clicking the on/off button on the
homepage. Please configure 1 to 3 associated events before using this function.

n Manual Trigger %/VIV@E I(

1 2 3
Video Stream |1+

= Manual Trigger:
1| on f0i

2| on fOf
3| on fOf

= VADP

It is presumed that you already uploaded and enabled the VADP modules before you can associatee
VADRP triggers with an Event setting.

Click on the Set VADP Trigger button to open the VADP setup menu. The triggering conditions
available with 3rd-party software modules known as VADP will be listed. Use the arrow buttons to
select these triggers. Users may implant these modules for different purposes such as triggering
motion detection, or applications related to video analysis, etc. Please refer to page 161 for the
configuration options with VADP modules.

Set VADP Trigger

VADP Triggers Triggers for Event Settings

ManualTrigger
TriggerA
TriggerB
TriggerC L
TriggerD | e |

W
W

| Close || Save




Once the triggers are configured, they will be listed under the VADP option.
@ VADP

TriggerD
J| TriggerA
7| TriggerB

TriggerC

et VADP Trigger

[ManualTrigger

Close || Save

3. Action

Define the actions to be performed by the Network Camera when a trigger is activated.
Action
() Trigger digital output for 1 seconds

—] Backup media if the network is disconnected

) Playaudioclip: | e Nong----- v Configure Audio clips

O

Configure Cameralink

Server Media Extra parameter
Osp | — Nong----- v | SD test
NASO Note: Please configure NAS management

Add server o Add media o

m Trigger digital output for [ ] seconds

Select this option to turn on the external digital output device when a trigger is activated. Specify

the length of the trigger interval in the text box.

m Backup media if the network is disconnected

Select this option to backup media file on SD card if the network is disconnected. This function
will only be displayed after you set up a network storage (NAS). The media to back up can

include snapshot images, video, or system logs depending on your event settings.

m Play audio clip:

A pre-loaded audio clip can be configured to be played when one triggering condition is met. For

example, playing a warning message to deter an intruder.
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m Configure CameralLink
The camera can be associated with another camera with responsive actions. For example, if a

thermal camera detects some abnormal situations, e.g., a fire, the camera can tell another camera,
say, a PTZ camera to move to a preset position to observe the current situation.
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Add server

It is necessary to configure the server and media settings so that the Network Camera will know what
action to take (such as which server to send the media files to) when a trigger is activated. Click Add

server to open the server setting window. You can specify where the notification messages are sent to
when a trigger is activated. A total of 5 server settings can be configured.

There are four choices of server types available: Email, FTP, HTTP, and Network storage. Select the item
to display the detailed configuration options. You can configure either one or all of them.

Add server Add media O

Server name:

Server type

@ Emall
Sender email address:
Recipient email
address:
Server address:
User name:
Password:
Server port 25
[C] This server requires a secure connection

O FTP

() SFTP

() HTTP

| Test || Save server \ \ Close

Server type - Email
Select to send the media files via email when a trigger is activated.

m Server name: Enter a name for the server setting.

m Sender email address: Enter the email address of the sender.

m Recipient email address: Enter the email address of the recipient.

m Server address: Enter the domain name or IP address of the email server.

m User name: Enter the user name of the email account if necessary.

m Password: Enter the password of the email account if necessary.

m Server port: The default mail server port is set to 25. You can also manually set another port.

If your SMTP server requires a secure connection (SSL), select This server requires a secure
connection (SSL).



To verify if the email settings are correctly configured, click Test. The result will be shown in a pop-up
window. If successful, you will also receive an email indicating the result.

3} hitp 197,168 5,171 fegi- biniamintiestsorverczi- .. [0 |0 |[%) 2 http:11192.168.5.121/cgi-binfadminftestserver.cgi - ... (2 01[K)

The email has been sent successfully. Error in sending email.

Click Save server to enable the settings.

Note that after you configure the first event server, the new event server will automatically display on the
Server list. If you wish to add other server options, click Add server.

Server Media Extra parameter
SD ——tone—[+] SDtest View
Email = —MNone— El

Add server 'O‘ Add media 'O‘

Server type - FTP
Select to send the media files to an FTP server when a trigger is activated.

Server name:
Server Type
Email
@ FTP
Senver address: ftp vivotek.com
Server port: 21
User name: vivotek
Password: sanaee

FTP folder name:
7| Passive mode
HTTP

Metwork storage

Test || saveserver || Close

m Server name: Enter a name for the server setting.
m Server address: Enter the domain name or IP address of the FTP server.

m Server port: By default, the FTP server port is set to 21. It can also be assigned to another port number
between 1025 and 65535.

m User name: Enter the login name of the FTP account.

m Password: Enter the password of the FTP account.

m FTP folder name

Enter the folder where the media files will be placed. If the folder name does not exist, the Network
Camera will automatically create one on the FTP server.



m Passive mode

Most firewalls do not accept new connections initiated from external requests. If the FTP server
supports passive mode, select this option to enable passive mode FTP and allow data transmission to
pass through the firewall. The firmware default has the Passive mode checkbox selected.

To verify if the FTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as shown below. If successful, you will also receive a test.txt file on the FTP server.

2 hitn:(/192.168.5.121 /cgi-binfadminfiestserver.cei - .. [0 ]I |[X) 2 hiip://102 1685 121 degi- binfadminiesiserver.cgi - ... [B|L1|[X)

fip transmission successfully. ftp transmission failed.

Click Save server to enable the settings.

Server type - SFTP
Select to send the media files to an SFTP (Secure File Transfer Protocol) server when a trigger is

activated. This page contains the client side settings.

Server type
(") Email
O FTP
() SFTP
Server address: 192.168.5.114
Server port: 22
Host key MD5: Scanning... please wait
Folder name:
Login mode: () Password (@ Publickey
User name: admin
Pairing mode: (@ Auto (7 Download () Upload

Password:

m Server address: Enter the SFTP server address in either the domain name or IP address.

m Server port: By default, the FTP server port is set to 22. It can also be assigned to another port number
between 1025 and 65535.

m Host key MD5: You have the option to use public/private key authentication instead of a username and
password to connect to the server. This option requires that you have a private/public SSH key pair,
and that the public key is in place on your SFTP server.

If you wish to Use key authentication for this SFTP server, click the Get (Read Fingerprint) button to
request the public key fingerprint from the server. The host key MD5 is a hash of the FTP server’s
public key, which the camera stores in order to verify that it is connecting to the correct SFTP server.
You can copy that fingerprint and save it for later reference.

The max. length of MD5 fingerprint is 47 characters.



If key authentication is not preferred, you can specify a username and password in the section below.

An RSA key fingerprint will look like this: da:47:93:b4:3a:90:5b:50:1f:20:a8:f9:b7:a1:d0:e1. Verify if this
is the SFTP server you want to connect to.

i

#EHAE x

£

Please confirm if the SFTP server( 192.168.5.114 ) is trustable far
you and the host key MD5
is: foee:0f268:30:71:fb:92:3Fb3:83:1d:90:18:c3:87.

B

m Folder name
Enter the folder where the media file will be placed. If the folder name does not exist, the Network
Camera will create one on the SFTP server.

Use backslash “\” when you need to specify a path. Leave it blank to use the SFTP server’s default
root directory. The max. length of folder name is 128 characters.

m Login mode
Select a Login mode as either the Password or the Public key mode.

When using SFTP, you can authenticate using a public/private SSH key pair instead of a password.
If key authentication is not enabled, you need to specify a password instead. The administrator of the
SFTP server will need to manually add the corresponding public key to the SFTP server.

Password mode:
m User name: Enter the login name of the SFTP account.

m Password: Enter the password of the SFTP account.

Addsenet damedia © Use the Test button to test the connectivity. When
Server name: | SFTP done, enter the server name and click the Save server
Server type button to preserve your settings.

() Email
O FTP
@® SFTP sftp transmission successfully
Server address: 10.16.103.55
Server port: 22
Host key MD5: 38:e0:5d:83:Tb:43:9¢:06:6a:76:ae:f Get
Folder name:
Login mode: (@) Password () Publickey
User name: admin
Password: sssssses
) HTTP
Network storage

Test || Save server || Close




Publickey mode:

Selecting the Public key mode will bring up the Pairing mode options: Auto, Download, Upload.

Auto Camera will generate a key pair and auto pair public key with the SFTP
server.
Download Camera will generate a key pair and download the public key for the user to

upload it to the SFTP server. The supported formats are: ED25519 (default.
Elliptic curve signature scheme Edwards-curve Digital Signature Algorithm;
with faster key creation, encryption and decryption), RSA (Rivest—-Shamir—
Adleman, with greater portability), ECDSA (Elliptic Curve Digital Signature
Algorithm).

Upload Upload the private key here and upload the public key to the SFTP server.

A private key is a guarded secret and it can be stored on disk in an encrypted
form. A passphrase is used in order to decrypt it. It is a login password to the
SSH server, the passphrase is only used to decrypt the private key on the
local system. The passphrase is not transmitted over the network.

When using SFTP, you can authenticate using a public/private SSH key pair instead of a
password. If key authentication is not enabled, you need to specify a password instead. The
administrator of the SFTP server will need to manually add the corresponding public key to the
SFTP server.

The key benefit of a key-based authentication is that instead of a using a password, you are less
vulnerable to brute-force attacks and you do not expose valid credentials, if the server has been
compromised.

Server name:

Server type

" Email

) FTP

@ SFTP
Server address: 192.168.5.114
Server port: 22
Host key MDA5: Get
Folder name: Camera will generate
Login mode: () Password (e) Publickey a key pair and
User name: download the public
Pairing mode: (@ Auto () Download () Upload key for the user fo
Password:

upload it to the SFTP

server

() HTTP

Metwork storage

Test || Save server || Close
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Server type - HTTP

Select to send the media files to an HTTP server when a trigger is activated.

Server name: | HTTP |

Server Type
) Email
© FTP

@ HTTP

LURL: | hitp:/192.168.5.10/cgi-binfupload.cqi

) Metwork storage

[ Test [ saveserver || Close

m Server name: Enter a name for the server setting.

m URL: Enter the URL of the HTTP server.
m User name: Enter the user name if necessary.

m Password: Enter the password if necessary.

To verify if the HTTP settings are correctly configured, click Test. The result will be shown in a pop-
up window as shown below. If successful, you will receive a test.txt file on the HTTP server.

2 hitp:#192.168.5.121/cgi- binadmin/testserver cgi - - o |

HTTF Transmission successfully. Thanks

HTTP Transmission failed.

Click Save server to enable the settings.
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Network storage:
Select to send the media files to a networked storage when a trigger is activated. Please refer to NAS
server on page 167 for details. Note that only one NAS server can be configured.

Click Save server to enable the settings.
Action
[] Trigger digital output for | 1 seconds
Backup media if the network is disconnected

Server Media Extra parameter

8D — None— [«| SDtest View

Email —Nnne—g

FTF —Nnne—E

HTTP —Nnne—E

Create folders by date time and hour automatically
MAS —Nnne—E
View

Add server o Add media O

Close || Save event

m SD Test: Click to test your SD card. The system will display a message indicating the result as a
success or a failure. If you want to use your SD card for local storage, please format it before use.
Please refer to page 150 for detailed information.

m View: Click this button to open a file list window. This function is only for SD card and Network Storage.
If you click the View button for an SD card, a Local storage page will prompt so that you can manage
the recorded files on SD card. For more information about Local storage, please refer to page 169.
If you click the View button for a Network storage, a file directory window will prompt for you to view
recorded data on Network storage. For detailed illustration, please refer to the next page.

m Create folders by date, time, and hour automatically: If you select this item, the system will
automatically create folders by the date when video footages are stored onto the networked storage.

The following is an example of a file destination with video clips:

[] #/120190120 The format is: YYYYMMDD
0] B/ 20190121 Click to open the directory

[]#20190122

[ Delete | [ Delete all |——Click to delete all recorded data

Click to delete selected items



The format is:

Click 20190120 to open the directory:

HH (24r)

Click to open the file list for that hour

< 07 03 09 10 11 12 13 14 15 16 17 =

file name size date time
[]|Recordingl 58.mpa| 2528004 |2019/01/20 07158128
[]|Recordingl 59.mp4 2563536 2019/01/20 D?:%EB
| Delete | | Deleteall | | Back |

|
Click to delete
selected items

Click to go back to the previous
level of the directory

Click to delete all
recorded data

< 07 03 09 10 11 12 13 14 15 16 17 =

file name size date time
[]|Recordingl 58 .mp4| 2525004 2019/01/20 07:58:28
[]|Recordingl 59.mp4 2563536 2019/01/20 07:59:28
[ Delete | [ Deleteall | | Back |
The format is: File name prefix + Minute (mm)

You can set up the file name prefix on Add media page. Please
refer to next page for detailed information.




Add media

Click Add media to open the media setting window. You can specify the type of media that will be
sent when a trigger is activated. A total of 5 media settings can be configured. There are three choices
of media types available: Snapshot, Video Clip, and System log. Select the item to display the detailed
configuration options. You can configure either one or all of them.

Add server o Add media

IMedia name:

Media type
Attached media:

@ Snapshot

Source: Stream 1[=]
Send 1 pre-event image(s) [0~7]
Send 1 past-event image(s) [0~7]

File name prefix. Snapshot_

Yideo clip

System log

Save media | | Close

Media type - Snapshot
Select to send snapshots when a trigger is activated.

m Media name: Enter a name for the media setting.
m Source: Select to take snapshots from any of the video streams.

m Send [] pre-event images
The Network Camera has a buffer to temporarily hold data up to a certain limit. Enter a number to
decide how many images to capture before a trigger is activated. Up to 7 images can be generated.

m Send [] post-event images
Enter a number to decide how many images to capture after a trigger is activated. Up to 7 images can
be generated.

For example, if both the Send pre-event images and Send post-event images are set to 7, a total of 15
images can be generated after a trigger is activated.

1pic. 2pic. 3pic. 4pic. Spic. épic. 7 pic. @ 9 pic. 10pic. 11pic. 10pic. 12pic. 13pic. 14pic. 15pic.

Trigger Activation

m File name prefix
Enter the text that will be appended to the front of the file name.



m Add date and time suffix to the file name
Select this option to add a date/time suffix to the file name.
For example:

Snapshot_20190513_100341

tt

File name prefix Date and time suffix
The format is: YYYYMMDD_HHMMSS

Click Save media to enable the settings.

Note that after you set up the first media server, a new column for media server will automatically display
on the Media list. If you wish to add more media options, click Add media.

Media type - Video clip

Select to send video clips when a trigger is activated.

Media name: Video Clip

Media Type
Attached media:

Snapshot

@ Video Clip

Channel: {[~| Stream:| {[w|

Pre-event recording: 0 seconds [0~9]
Maximum duration: 5 seconds [1~20]
Maximum file size: 500 Kbytes [50~4096]

File name prefix: | Video Clip_|

System log

| Save media || Close

m Media name: Enter a name for the media setting.
m Source: Select a video stream as the source of video clip.

m Pre-event recording
The Network Camera has a buffer to temporarily hold data up to a certain limit. Enter a number to
decide the duration of recording before a trigger is activated. Up to 9 seconds can be set.

m Maximum duration
Specify the maximum recording duration in seconds. The duration can be up to 10 seconds.
For example, if pre-event recording is set to five seconds and the maximum duration is set to ten
seconds, the Network Camera continues to record for another 4 seconds after a trigger is activated.

1sec. 2sec. 3sec. 4sec. 5sec. @ 7sec. 8sec. 9sec. 10sec.

1

Trigger Activation
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m Maximum file size
Specify the maximum file size allowed. Some users may need to stitch the video clips together when

searching and packing up forensic evidence.

m File name prefix
Enter the text that will be appended to the front of the file name.

For example:

Video_20190513_100341

tt

File name prefix Date and time suffix
The format is: YYYYMMDD_HHMMSS

Click Save media to enable the settings.

Media type - System log
Select to send a system log when a trigger is activated.

Media name:| System log | |

~ Media Type

Attached media:
) Snapshot
) video Clip

@ System log

| savemeda |  Close

Click Save media to enable the settings, then click Close to exit the page.

— Action

Backup media ifthe network is disconnected

Server Media Extra parameter
(18D | —None—I[=] SDtest View
mail

——MNoneg—-
email

log
snapshot

Saveevent ||  Close
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In the Event settings column, the Servers and Medias you configured will be listed; please make sure the
Event -> Status is indicated as ON, in order to enable the event triggering action.

When completed, click the Save event button to enable the settings and click Close to exit Event
Settings page. The new Event / Server settings / Media will appear in the event drop-down list on the
Event setting page.

Please see the example of the Event setting page below:

Event

Hame Status Sun Mon Tue Wed Thu Fri  Sat Time Trigger

eventi ON W W W W W W Yo 00:00~24:.00 zaq Delete
Add Help

Server settings

Name Type Address/Location

HTTP htp http:/192.168.5.10 Delete
| Add
Media

Available memory space: 13000KB

Name Type
Snapshot snapshot [ Delete |
Video clip videoclip [ Delete |
System log systemlog [ Delete |
P

Customized script

Hame Date Time

Add |

When the Event Status is ON, the event configuration above is triggered by motion detection, the
Network Camera will automatically send snapshots via e-mail.

If you want to stop the event trigger, you can click on the ON button to turn it to OFF status or click the
Delete button to remove the event setting.

To remove a server setting from the list, select a server name from the drop-down list and click Delete.
Note that you can only delete a server setting when it is not applied in an existing event setting.

To remove a media setting from the list, select a media name from the drop-down list and click Delete.
Note that you can only delete a media setting when it is not applied in an existing event setting.



Applications > Motion detection

This section explains how to configure the Network Camera to enable motion detection. A total
of 5 motion detection windows can be configured.

Enable motion detection

Motion Detection Setting 2:
Normal light mode || Profile mode For SpeCiaI situations

Motion Detection Setting 1:
For normal situations

Window name

Mation1

Itemn size: 17

Sensifivity: 80%
—J

Follow the steps below to enable motion detection:

1. Click New to add a new motion detection window.
2. In the Window Name text box, enter a name for the motion detection window.
m Use 4 mouse clicks to designate a detection window. You can change the window shape by dragging

the corner marks to a preferred location.

m Drag the item size tab to change the minimum size of item to trigger an alarm. An item size box will
appear in the center of screen for your reference (in semi-transparent red). An intruding object must
be larger than the ltem size to trigger an alarm. Change the item size according to the live view.

m To delete a window, click the X mark on the right of the window name.

3. Define the sensitivity to moving objects by moving the Sensitivity slide bar. Note that a high sensitivity
is prone to produce false alarms such as the fast changes of light (such as day/night mode switch,
turning lights on/off). A movement must persist longer than 0.3 second for the motion to be detected.

4. Click Save to enable the settings.

5. Select Enable motion detection to enable this function.

For example: Enable motion detection

Normal light mode | | Profile mode

Window name

Motion1

liem size: 17

Sensitivity: 80%
——

The Percentage Indicator will rise or fall depending on the variation between sequential images. When
motions are detected by the Network Camera and are considered to exceed the preset threshold, the red
bar rises. Meanwhile, the motion detection window will be outlined in red.



Photos or videos can be captured instantly and configured to be sent to a remote server (via an
Email or FTP server). For more information on how to configure an event setting, please refer to

Event settings on page 137.

A green bar indicates that even though motions have been detected, the event has not been
triggered because the image variations still fall under the preset threshold.

s

- - Larger than the
min. item size

& J

If you want to configure other motion detection settings for day/night/schedule mode (e.g., for a
different lighting condition), please click Profile to open the Motion Detection Profile Settings page
as shown below. Another three motion detection windows can be configured on this page.

Enable motion detection
Normal light mode | | Profile mode

Window name

Maotion1

Item size: 15

Enable to apply these seflings at

(@) Nightmaode

(::. Schedule mode [hhomm]

Sensifivity 80%

Please follow the steps beolw to set up a profile:

1. Create a new motion detection window.

2. Click the Profile mode tab.

3. Select the applicable Schedule mode. Please manually enter a time range.
4. Click Save to enable the settings and click Close to exit the page.



This motion detection window will also be displayed on the Event Settings page. You can go to Event
> Event settings > Trigger to select it as a trigger source. Please refer to page 137 for detailed
information.

/) NOTE:

» How does motion detection work?

u Enable motion detection Enable motion detection

Min. item size

Nye- = \ -, §§
O" ftem size: 33 \2‘1‘
Vo g, | T ~apY M
N I ET P
N e C,&. o~ | @ -~ : JQ @ W
- Ve | &
3 -

Sensitivity 80%

<— Alerted pixels < Min. item size

Sensitivity 80%

-.Hm -Save

n Enable motion detection

n Enable motion detection

W *uﬂé Window name Min. item size
- Wotion1
J 2, fem size: 32

A - ‘.‘\\ —
»%\ (L4« Vi
- Ha a2 / /*'y‘

™ e (o

¥ o

e A
9 -

Sensitivity 80% Seneitivity 80%
. . <— Alerted pixels > Min. item size

There are two motion detection parameters: Sensitivity and Min. ltem Size. As illustrated above, frame
A and frame B are two sequential images. Pixel differences between the two frames are detected and
highlighted in gray in which the sensitivity setting will take effect. Sensitivity is a value that expresses
the sensitivity to moving objects. A higher sensitivity setting allows camera to detect slight movements
while a lower sensitivity setting will neglect them.

The minimum item size is a threshold value that determines how many ‘alerted pixels” can trigger an
event. When the size of an intruding object is larger than the minimum size, and its movement persist
for 0.3 second, the motion is judged to exceed the defined threshold; and the motion window will be
outlined in red. With a large minimum item size, the size of moving object in frame C is considered as
smaller than the minimum item size, no motion alarm is triggered. With a smaller minimum item size,
the same moving object in frame D triggers the alarm.

For applications that require a high level of security management, it is suggested to use higher
sensitivity settings. However, a higher sensitivity level can also produce false alarms due to fast light
changes when switching between the day and night modes, AE switch, turning the light on or off, efc.
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Applications > Dl and DO

— Digital input
Maormal status: @ High ) Low
Current status: High

— Digital output
Mormal status: @ Open ) Grounded
Current status: Open

Digital input: Select High or Low as the Normal status for the digital input connection. Connect
the digital input pin of the Network Camera to an external device to detect the current connection
status.

Digital output: Select Grounded or Open to define the normal status for the digital output. Connect
the digital output pin of the Network Camera to an external device to determine the current status.

Set up the event source as DI on Event > Event settings > Trigger. Please refer to page 138 for
detailed information.
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Applications > Tampering detection

This section explains how to set up camera tamper detection. With tamper detection, the
camera is capable of detecting incidents such as redirection, blocking or defocusing, or
even spray paint.

Channel:

Camera tampering detection
[C) Tampering detection

Trigger duration 10 seconds [10~600]
Trigger threshold 12 [0~100]

[7) Image too dark detection

Trigger duration 2 seconds [1~10]
Trigger threshold 15 [0~100]

[7) Image too bright detection

Trigger duration 2 seconds [1~10]
Trigger threshold 15 [0~100]

[7) Image too blurry detection

Trigger duration 10 seconds [1~10]

Trigger threshold 13 [0~100]
\ Save |

Please follow the steps below to set up the camera tamper detection function:

1. Click to select the checkbox before tampering conditions: Tampering detection, Image
too dark, Image too bright, and Image too blurry. Enter the tamper trigger duration. (10
sec. ~ 10 min.). The duration specifies the set of time before the tampering is considered
as a real alarm. This helps avoid false alarms by short-lived changes.

The tamper alarm will be triggered only when the tampering factor (the difference
between current frame and pre-saved background) exceeds the trigger threshold.
Conditions such as image too dark, too bright, or too blurry (defocused) can also be
configured as tampering conditions. The Trigger threshold determines how sensitive
your is tamper detection setting. Lower the threshold number, easier to trigger.

Too bright: shining a flash light. The average lighting level of the scene is taken into
consideration.

Too dark: covering the objective or spraying paint.

Too blurry: blurry scene can be the result of strong interference on the device, such as
EMI interference.

2. You can configure Tampering Detection as a trigger element to the proactive event
configurations in Event -> Event settings -> Trigger. For example, when the camera is
tampered with, camera can be configured to send the pre- and post-event video clips to
a networked storage device. Please refer to page 137 for detailed information.



Applications > Audio detection

Audio detection, along with video motion detection, is applicable in the following scenarios:

1. Detection of activities not covered by camera view, e.g., a loud input by gun shots or breaking a
door/window.

2. A usually noisy environment, such as a factory, suddenly becomes quiet due to a breakdown of
machines.

3. APTZ camera can be directed to turn to a preset point by the occurrence of audio events.

4. Dark environments where video motion detection may not function well.

Audio detection

V] Enable audio detection

100

Alarm Level
Volume

o -O- O =

| Profile | | Save |

The red circles indicate where the audio alarms can be triggered when breaching or falling below
the preset threshold.

How to configure Audio detection:
1. Once the Audio detection window is opened, the current sound input will be interactively
indicated by a fluctuating yellow wave diagram.
2. Use a mouse click to drag the Alarm level tab to a preferred location on the slide bar.
3. Select the “Enable audio detection” checkbox and click Save to enable the feature.

J NOTE:

1. Note that the volume numbers (0~100) on the side of wave diagram does not represent decibel
(dB). Sound intensity level has already been mapped to preset values. You can, however, use
the real-world inputs at your installation site that are shown on the wave diagram to configure
an alarm level.

2. To configure this feature, you must not mute the audio in Configuration > Media > Audio.
The default of the camera can be muted due to the lack of an internal microphone. An external
microphone is provided by users.



You can use the Profile window to configure a different Audio detection setting. For example, a
place can be noisy in the day time and become very quiet in the night.

1. Click on the Enable this profile checkbox. Once the Audio detection window is opened, the
current sound input will be interactively indicated by a fluctuating yellow wave diagram.

2. Use a mouse click to drag the Alarm level tab to a preferred location on the slide bar.

3. Select the Day, Night, or Schedule mode check circles. You may also manually configure a
period of time during which this profile will take effect.

4. Click Save and then click Close to complete your configuration.

E-Audio detection profile settings

Audio detection

Alarm Level

General settings

| Enable this profile
This profile is applied to:
Day mode

Might mode

From 18:00 to 06:00 [hh:mm]

Close il Save

/\ IMPORTANT:

+ If the Alarm level and the received volume are set within a range of 20% on the wave
diagram, frequent alarms will be triggered. It is recommended to set the Alarm level
farther apart from the detected sound level.

» To configure and enable this feature, you must not configure video stream #1 into
Motion JPEG. If an external microphone input is connected and recording of audio

stream is preferred, audio stream is transmitted between camera and viewer/recording
station along with stream #1.

» Refer to page 94 for Audio settings, and page 86 for video streaming settings.



Applications > Package management - a.k.a., VADP (VIVOTEK
Application Development Platform)

Upload package
Save to SD card

Select file | Upload

Resource status

- Storage status:
storage_size: 10240 KBytes Free size: 10240 KBytes
« 5D card status: Detached

Total size: 0 KBytes Free size: 0 KBytes
Used size: 0 KBytes Use (%) 0%

~ Memory status:

Total size: 24576 KBytes = Free size: 24576 KBytes
Package list
Module name Vendor Version Status License
| Backup | | Reload | | Restore | | Start | | Stop |

Users can store and execute VIVOTEK's or 3rd-party software modules onto the camera's
flash memory or SD card. These software modules can apply in video analysis for
intelligent video applications such as license plate recognition, object counting, or as an

agent for edge recording, etc.

* Once the software package is successfully uploaded, the module configuration (vadp.
xml) information is displayed. When uploading a module, the camera will examine
whether the module fits the predefined VADP requirements. Please contact our
technical support or the vendor of your 3rd-party module for the parameters contained

within.

+ Users can also run VIVOTEK's VADP packages as a means to access updated

functionality instead of replacing the entire firmware.

* Note that for some cameras the flash is too small to hold VADP packages. These

cameras will have its "Save to SD card" checkbox selected and grayed-out for all time.

* The file system of SD card (FAT32) does not support soft (symbolic) link. It will return

failure if your module tries to create soft links on SD card.

To utilize a software module, acquire the software package and click Browse and Upload

buttons. The screen message for a successful upload is shown below:

= http://172.16.62.166/cgi-bin/admin/upload_vadp.cgi - Windows Internet l = iz-]

: Starting VADP upload procedure, please wait a moment...
Uploading new module: Hello World / ABC

Update configuration...

. Reloading configuration httpd: .

| Upload VADP package successfully




To start a module, select the checkcircle in front, and click the Start button.
Package list

Module name Vendor Version Status  License &
Hello World ABC 1.00 oM VES =]
| Backup | | Reload | | Restore | | Start | | Stop |

If you should need to remove a module, select the checkcircle in front and then click the
Stop button. By then the module status will become OFF, and the X button will appear at
the end of the row. Click on the X button to remove an existing module.

Package list

Module name Vendor \Version Status License &
-] Hello World ABC 1.0.0 oM no Cu
| Backup || Reload |  Restore | Start || Stop

When prompted by a confirm message, Click Yes to proceed.

Note that the actual memory consumed while operating the module will be indicated on the
Memory status field. This helps determine whether a running module has consumed too
much of system resources.
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On the License page, register and activate the license for using VIVOTEK's VADP
modules. You should acquire the license key elsewhere, and manually upload to the

network camera.

Follow the onscreen instruction on VIVOTEK's website for the registration procedure.

| Status | License |

— Manual License
To receive a license key forV¥ADP application, go to http:iwwwayivotek.com and join the WTE
member. This device's WADP number is:

Bht79RE=0dGU1 PILEGJRFacEsacoRs7 g4 sl

Selectfile Mo file selected. Upload
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Recording > Recording settings

This section explains how to configure the recording settings for the Network Camera.

Recording Settings

Insert your SD card and click here to test

Recording settings

Hame  Status Sun n Tue Wed Thu Fri Sat Time Source Destination Delete

| Add | 5D test

Mote: Before setup recording, you may setup network storage via NAS server page

NOTE:

» Please remember to format your SD card via the camera’s web console (in the Local storage .
SD card management page) when using it for the first time. Please refer to page 169 for detailed
information.

Recording Settings

Click Add to open the recording setting window. On this page, you can define the adaptive recording,
recording source, recording schedule, and recording capacity. A total of 2 recording settings can be
configured. p

Recording name:
[] Enable this recording

With adaptive recording (Help)

Pre-event recording: & seconds [0~8]
Fost-event recording: 5 seconds [0~10]
Priority:

Channel: | Channel 1 s

Trigger |
(@ Schedule
1. Trigger
Sun Mon Tue [v] Wed [v] Thu Fri Sat
Time
(®) Always
2. Destination () From to [hh:mmi
() Network fail

| Close || Save

m Recording name: Enter a name for the recording setting.
m Enable this recording: Select this option to enable video recording.

m With adaptive recording:

Select this option will activate the frame rate control according to alarm trigger.

The frame control means that when there is a triggered alarm, the frame rate will raise up to the
value you’ve configured on the Video quality page. Please refer to page 87 for more information.



If you enable adaptive recording on a camera, only when an event is triggered on Camera A will the
server record the full frame rate streaming data; otherwise, it will only request the | frame data during
normal monitoring, thus effectively saves bandwidths and storage space.

2{ o[ — |© [4) () NOTE:
7) ﬁ- zf » To enable adaptive recording, please make sure

you've set up the trigger source such as Motion

°gt ’ﬂ Ei [] @J— : £ Detection, DI Device, or Manual Trigger.
| I
frame. > Fullframe rate > | frame » When there is no alarm trigger:
Bandwidth - JPEG mode: record 1 frame per second.
T - H.265/H.264 mode: record the | frame only.

for Dynamic Frame Rate Control

» When the | frame period is >1s on Video sefttings
page, firmware will force decrease the | frame
period to 1s when adaptive recording is enabled.

S
7
Continuous recording Time

The alarm trigger includes: motion detection and DI detection. Please refer to Event Settings on page 137.
m Pre-event recording and post-event recording
The Network Camera has a buffer that temporarily holds data for a period of time. Therefore, when an
event occurs, the camera can restrieve image frames taken several seconds ago. Enter a number to
define the duration of recording before and after a trigger is activated.

m Priority: Select the relative importance of this recording (High, Normal, or Low). Recording with a higher
priority setting will be executed first.

m Source (Channel/Stream): Select a video stream as the recording source.

J NOTE:

» To enable recording notification please configure Event settings first . Please refer to page 137.

Please follow the steps below to set up the recording.

1. Trigger

Select a trigger source.
Trigger
(® Schedule

Sun Mon Tue Wed Thu Fri Sat
Time

(@ Always

(O From to [hh:mm]

() Network fail

m Schedule: The server will start to record files on the local storage or network storage (NAS).

m Network fail: Since network fail, the server will start to record files on the local storage (SD card).
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2. Destination
You can select the SD card or network storage (NAS) for the recorded video files. If you have not

configured a NAS server, see details in the following.

Prorty.
source:
— Destination
Destination: pag
1 Trigger
Capacity:

@ Entire free space

; ©) Reserved space: Mbytes
— Enable cyclic recording

Recording file management

Maximum duration: minutes [1~30]

Maximum file size: MB [100~2000]
T —

Note: To enable recording notification please configure Event first

NAS server

Click Add NAS server to open the server setting window and follow the steps below to configure:
1. Fill in the information for your server.

For example:
Destination: sp
A
J Add NHAS server
l 3
Server name: |NAS Network efnr9$n path
2. Desfination Server type (\\server name or IP address\folder nameg)

1 I@ Network storage

Metwork storage locaion:  1192.168.5.12INAS |

(For example: Wmy_nas\diskifolder)
Waorkgroup:
User name: '
Password: wv

AN
2 A
= = \
N

User name and password for your server

2. Click Test to check the setting. The result will be shown in the pop-up window.

A http:/192.168.5.151 fcgi-binfadmin/testserver... [ |

A hitp:/192.168.5.151/cgi-binfadmin/testserver... [= ||1/[X]

Mount successfully. Thanles Ifeunt faled.

a = T T @ .:E| Done D Intemet
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If successful, you will receive a test.txt file on the network storage server.

_ < e -
< o-

L€ 1 5 5 e e

~ DS213air

Organize ¥  Search active deectory  Network and Sharing Center  View remote printers #recyde

» #recyde 0002D19059D5

z
i
1]

2020-06-03 13:23:06

2020-06-04 09:50:43

Favorktes ~ 0002D19059D5 test.txt 2020-06-03 13:21:32

Bl Desktop
§ Dowrloads
.| Recent Places

~ 20000101

» 09

» 10

» 11

» 12

g Libraries
*| Documents ~ 20000102
@' Music v 05

» NCMF

» 13

b Pictures
B videos B test - Notepad
File Edit Format View Help
1B Computer |MOTIFICATION]The Result of server Test of vour IP cCameral

€ Network

3. Enter a server name.
4. Click Save to complete the settings and click Close to exit the page.

Recording name:

(7) Enable this recording

() With adaptive recording (Help)

Priorty: [Normal v
Source: | Ch1 Max view v

Destination

Destination: SD v
1. Trigger

Recording file management
Maximum duration: 1 minutes [1~60]
Maximum file size: 100 MB [100~2000]

2. Destination . )
File name prefix:

Add NAS server )

Note: To enable recording notification please configure Event first

Save \ \ Close

m Capacity: You can either choose the entire free space available or limit the reserved space. The
recording size limit must be larger than the reserved amount for cyclic recording.

m Enable cyclic recording: If you check this item, when the maximum capacity is reached, the oldest file
will be overwritten by the latest one. The reserved amount is reserved for the transaction stage when
the storage space is about to be full and new data arrives. The minimum for the Reserved space must
be larger than 15 MegaBytes.

m Recording file management: You can manually assign the Maximum duration and the Maximum
file size for each recording footage. You may need to stitch individual files together under some
circumstances. You may also designate a file name prefix by filling in the responsive text field.

m File name prefix: Enter the text that will be appended to the front of the file name.



f you want to enable recording notification, please click Event to configure event triggering settings.
Please refer to Event > Event settings on page 137 for more details.

When completed, select Enable this recording. Click Save to enable the setting and click Close
to exit this page. When the system begins recording, it will send the recorded files to the network
storage. The new recording name will appear in the drop-down list on the recording page as shown
below.

To remove a recording setting from the list, select a recording name from the drop-down list and

click Delete.
Recording settings

Hame Status Sun Mon Tue Wed Thu Fri  Sat Time Source Destination Delete
recording OW vV %V WV WV OV VWV 00:00~24:00 streamd HAS Delete
Add 5D test

m Click recording (Name): Opens the Recording Settings page to modify.

m Click ON (Status): The Status will become OFF and stop recording.

m Click NAS (Destination): Opens the file list of recordings as shown below. For more information
about folder naming rules, please refer to page 148 for details.

[]® 20190210
(18l 20190211
[] = 20190212

[ Delete | [ Deleteall |




Storage

NOTE:

» Itis recommended to turn OFF the recording activity before you remove an SD card from the
camera.

» The lifespan of an SD card is limited. Regular replacement of the SD card can be necessary.

« Camera filesystem takes up several megabytes of memory space. The storage space cannot
be used for recording.

+ Using an SD card that already contains data recorded by another device should not be used
in this camera.

* Please do not modify or change the folder names in the SD card. That may result in camera
malfunctions.

Storage > SD card management

This section explains how to manage the local storage on the Network Camera. Here you can
view SD card status, and implement SD card control.

SD card staus
This column shows the status and reserved space of your SD card. Please remember to format the SD
card when using for the first time.

SD card status
SD card status: | Detached ——no SD card
Total size: 0 KBytesFree size:0 KBytes

Uzed size:0 KByeslUse (%) 0%

SD card status

SD card status: Ready

File system: FAT32
Total size: 16323496 KByles Free size: 15037976 KByies
Used size: 235520 KBytes Use (%) 1537 %

SD card format

The Linux kernel EXT4 file system format applies to SD card larger than 32GB. However, if EXT4 is
applied, the computers running Windows will not be able to access the contents on the SD card unless
using some 3rd-party software .

SD card format

Extd [7]
Ext4 — ]
- | Format |
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SD card control

— SD card control

Enable cyclic storage

Enable automatic disk cleanup

Maximum duration for keeping files: days

m Enable cyclic storage: Check this item if you want to enable cyclic recording. When the maximum
capacity is reached, the oldest file will be overwritten by the latest one.

m Enable automatic disk cleanup: Check this item and enter the number of days you wish to retain a file.
For example, if you enter “7 days”, the recorded files will be stored on the SD card for 7 days.

Click Save to enable your settings.

Storage > NAS management

NAS Setup

Click NAS management tab to open the server setting window and follow the steps below to set up:
1. Fill in the information for the access to the shared networked storage.
For example:

— NAS setup

Network storage location: WDS213air\DS_network_share

(For example: Yy _nasidiskifolder)

Workgroup: | WORKGROUP |
User name: | admin |
me: | SRR EERERERD |
| Test | | Mount | |  Unmount
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2. Click Test to check the setting. The result will be shown in the pop-up window.

A hitp:17192.168.5.151/cgi-binfadminftestserver... [= |1

<A http:11192.168.5.151/cgi-binfadmin/testserver. .

Mount succeeded. Dfount faled.

@j Done # Internet ﬂj Done  Internet

If successful, you will receive a test.txt file on the networked storage server.

Qo | y0.22.22.229) &

Organize »  Search active directory  Nebwork and Sharing Center  Yiew remote printers o} File Station ? - o
< C || DS_network_share 0-

{ Favorkes

BB Desktop

8 Downloads
. Recent Places

~ DS213air = *

~ DS_network_share @ #recyde

b #recycle 0002D19059D5

2020-06-03 13:23:06

= 2020-06-04 09:50:43
~ 0002D19059D5 test.bxt 58 bytes TXT % 2020-06-03 13:21:32

79 Lkearies
*| Documents » 09
@' Music b

11

~ 20000101

| Pictures
B videos B test - Notepad

12

» 13
File Edit Format View Help ¥ 20000102
[[MOTIFICATION]The Result of Server Test of wvoul » o5

» NCMF

8 Coenputer

€ Network

m
Q

3. Click Mount to complete the settings.

NAS management

m Minimum reserved storage space: The reserved space can be used as a safe buffer
especially when the cyclic recording function is enabled, during the transaction stage when
a storage space is full and the incoming streaming data is about to overwrite the previously
saved videos.

m Enable cyclic storage: Allows previous recordings to be overwritten by new recordings.

m Enable automatic disk cleanup: Allows you to specify how long the recording files will be kept
on the NAS storage.

Maximum duration for keeping files: __ days: Specify the days of retention of the video files
recorded to the NAS storage.



VIVOTEK

Storage > Content management

This section explains how to manage the content of recorded videos on the Network Camera. Here
you can search and view the records and view the searched results.

Searching and Viewing the Records

This column allows the user to set up search criteria for recorded data. If you do not select any
criteria and click Search button, all recorded data will be listed in the Search Results column.

— Search

Device target

(@ Alldevices O sb O NAs

Trigger type

["] Backup [] System boot [[] Digital input

[] Motion [] Network fail [] Preset reached

[[] Recording notify [[] Periodically [[] SD card life expectancy
[] Tampering detection [] VADP [] Manual triggers

[] Audio detection

Media type

(@ Video clip (O Snapshot O Text
Time

SearchforlastE” minute(s) | hours | days [ weeks]

From: l2021l()6/28 l 01 H 21 IPM]

&
to: [2021/07/05 ‘i] [ 01 “ 21 [PM]

m File attributes: Select one or more items as your search criteria.
m Trigger time: Manually enter the time range you want to search for contents created at a specific
point in time.

Click Search and the recorded data corresponding to the search criteria will be listed in Search
Results window.
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Search Results

The following is an example of search results. There are four columns: Trigger time, Media type,
Trigger type, and Locked. Click  to sort the search results in either direction.

Numbers of entries
displayed on one page

Search results

il Name Trigger type Starting time Ending time

O to SD Pericdically = Today at 3:45 PM Today at 3:58 PM A Click to open a live view
1 to SD Periodically | Today at 3:56 PM -
O test Motion Today at 3:45 PM Today at 3:45 PM
[ test Motion Today at 3:49 PM Today at 3:49 PM
O test Motion Today at 3:49 PM Today at 3:49 PM
1 test Motion Today at 3:50 PM Today at 3:50 P
O test Motion Today at 3:50 PM Today at 3:50 PM v

oM [ s

& Download | @ Lock/Unlock | H JPEGs to AV T Remove

m Play: Click on a search result which will highlight the selected item. A Play window will appear on
top for immediate review of the selected file.
For example:

Play

< Back to search

m Download: Click on a search result to highlight the selected item in purple as shown above. Then
click the Download button and a file download window will pop up for you to save the file.

m JPEGs to AVI: This function only applies to “JPEG" format files such as snapshots. You can
select several snapshots from the list, then click this button. Those snapshots will be converted
into an AVI file.
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m Lock/Unlock: Select the checkbox in front of a desired search result, then click this button. The selected
items will become Locked, which will not be deleted during cyclic recording. You can click again to

unlock the selections.
For example:

<
g

y
[
g

test

O O

test

10

Trigger type
Pericdically

Periodically

Starting time
Today at 3:45 PM

Today at 3:58 PM

Today at 3:49 PM
Today at 3:49 PM
Today at 3:50 PM
Today at 3:50 PM

Ending time

Today at 3:55 PM

Today at 3:49 PM
Today at 3:49 PM
Today at 3:50 PM
Today at 3:50 PM

>

v

NN N T

l 4 Download ‘ & Lock/Unlock ‘ H JPEGs to AV

Click to switch
pages

m Remove: Select the desired search results, then click this button to delete the files.
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ﬁ NOTE:

*  Currently this model does not support URL commands.
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Technology License Notice

AMR-NB Standard

THIS PRODUCT IS LICENSED UNDER THE AMR-NB STANDARD PATENT LICENSE AGREEMENT. WITH
RESPECT TO THE USE OF THIS PRODUCT, THE FOLLOWING LICENSORS’ PATENTS MAY APPLY:

TELEFONAKIEBOLAGET ERICSSON AB: US PAT. 6192335; 6275798; 6029125; 6424938; 6058359. NOKIA
CORPORATION: US PAT. 5946651; 6199035. VOICEAGE CORPORATION: AT PAT. 0516621; BE PAT. 0516621;
CA PAT. 2010830; CH PAT. 0516621; DE PAT. 0516621; DK PAT. 0516621; ES PAT. 0516621; FR PAT. 0516621;
GB PAT. 0516621; GR PAT. 0516621; IT PAT. 0516621; LI PAT. 0516621; LU PAT. 0516621; NL PAT. 0516621;
SE PAT 0516621; US PAT 5444816; AT PAT. 819303/AT E 198805T1; AU PAT. 697256; BE PAT. 819303; BR PAT.
9604838-7; CA PAT. 2216315; CH PAT. 819303; CN PAT. ZL96193827.7; DE PAT. 819303/DE69611607T2; DK
PAT. 819303; ES PAT. 819303; EP PAT. 819303; FR PAT. 819303; GB PAT. 819303; IT PAT. 819303; JP PAT. APP.
8-529817; NL PAT. 819303; SE PAT. 819303; US PAT. 5664053. THE LIST MAY BE UPDATED FROM TIME TO
TIME BY LICENSORS AND A CURRENT VERSION OF WHICH IS AVAILABLE ON LICENSOR’S WEBSITE AT
HTTP://WWW.VOICEAGE.COM.

HE HEVCAdvance™

‘E Covered by Patents at patentlist.hevcadvance.com

Notices from HEVC Advance:

THIS PRODUCT IS SOLD WITH A LIMITED LICENSE AND IS AUTHORIZED TO BE USED ONLY
IN CONNECTION WITH HEVC CONTENT THAT MEETS EACH OF THE THREE FOLLOWING
QUALIFICATIONS: (1) HEVC CONTENT ONLY FOR PERSONAL USE; (2) HEVC CONTENT THAT
IS NOT OFFERED FOR SALE; AND (3) HEVC CONTENT THAT IS CREATED BY THE OWNER OF
THE PRODUCT. THIS PRODUCT MAY NOT BE USED IN CONNECTION WITH HEVC ENCODED
CONTENT CREATED BY A THIRD PARTY, WHICH THE USER HAS ORDERED OR PURCHASED
FROM A THIRD PARTY, UNLESS THE USER IS SEPARATELY GRANTED RIGHTS TO USE THE
PRODUCT WITH SUCH CONTENT BY A LICENSED SELLER OF THE CONTENT. YOUR USE OF
THIS PRODUCT IN CONNECTION WITH HEVC ENCODED CONTENT IS DEEMED ACCEPTANCE
OF THE LIMITED AUTHORITY TO USE AS NOTED ABOVE.

H.264

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN
COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEQO") AND/OR (ii) DECODE AVC VIDEO
THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC
VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP:// WWW.MPEGLA.COM


HTTP://WWW.VOICEAGE.COM

Electromagnetic Compatibility (EMC)

FCC Statement
This device compiles with FCC Rules Part 15. Operation is subject to the following two conditions.
m This device may not cause harmful interference, and

m This device must accept any interference received, including interference that may cause undesired
operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a partial
installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

m Reorient or relocate the receiving antenna.

m Increase the separation between the equipment and receiver.

m Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
m Consult the dealer or an experienced radio/TV technician for help.

Shielded interface cables must be used in order to comply with emission limits.

CE Mark Warning

This is a Class B product. In a domestic environment, this product may cause radio interference, in which
case the user may be required to take adequate measures.

VCCIFRBYISDOWNT

COREL -V T ABERNITEE T - COBEY FEBETCHEATAIZLAHANE L THETHN -
CDIEBEMT AT L EY a U 2EHRIIEL TEHsN L - ZEEELSIESEIIIENHN X
T o BURSIHAZEICE D TIEL WEERWA L T RS » VCCI-B

Liability

VIVOTEK Inc. cannot be held responsible for any technical or typographical errors and reserves the right
to make changes to the product and manuals without prior notice. VIVOTEK Inc. makes no warranty
of any kind with regard to the material contained within this document, including, but not limited to, the
implied warranties of merchantability and fitness for any particular purpose.
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